Business Workplace (BC-SRV-GBT)

Release 4.6C
Copyright

© Copyright 2001 SAP AG. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

Microsoft®, WINDOWS®, NT®, EXCEL®, Word®, PowerPoint® and SQL Server® are registered trademarks of Microsoft Corporation.

IBM®, DB2®, OS/2®, DB2/6000®, Parallel Sysplex®, MVS/ESA®, RS/6000®, AIX®, S/390®, AS/400®, OS/390®, and OS/400® are registered trademarks of IBM Corporation.

ORACLE® is a registered trademark of ORACLE Corporation.

INFORMIX®-OnLine for SAP and Informix® Dynamic Server™ are registered trademarks of Informix Software Incorporated.

UNIX®, X/Open®, OSF/1®, and Motif® are registered trademarks of the Open Group.

HTML, DHTML, XML, XHTML are trademarks or registered trademarks of W3C®, World Wide Web Consortium, Massachusetts Institute of Technology.

JAVA® is a registered trademark of Sun Microsystems, Inc.

JAVASCRIPT® is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by Netscape.

SAP, SAP Logo, R/2, R/3, ABAP, SAP ArchiveLink, SAP Business Workflow, WebFlow, SAP EarlyWatch, BAPI, SAPHIRE, Management Cockpit, mySAP.com Logo and mySAP.com are trademarks or registered trademarks of SAP AG in Germany and in several other countries all over the world. All other products mentioned are trademarks or registered trademarks of their respective companies.
## Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Caution Icon]</td>
<td>Caution</td>
</tr>
<tr>
<td>![Example Icon]</td>
<td>Example</td>
</tr>
<tr>
<td>![Note Icon]</td>
<td>Note</td>
</tr>
<tr>
<td>![Recommendation Icon]</td>
<td>Recommendation</td>
</tr>
<tr>
<td>![Syntax Icon]</td>
<td>Syntax</td>
</tr>
<tr>
<td>![Tip Icon]</td>
<td>Tip</td>
</tr>
</tbody>
</table>
# Contents

**Business Workplace (BC-SRV-GBT)** ................................................................. 9  
**The Business Workplace** ................................................................................... 10  
**Working with the Business Workplace** ............................................................. 12  
**The Send, Folder and Office Functions** .............................................................. 15  
  - Working Environment for Documents and Messages ........................................... 16  
    - Inbox ............................................................................................................... 17  
    - Outbox ........................................................................................................... 18  
  - The Folder Private Folders .................................................................................. 19  
  - Shared Folders .................................................................................................. 21  
    - Folder Access Authorizations ........................................................................ 24  
  - Subscribed Folders ........................................................................................... 25  
  - Resubmissions .................................................................................................. 26  
  - Trash Folder .................................................................................................... 27  
**Working with Folders** ....................................................................................... 28  
  - Folder ................................................................................................................ 29  
    - Private Folder ................................................................................................. 30  
    - Shared Folder ................................................................................................. 31  
  - Creating a Folder .............................................................................................. 32  
  - Editing Folders .................................................................................................. 34  
  - Folder Selection - Selecting a Target Folder ...................................................... 36  
**Working with Documents** .................................................................................. 37  
  - Document .......................................................................................................... 38  
    - Document Class ............................................................................................. 39  
    - Object Folder .................................................................................................. 40  
    - Image Documents ............................................................................................ 41  
    - Executable Documents ................................................................................... 42  
    - Business Object .............................................................................................. 43  
    - Default Documents ......................................................................................... 44  
    - Document Templates ....................................................................................... 45  
  - Attributes .......................................................................................................... 46  
    - Expiry Date ..................................................................................................... 48  
  - Creating a Document ....................................................................................... 49  
  - Creating a Document ....................................................................................... 50  
  - Find Document .................................................................................................. 53  
  - Moving a Document .......................................................................................... 54  
    - Moving a Document ....................................................................................... 55  
  - Changing a Document ...................................................................................... 56  
    - Displaying and Changing a Document ............................................................ 57  
    - Editing a Document ....................................................................................... 58  
    - Inserting Links in a Text ................................................................................. 59  
    - Calling a PC Document .................................................................................. 61  
  - Deleting and Retrieving Documents ................................................................. 63
Attachments to a Document ................................................................. 64
Appending an Attachment to a Document ............................................ 65
Printing Documents and Folder Content Lists ..................................... 67
Document Status ................................................................................. 68
Working with Object Folders ............................................................... 69
Creating an Object ........................................................................... 70
Working with Distribution Lists ......................................................... 72
Distribution List ................................................................................ 74
Shared Distribution List .................................................................... 75
Subscription Lists ............................................................................ 76
Private Distribution List ..................................................................... 77
Creating a Distribution List ............................................................... 78
Creating Distribution Lists ................................................................. 79
Searching for Distribution Lists ......................................................... 80
Editing a Distribution List .................................................................. 83
Sending ............................................................................................... 85
Sending a Document .......................................................................... 87
Sending a Mail with a Callback Function ......................................... 90
Sending a Short Message .................................................................. 91
Reply .................................................................................................. 93
Forwarding a Document .................................................................... 94
Resubmitting a Document ................................................................. 95
Creating a Resubmission ................................................................. 96
Address Type ...................................................................................... 97
Automatic Entry of Address Type ..................................................... 98
Send Attributes ............................................................................... 99
Recipient Lists and Transmission Information .................................. 100
Correspondence History .................................................................. 101
Measures for Periods of Absence ...................................................... 102
Creating a Substitute ........................................................................ 103
Creating Automatic Forwarding ...................................................... 104
Creating an Automatic Reply ......................................................... 105
Private Office Settings ...................................................................... 106
Displaying Addresses and Other Personal Data ................................ 109
Search Screen for LDAP Addresses ............................................... 110
Processing the Quota Notification ..................................................... 111
Object Services ............................................................................... 112
Business Workplace With Other Interfaces ...................................... 113
Business Workplace via the Internet ............................................... 114
Creating, Processing and Sending Documents ................................ 116
Business Workplace: Workflow Functions ...................................... 117
Work Item ........................................................................................... 120
Dialog Work Items (Type W) ............................................................ 122
Status of a Dialog Work Item ............................................................ 123
Status Transitions of a Dialog Work Item ........................................... 125
Missed Deadline Work Item (Type D) .............................................. 127
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow Resubmissions</td>
<td>198</td>
</tr>
<tr>
<td>Work Item Preview</td>
<td>200</td>
</tr>
<tr>
<td>User Exit for Work Item Preview</td>
<td>201</td>
</tr>
<tr>
<td>Workflow Toolbox</td>
<td>202</td>
</tr>
<tr>
<td>Administration of the Business Workplace</td>
<td>204</td>
</tr>
<tr>
<td>Administration of the Send, Folder and Office Functions</td>
<td>205</td>
</tr>
<tr>
<td>Authorizations for the Business Workplace</td>
<td>207</td>
</tr>
<tr>
<td>Sending</td>
<td>209</td>
</tr>
<tr>
<td>Sending Externally from the SAP System</td>
<td>211</td>
</tr>
<tr>
<td>Shared Office Settings</td>
<td>214</td>
</tr>
<tr>
<td>Maintaining Private Office Settings Centrally</td>
<td>218</td>
</tr>
<tr>
<td>Assigning a Business Workplace Manually</td>
<td>219</td>
</tr>
<tr>
<td>User Tables: Consistency Checks</td>
<td>221</td>
</tr>
<tr>
<td>Setting Automatic Forwarding Centrally</td>
<td>222</td>
</tr>
<tr>
<td>Updating Folder Authorizations</td>
<td>223</td>
</tr>
<tr>
<td>Addresses and Communication Methods</td>
<td>224</td>
</tr>
<tr>
<td>Maintaining an Internal Private Address</td>
<td>226</td>
</tr>
<tr>
<td>Maintaining Addresses of Companies and Contact Persons</td>
<td>227</td>
</tr>
<tr>
<td>Creating Company Addresses</td>
<td>228</td>
</tr>
<tr>
<td>Creating Addresses for Contact Persons</td>
<td>229</td>
</tr>
<tr>
<td>Inbound Distribution</td>
<td>230</td>
</tr>
<tr>
<td>Maintaining Inbound Distribution</td>
<td>232</td>
</tr>
<tr>
<td>Information on Documents in the Business Workplace</td>
<td>234</td>
</tr>
<tr>
<td>Maintaining Document Classes</td>
<td>235</td>
</tr>
<tr>
<td>Maintaining PC Document Classes</td>
<td>236</td>
</tr>
<tr>
<td>Creating and Maintaining Default Documents</td>
<td>237</td>
</tr>
<tr>
<td>Mass Archiving</td>
<td>239</td>
</tr>
<tr>
<td>Configuring an HTTP Content Server for Documents in the Business Workplace</td>
<td>240</td>
</tr>
<tr>
<td>Configuring the Storage Category for the HTTP Content Server</td>
<td>242</td>
</tr>
<tr>
<td>Deleting the Shared Trash Folder</td>
<td>243</td>
</tr>
<tr>
<td>Scheduling Reorganization</td>
<td>244</td>
</tr>
<tr>
<td>Inbox Reorganization</td>
<td>246</td>
</tr>
<tr>
<td>Quota</td>
<td>247</td>
</tr>
<tr>
<td>Forms in the Business Workplace</td>
<td>249</td>
</tr>
<tr>
<td>Maintaining Forms</td>
<td>250</td>
</tr>
<tr>
<td>Processing in Overview</td>
<td>251</td>
</tr>
<tr>
<td>Statistics</td>
<td>252</td>
</tr>
<tr>
<td>Data Collection</td>
<td>253</td>
</tr>
<tr>
<td>Data Evaluation</td>
<td>254</td>
</tr>
<tr>
<td>Access Overview</td>
<td>255</td>
</tr>
<tr>
<td>Inbox Overview</td>
<td>256</td>
</tr>
<tr>
<td>Document Overview</td>
<td>257</td>
</tr>
<tr>
<td>Folder Overview</td>
<td>258</td>
</tr>
<tr>
<td>Other Administration Reports</td>
<td>259</td>
</tr>
<tr>
<td>A Mail System Group Between SAP Systems and an External Mail System</td>
<td>260</td>
</tr>
<tr>
<td>System Structure of the Mail System Group</td>
<td>262</td>
</tr>
<tr>
<td>Settings for the Mail System Group</td>
<td>264</td>
</tr>
<tr>
<td>Settings for Sending to the SAP System</td>
<td>266</td>
</tr>
</tbody>
</table>
Business Workplace (BC-SRV-GBT)

The documentation on the Business Workplace is divided into several areas:

Business Workplace [Page 10]
This part contains a short description of the structure and functions of the Business Workplace.

Working with the Business Workplace [Page 12]
This part contains descriptions of the functions and possible applications of the Business Workplace and is aimed at the end user.

Administration of the Business Workplace [Page 204]
This part contains information on how to set up and organize the Business Workplace and is aimed at administrators.
The Business Workplace

Purpose

The Business Workplace provides a standard working environment in which every R/3 user can carry out their share of the business and communication processes in the enterprise. There, they receive all the work items that are assigned to them in the course of SAP Business Workflow and process the documents that were sent to them from people or from R/3 applications. Each user has a folder in which they can manage documents and work processes. Furthermore, each user can read information that has been published within their work group or throughout the company or make this information available themselves.

Introduction notes

The users who participate in SAP Business Workflow in their enterprise must have the Business Workplace. The sending of documents to and from the R/3 applications is also handled by the Business Workplace. Therefore, a direct link to the Business Workplace is provided in many applications. In addition, these components can be used for all the internal and external mailing of a company. You can use the Business Workplace via the interface of MAPI-compatible clients, for example Microsoft Outlook. Furthermore, the Business Workplace is also available as an Internet Application Component.

For information on the settings required for external sending of documents, see BC - SAPconnect [Ext.].

Features

Workflow

Starting workflows
Processing work items
For further information, see Business Workplace: Workflow Functions [Page 117].

Sending

Internal sending

- Users
- Organizational units
- Business objects

External sending

- Internet
- Fax
- X.400
- R/3 <> R/3

Sending to distribution lists

Distribution lists can contain internal and external recipient addresses.
Inbound Distribution
Incoming documents can be distributed centrally or can trigger processing directly.

Folders
Administration of folders and documents
- User-specific private folders
- Public and group-specific shared folders
- Integration of PC applications
- Organization of your own work processes in object folders
- Archive connection

Attachments
Notes

Office organization
Resubmissions
Substitutes
Automatic reply
Automatic forwarding
Working with the Business Workplace

Use

You can start workflows and edit work items as well as create, edit and send documents and messages in the Business Workplace.

Features

The following screen areas are available in the Business Workplace:

Folders

The folders of your Business Workplace are displayed here in a tree structure. By clicking on a folder you call the contents of that folder.

Contents list

A list is displayed here of all the documents, distribution lists, folders and objects contained in the folder that you have selected in the folder tree. By clicking once you call the preview of a list entry, by double-clicking you branch to the full screen display of this list entry.

Preview
The list entry that is selected in the folder contents list is displayed here, provided that the entry supports the preview. Further functions are available in the work item preview [Page 200]. If necessary, you can hide the preview.

**Activities**

The initial screen of the Business Workplace provides the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and send new messages</td>
<td>Choose New Message. Proceed as described in Sending a Short Message [Page 91].</td>
</tr>
<tr>
<td>Find folder</td>
<td>Choose Find folder. The dialog box for folder selection [Page 36] is displayed.</td>
</tr>
<tr>
<td>Maintain appointment calendar</td>
<td>Choose Appointment Calendar. Your appointment calendar [Ext.] is opened in a new session.</td>
</tr>
</tbody>
</table>
| Display employee calendar       | 1. Choose Environment → Employee calendar  
2. In the subsequent dialog box, enter the name of an employee.  
3. Choose . The appointment calendar of the employee is displayed in a new session. Provided that you have authorization, you can also maintain the employee calendar. |
| Display employee address with detailed data | 1. Choose Environment → Display personal data  
2. In the subsequent screen, enter search criteria for the required user, for example, the name or department. A generic entry with * as the joker for a character string (e.g. B*ker) is permitted for the name.  
3. Choose . A list of all the users who fulfill the search criteria is displayed. |
| Find and display external addresses | Choose Environment → External contact persons or External companies or External directory service.  
A search screen in which you can search for addresses [Page 109] is displayed. |
Maintain office settings

Choose Settings --> Office settings.

A dialog box is displayed in which your private office settings [Page 106] are arranged according to subject areas on tab pages.

Save or do not save Workplace display when exiting

If you want your Workplace to appear with the same settings (for example, the way the folder tree is expanded, which folders are displayed) the next time you call it, you have to save these settings when you exit. You can also switch off this function.

In order to switch between saving and not saving, choose Settings --> Save when exiting or Do not save when exiting.

Only the executable menu option is displayed each time.

Hide or show document preview

Choose Settings --> Hide preview or Show preview.

Only the executable menu option is displayed each time.

Further functions are available in the screen areas Folders and Folder contents list. For further information, see Business Workplace: Workflow Functions [Page 117] and Send, Folder and Office Functions [Page 15].

Calling the Business Workplace

<table>
<thead>
<tr>
<th>Menu Path</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Office \rightarrow Workplace</td>
<td>It is preset that the workplace is displayed in the same way as it was when you last left it. This does not apply to the way the folder contents list is sorted. If you have specified that the Business Workplace display is not to be saved, the Workplace is always displayed as it was when this function was called.</td>
</tr>
</tbody>
</table>

April 2001
The Send, Folder and Office Functions

For information on these functions of the Business Workplace, see

- Working Environment for Documents and Messages [Page 16]
- Working with Folders [Page 28]
- Working with Documents [Page 37]
- Working with Distribution Lists [Page 72]
- Send [Page 85]
- Measures for Periods of Absence [Page 102]
- Private Office Settings [Page 106]
- Business Workplace with Other Interfaces [Page 113].
Working Environment for Documents and Messages

Use

This part of the Business Workplace working environment is used for organizing and managing folders, documents, messages, distribution lists and objects.

For information on processing work items, see Business Workplace: Workflow Functions [Page 117].

Features

The Business Workplace has six working environments for processing documents and messages. The working environments are flagged with symbols.

<table>
<thead>
<tr>
<th>Working Environment</th>
<th>Description</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inbox</td>
<td>Under Documents, you find all the documents sent to you and their resubmissions. Under Unread documents, you find only those documents which you have not yet read (that is, they are displayed in the preview).</td>
<td></td>
</tr>
<tr>
<td>Outbox</td>
<td>Under Documents, you find an overview and information about the documents sent by you.</td>
<td></td>
</tr>
<tr>
<td>Resubmissions</td>
<td>Under Documents, you find the documents that are to be resubmitted to your inbox at a future date.</td>
<td></td>
</tr>
<tr>
<td>Private folders</td>
<td>A folder structure that you create yourself for managing your documents, messages, distribution lists and work processes.</td>
<td></td>
</tr>
<tr>
<td>Shared Folders</td>
<td>A folder structure for publishing and managing information, on either an enterprise-wide or a group-specific basis, and for accessing this information dependent on authorizations.</td>
<td></td>
</tr>
<tr>
<td>Subscribed Folders</td>
<td>The folders that you subscribe to are displayed here.</td>
<td></td>
</tr>
<tr>
<td>Trash folder</td>
<td>Deleted folders, documents, distribution lists and work processes are stored here temporarily and you have the option of undoing the deletion.</td>
<td></td>
</tr>
</tbody>
</table>

Activities

In order to display the contents of a working environment, click on the required working environment in the folder tree. The corresponding folder content list is displayed.
Inbox

Use

From your inbox, you can display and process documents that have been sent to you and work items which have been assigned to you. The inbox is divided into different areas that filter the whole list according to the information you want to access (for example, unread documents only, work items to be processed by you or missed deadlines).

Integration

The inbox groups together different worklists:

<table>
<thead>
<tr>
<th>Worklist</th>
<th>Contents</th>
<th>Classification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documents</td>
<td>Documents which have been sent to you and resubmissions</td>
<td>![icon]</td>
</tr>
<tr>
<td>Work items</td>
<td>SAP Business Workflow work items assigned to you</td>
<td>![icon]</td>
</tr>
</tbody>
</table>

Classification is used to differentiate between the various functions for work items and for documents. As a result, the relevant context menu contains only the functions that are possible for the selected entry.

Features

Working with work items

You can process work items that have been assigned to you. It is also possible to start workflows. For information on processing work items and starting workflows, see Workflow Inbox [Page 158].

Working with Documents

The following functions are available for documents that have been sent to you and resubmissions: reply, forward, edit and send. For more information on this topic, see Working with Documents [Page 37]
Outbox

Use

The outbox serves as a folder for the documents that you have sent, the work items that you have executed and the workflows that you have started. In this way, it enables you to gain an overview of the work you have done and to continue to monitor the status of the documents, work items and workflows. The outbox is divided into different areas that filter the whole list according to the information you want to access (for example, only documents that you have sent or work items that you have processed).

The outbox provides an overview of the documents that you have sent. The send status of documents that you have sent to one recipient only is displayed in the list directly. Furthermore, you can call more transmission information [Page 100] for individual documents. You can find out, for example, whether they have been read by the recipients.

In the shared office settings [Page 214], the administrator can set an expiry date for the outbox so that the list of documents does not become too big. If an expiry date is entered, the documents stored in the outbox are deleted after the specified time period. You can move documents that are not to be deleted to a folder in private folders [Page 19].

Prerequisites

Documents are automatically moved to the outbox after sending if this is specified in the private user settings [Page 106]. When you send documents, you can change the default settings in the Send dialog box. You can also define a private folder either as the sole storage location or as an additional storage location for the documents that you have sent.

Activities

Access your outbox and display the document list. If you require additional information about a document, access the required option from the context menu of the document (for example, the recipient list).
The Folder *Private Folders*

**Use**

The folder *Private folders* in the Business Workplace is used for organizing a users' documents, distribution lists and work processes. Users can manage the information that they require for their own tasks and work processes and that does not have to be accessed by other employees here.

Users can access the folder *Private folders* in their Business Workplace. It is the root folder of the hierarchically structured [private folders](Page 30) and is flagged with the icon 📁. Private folders can contain other private folders, documents, and distribution lists. All documents, object folders and distribution lists relating to one project or topic can be stored in a corresponding folder, including subfolders if required.

The following figure shows how you can arrange your *Private folders* folder in the Business Workplace.
Activities

Create a suitable folder structure for your work. You should move your inbox documents to this folder structure as soon as possible so that system performance is not reduced and you can access the information you require faster.
Shared Folders

Use

The shared folders in the Business Workplace are used for organizing the documents, distribution lists and Business objects of several users. Information that is required for group projects and other teamwork, in other words information that is to be made accessible to several employees, can be managed here.

In this way, it is possible to allow either all users or only a defined group of users access to the same information in a folder in shared folders. Depending on this usage type, a distinction is made between client folders and group folders. Access to the folders can also be varied according to whether the information is to be used for publication only or whether it is to be processed further. To do this, different access authorizations to a folder can be assigned.

Users can access the shared folders in their Business Workplace. The shared folder is the root folder of the hierarchically structured shared folders [Page 30] and is flagged with the icon 📁.

Examples of shared folders:

**Bulletin board (client folder)**

The bulletin board is a source of information and messages for all employees within a company. All employees can display, create, and sometimes change documents.

**Personnel department information folder (client folder)**

This folder can contain documents of general interest and may therefore be displayed by all employees. However, only personnel department staff has the authorization to create or change documents in this information folder.

**Project folder (group folder)**

A project folder can serve as a discussion forum. This folder can store, for example, project plans, proposals, minutes of meetings and activities. Only employees involved in a particular project may display, create and change documents in this folder.

Shared folders can contain other shared folders, documents, and distribution lists. All documents, object folders and distribution lists relating to one project or topic can be stored in a corresponding folder, including subfolders if required. The following figure shows how shared folders in the Business Workplace can be arranged.
Depending on company size and usage intensity, shared folders can have very complicated hierarchies. If this is the case, you should subscribe to the folders that you repeatedly access so that you can access the information you require faster and more easily.

**Activities**

To set up this structure in accordance with the requirements of the different departments, the administrator should contact the representatives of each department when defining the folder structure.

In order to control which users can access the folders and with which authorizations, access authorizations [Page 24] are defined for shared folders.
Folder Access Authorizations

Use
Folder access authorizations control the distribution of information in shared folders. Each user can have different access to information.

Features
The following access authorizations can be assigned:

Display authorization for folders and documents
The user can display the documents and distribution lists stored in the folder and the attributes of the folder. The user can also send documents to the distribution lists stored in the folder.

Change authorization for documents
The user can also create and change documents in the folder.

Change authorization for folders and distribution lists
The user can also create and change folders and distribution lists in the folder as well as change the attributes of the folder.

Administrators and folder owners automatically have change authorization for folders and distribution lists.

In order to create a shared folder, the user must also be assigned the corresponding authorization [Page 207] in his or her SAP user master data.
**Subscribed Folders**

**Use**

Subscribed folders are used to gain fast access to the shared folders that you use often. It can take a relatively long time to access the required information in shared folders, particularly those that have very complicated hierarchies. You can reduce the time and the navigation required by subscribing to folders.

The folders that you have subscribed to are displayed directly under the root folder Subscribed folders that is flagged with the icon 📖.

**Activities**

To subscribe to a shared folder, position the cursor on this folder in the folder tree and choose *Subscribe* in the context menu.

To remove a folder from the folder area of the subscribed folders, choose *Cancel subscription* in the context menu of the folder.
Resubmissions

Use
The resubmissions folder is used to temporarily store documents that are to be placed in your inbox again in the future. These can be documents for which you yourself have created a resubmission or for which the sender has created a resubmission.

You can resubmit a document, for example, in order to be reminded of an appointment or a task that has to be completed at a certain time.

Integration
When users define their own resubmissions, there are two possible cases:

- When the user defines a resubmission for a document in the inbox, the document is moved to the resubmissions folder and no longer appears in the inbox display.

- If a resubmission is defined for a document in the outbox or in a private folder, a link to that document is created in the resubmissions folder and the document itself remains in the outbox or in the private folder and can be processed. Any subsequent changes made to the document in the outbox or the folder also apply to the referenced version in the resubmissions folder.
Trash Folder

Use

The trash folder temporarily stores all the documents, distribution lists and folders that you have deleted from your private folder area. Deleted documents, distribution lists and folders from shared folders are each moved to the owner's shared trash folder. Therefore, every user's shared trash folder contains the objects from shared folders that they have created and that they, or another user, have deleted.

Documents for which the expiry date has been reached are automatically placed in the trash folder. As long as the deleted objects are stored in the trash folder, you can retrieve them in the private folder area. Trash is automatically deleted at regular intervals.
Working with Folders

Use

Folders can be used to organize and manage documents in your private folders and to publicize information within your company in shared folders. The folders are displayed hierarchically in a folder tree. The objects contained in a selected folder in the folder tree are displayed in a list.

You can adapt the display of the folder content list to suit your needs using the standard R/3 functions. You can, for example, set multi-level sorts and show or hide individual columns.

Activities

Proceed as described in Editing Folders [Page 34].

If you want to edit the folder content list, see Working with Documents [Page 37] and Working with Distribution Lists [Page 72].
Folder

Definition
This is a synonym for a folder in the real office environment. Just like normal folders, documents are stored in folders. In addition, other folders can be stored in a particular folder. As a result, folders can contain hierarchical folder structures with parent folders and subfolders.

Folders can be created in your private folders or in shared folders in the Business Workplace. According to the folder which is involved, a distinction is made between private folders [Page 30] and shared folders [Page 31].

Use
Folders are used to organize folders and to store the information that accumulates during the working day. Documents and other objects relating to certain topics or projects can be filed in an appropriate folder structure.

Structure
Folders consist of their contents and attributes. Shared folders are also assigned authorizations. The possible contents of a folder include documents, distribution lists, objects and subfolders. The attributes are:

- Name and title
- Flag indicating whether the folder can only contain objects
  - If this is the case, it is an object folder [Page 40]. Other attributes are also assigned to an object folder.
- Owner, creator and the last person to make changes as well as the creation time and the change time.

In addition, shared folders have other attributes:

- Flag indicating whether the folder is indexed for faster searches
  - When folders are indexed, OFIC is automatically assigned as the information class.
- Retention period of the documents in the folder
- Flag indicating whether the folder is a client folder or a group folder
- Folder access authorization [Page 24]
Private Folder

Definition

Folder [Page 29] that is stored in the folder Private folders, that is, the folder is subordinated to the folder Private folders either directly or via several levels. A private folder is user-specific and can therefore only be accessed by the users themselves and any specified substitutes.

Use

Users can create their own private folder structures. This structure can be used, for example, to store documents that you alone process. If the user is absent, a substitute, who has access to the private folders of the user, can be specified. In addition, a folder can be flagged as Confidential so that it is not displayed to substitutes.
Shared Folder

Definition

Folder [Page 29] that is stored in shared folders, that is, the folder is subordinated to the folder
Shared folders either directly or via several levels. A shared folder is group-specific or client-
specific: either all users within one client or a defined group of users are able to access the
folder.

Use

Shared folders allow more than one user to access the same document. Authorizations for
displaying and editing documents can be entered for each folder.

In addition, an expiration time for documents in this folder can also be specified. If the specified
number of days is exceeded, the document is deleted automatically.

If there are a large number of shared folders in one client, the structure may become unclear to
users. To avoid unnecessary searches and navigation tasks, individual users can create their
own views for shared folders. To do this, you can subscribe [Page 25] to the folders that interest
you, so that only those folders are displayed when you access shared folders.

Structure

The owner of a shared folder can assign various access authorizations to users. Shared folders
can be divided into:

- Client folders
- Group folders

Each user with the required access authorization in the relevant client can access client folders.
In addition, users can be assigned different access authorizations.

Only users with the required authorization can access group folders.

The personnel department releases information about the company’s social benefits
in a client folder, so that all employees can be informed of the benefits. A project
team creates a group folder to make project-relevant information available to all
project team members.
Creating a Folder

Prerequisites

To create shared folders, you have to be listed in the authorizations list for the parent folder with the access authorization change folders and documents.

Procedure

<table>
<thead>
<tr>
<th>Function</th>
<th>Procedure</th>
</tr>
</thead>
</table>
| Create a private folder | 1. Choose Create subfolder in the context menu of the private folder that you want to store the new folder in.  
2. Enter a name and a short description in the Folder fields.  
3. Specify whether the folder is to be indexed for faster searches  
4. Specify whether the folder contains confidential information. If this is the case, your substitute cannot access the folder.  
5. Choose . The folder is created and displayed in the folder tree. |
| Create a shared folder | 1. Choose Create subfolder in the context menu of the private folder that you want to store the new folder in.  
2. Enter a name and a short description in the Folder fields.  
3. Specify whether the folder is to be indexed for faster searches  
4. Specify the number of days after which objects are automatically deleted from the folder. If you leave this field blank, objects are only deleted automatically if an expiry date is assigned to them individually.  
5. Specify whether the folder can be accessed by all users (client folder) or only by the users that you list on the tab page (group folder).  
6. Specify an access authorization. In the case of client folders, this access authorization applies to all users, except those that you list on the tab page Authorizations with a different access authorization. In the case of group folders, this access authorization is automatically assigned to all the users who you list on the tab page Authorizations, as long as you do not explicitly specify a different access authorization.  
7. When you create a group folder, on the tab page Authorization specify the users who can access the folder with the assigned authorization. You can specify individual users, organizational units and shared distribution lists. In the case of client folders, you can specify the users who can access the folder with a different access authorization to that specified on the tab page Attributes.  
8. Choose . The folder is created and displayed in the folder tree. |
### Creating a Folder

| Create an object folder | To create object folders [Page 40], proceed as described in Create a private folder or Create a shared folder. Select Folder only contains objects on the tab page Attributes. In the case of private object folders, also specify the changeability, sensitivity, priority and, if necessary, expiry date. |
Editing Folders

Prerequisites
For shared folders, you require the relevant folder access authorization [Page 24].

Procedure

<table>
<thead>
<tr>
<th>Function</th>
<th>Procedure</th>
</tr>
</thead>
</table>
| Find folder                      | 1. Choose \(\text{Find folder}\).  
2. Proceed as described in Folder Selection [Page 36].                                                                                           |
| Display folder contents          | Select a folder in the folder tree by clicking on it once.                                                                                                                                                  |
| Display folder attributes        | In the context menu of the folder, choose Attributes.                                                                                                                                                     |
| Display authorization list for a shared folder | 1. In the context menu of the folder, choose Attributes.  
2. Switch to the tab page Authorizations.                                                                                                          |
| Subscribe to a shared folder     | Choose Subscribe in the context menu of a shared folder. A link to the folder is stored in the Folders subscribed to [Page 25] folder. If you want to remove a folder from your subscribed folders, choose Cancel subscription in the context menu of the folder. |
| Move folder                      | 1. In the context menu of a folder, choose Move.  
2. Select a target folder in the Folder selection [Page 36] dialog box. You can only move folders within a folder, therefore only within private folders [Page 19] or shared folders [Page 21] or from the trash folder to a folder in the original folder area.  
You can also move the folder using drag and drop.                                                                 |
| Delete folder                    | 1. In the context menu of a folder, choose Delete  
2. Confirm the subsequent dialog with Yes. The folder is temporarily placed in your trash folder [Page 27].  
You can also put the folder in the trash folder using drag and drop.                                                                                   |
**Retrieve a deleted private folder**

1. Call the trash folder in the folder tree.
2. Select the folder in the folder contents list.
3. In the context menu of the folder, choose *Retrieve*.

   The folder is put back in the original folder, that is, the folder that it was deleted from.
Folder Selection - Selecting a Target Folder

Use

When using functions such as create or move folders, documents, or distribution lists, you can select the storage location for the object that has been processed using this function. When selecting a target folder, you can call a dialog box that offers the following functions:

- Input help and search help for selecting an existing folder
- Option to create a new folder
- For documents and distribution lists there is also an option to append the object as an attachment of an existing document.

Procedure

The Folder selection dialog box appears.

1. Choose whether you want the object to be stored in your private folder area or in the shared folder area.
2. Enter the name and/or the title of a folder.
3. Choose 🟢.

   If the specifications were unique, the object is moved to the folder specified. If they were not unique, the folders that correspond to the specifications are listed. Select the required folder from the list by double-clicking on it and choose 🟢.

   When entering a folder name and title, the following additional options are available:

   - A generic entry is permitted. To make a generic entry, enter part of the name with * as the joker for the missing parts of the name (for example, Plan*) and choose 🟢.
   - You can also call the input help in the Folder name field.

   In both cases, all the folders in the chosen folder area that correspond to your search criteria are displayed and you can select the required folder by double-clicking on it. If you have not specified anything, the entire folder structure of the chosen folder area is displayed. If you specified unique search criteria for the generic search, the object is moved directly to the corresponding folder. The success message then tells you which folder the object was moved to.
Working with Documents

Use

During the working day a lot of subject matter is recorded in writing. It is important to store the recordings efficiently in order to ensure fast access to the right information. For this purpose, the Business Workplace provides a document folder system that users can use to organize and further process the documents that have been sent to them and the documents that they themselves have created.

Integration

You can change the default setting for working with documents in your private office settings [Page 106].

When you send a document from your private folder area internally, the storage location of the document in the database does not change. Therefore, the recipient does not receive a copy of the document that is stored in your inbox or in one of your private folders, but rather a link to the same document. Changes that you or a recipient make to the document can therefore be seen by all the users who have a link to the document, in other words, the users who have created the document or received it. If you delete the document, it remains in the folders of these other users.

In contrast, only copies can be sent from shared folders. In this case, the recipient receives a new execution of the same document.

Features

In the Business Workplace you can edit various document classes [Page 39]. You can create [Page 49] documents, as well as display and change [Page 56] documents. The Business Workplace offers a large range of functions that can be used to edit [Page 58] documents. You can also move [Page 54] documents between folders.

For more information on how to send and reply to documents, see Send [Page 209].
Document

Definition
Information stored coherently. Documents can contain text or graphics, for example. Documents of various classes [Page 39] can be created, stored and edited in the Business Workplace.

Use

Structure
Documents from the Business Workplace consist of the following components:

- Document content
- Attributes [Page 46].

If attachments were appended to the document or the document was sent, the following components are also included:

- Attachment list
- Recipient list [Page 100].

These components are arranged on tab pages on the document display screen or the document maintenance screen. The document content of messages is edited on the appropriate tab page directly. The standard text editing functions are available. You edit the document content of PC documents in the appropriate PC application. It is possible to integrate the editor of PC applications that support OLE, for example Microsoft Word, directly in the R/3 window. The functions of the PC application and of the Business Workplace can be used during editing.
## Document Class

### Definition
Classification of documents. The functions of the Business Workplace which can be applied to the document depend on the document class.

### Integration
The different document classes are managed in an administration table. This table defines, for example, which documents can be created via the Business Workplace interface. Further information can be found in the administration section [Page 235] of this documentation.

In private office settings [Page 106] users can define which document classes are displayed to them directly under a user-defined name (for example, Word document for DOC) for creation in the Business Workplace. The administration can define a default for this setting in shared office settings [Page 214] so that the document classes used most often are displayed directly to all users.

In the Business Workplace you can use the following document classes:

<table>
<thead>
<tr>
<th>Document type</th>
<th>Document Class</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP documents</td>
<td>Message</td>
<td>RAW</td>
</tr>
<tr>
<td></td>
<td>SAPscript document</td>
<td>SCR</td>
</tr>
<tr>
<td></td>
<td>SAP graphic</td>
<td>GRA</td>
</tr>
<tr>
<td></td>
<td>Business object [Page 43]</td>
<td>OBJ</td>
</tr>
<tr>
<td></td>
<td>ABAP list</td>
<td>ALI</td>
</tr>
<tr>
<td></td>
<td>Binary document</td>
<td>BIN</td>
</tr>
<tr>
<td></td>
<td>List viewer document</td>
<td>XXL</td>
</tr>
<tr>
<td></td>
<td>Archived document, for example, image document [Page 41]</td>
<td>ARC</td>
</tr>
<tr>
<td></td>
<td>Incoming fax</td>
<td>FAX</td>
</tr>
<tr>
<td></td>
<td>Link to the intranet or Internet</td>
<td>URL</td>
</tr>
<tr>
<td>PC documents</td>
<td>The file extension that corresponds to the PC application used is displayed to the user. In the system, the class EXT is assigned to all PC documents.</td>
<td>For example, DOC, PPT</td>
</tr>
<tr>
<td>Other</td>
<td>Folder [Page 29]</td>
<td>FOL</td>
</tr>
<tr>
<td></td>
<td>Object folder [Page 40]</td>
<td>OFO</td>
</tr>
<tr>
<td></td>
<td>Distribution list [Page 74]</td>
<td>DLI</td>
</tr>
</tbody>
</table>
Object Folder

Definition

Folder in which objects alone are managed and edited. Object folders are displayed in the folder tree and can be edited using various folder and document functions.

Use

Object folders are suitable for topic-related administration of private or group business objects. The objects in an object folder can be separated in a hierarchical structure and executed in the folder.

The following folder functions are possible:

- Create objects in the folder
- Assign folder attributes, such as the folder area and the folder access authorization

The following document functions are possible:

- Sending
- Create note for an object folder
- Assign the document attributes Changeability, Sensitivity, Priority and Expiry date
- Create link
- Resubmit

For further information, see Working with Object Folders [Page 69].

Integration

The objects that can be stored in an object folder are SAP Business objects [Ext.] from the Business Object Repository, for example a telephone call or a workflow, together with the relevant methods, for example Create.
Image Documents

Definition
Optical document that has the class ARC in the Business Workplace. Image documents are scanned in and stored in an optical archive.

Use
Image documents are used in many areas. Important image documents, i.e. invoices and other documents, must sometimes be available decades later. Such documents should therefore be archived. You can find more information about archiving in the SAP ArchiveLink [Ext.] documentation.

Prerequisite
A scanner and an archive system must be connected to the R/3 System.
To create an image document in the Business Workplace, the scan dialog must be started and the scanned image displayed and selected.
To change an image document (that is, to attach a new image), the image to be appended must either be in a scan dialog or displayed and selected in the archive.

Features
You can create, display and change image documents in the Business Workplace by appending further images. These images can either be archive images or new images. The change function enables you, for example, to group together images which have the same type of contents (i.e. orders, order confirmations, invoices).

Image documents that have been sent cannot be changed.
Executable Documents

Definition
A document to which a transaction, report, dialog module or a function module (with the corresponding data) is assigned. If this document is sent, the recipient can execute the document.

Use
Executable documents can be used for a very limited ‘mini-workflow’. In the process, an application creates a document, assigns an action to the document and sends the document to a recipient. If the recipient executes the document, the action is carried out.

To execute a document, choose *Execute* in the folder contents list in the context menu of the document or double-click on the icon in the column *Executable*.

As standard, the column *Executable* is not displayed in the folder contents list. To add it, you have to configure a new layout for the inbox.
Business Object

Definition
Representative of a central business object of the real world. Business objects describe concrete or abstract objects as well as activities or processes. Examples include purchase orders, contracts, customers, risk or telephone calls.

Use
Business objects are used to model and further process objects occurring in your company in the R/3 system. Certain processing options, for example display, change or send, are available for each business object.

For information on the technical use of business objects, see Business Object / Objects [Ext.].
Default Documents

Definition

Document template [Page 45] that is assigned to a document when the document is created. Default documents can be passed from the Business Workplace to the appropriate PC application, for example, when the PC document is being created. Default documents can also be forms, for example.

Use

Default documents are required for technical reasons when a PC application expects a formatted transfer file. You can create several default documents for one PC application. This is recommended, for example, if several versions of the same application are used within the company.

You can also use default documents as company-specific layout templates and, in this way, offer users a selection of forms, for example, when they create SAPscript or Word documents.

If only one default document exists for a document class, this is always used as the template when documents of this class are created. If several default documents exist for a document class, these are displayed to the user for selection when documents of this class are created. The use of default documents is not restricted to certain users.

Default documents can only be created by administrators [Page 237].
Document Templates

Use
Document templates serve as a basis for the creation of a new document. They can provide a standard layout for certain company documents and contain additional text, for example, for forms.

Integration
Document templates for messages, SAPscript documents and PC documents are created as 'normal' documents in the Business Workplace. Depending on the application, the following attributes must be assigned to the documents:

- changeable for templates that are for general use
- changeable or changeable by author for templates that are for private use

If a document template is used by all users or by a group of users, store the document in a client folder or a group folder in shared folders. If a document template is only used by one user, store this document in a private folder.

Alternatively, you can also use default documents [Page 44] as document templates. However, only the administration can create default documents.

Activities
In order to use a changeable document as a document template, select the document and choose Copy from in the list field for [ ]. Then proceed as described in Creating a Document [Page 50]. If the document template has attachments, these are also appended to the new document as links.
Attributes

Use
An overview of the features, history and storage location of a document is displayed on the tab page Attributes in the document display or document maintenance. Some attributes can only be defined when a document is being created; others can still be changed later.

Features

Characteristics

- Document class [Page 39]
- Changeability
  Other users can access documents that you create if, for example, you send them, put them in shared folders or if you have defined substitutes. You can define documents with sensitive contents as Not changeable or Changeable by author only so that they are not changed. You can assign the attribute Changeable by all to other documents, for example, discussion papers. Changes to the document sent can then be seen by the author and the internal recipients of the document, irrespective of the storage location in the R/3 System. Changes do not affect copies. The following characteristic values of changeability can be assigned:
    - Changeable
    - Changeable by author
    - Not changeable
  In the private folder area, the changeability only refers to the time period after which the document was sent. Documents that are created in shared folders can only be defined as either Changeable or Changeable by author under the Changeability attribute.

- Sensitivity
  You can assign documents different sensitivities:
    - Standard
    - Confidential
    - Functional
  Confidential documents, distribution lists and folders are not visible to substitutes who work in your private folder area. In your private office settings, you can specify that confidential documents are not sent to external addresses (for example, via fax or Internet). In this case, if the recipient of a document marked by you as confidential forwards this document to an external address, the document remains in his R/3 inbox.
  Documents that are created in shared folders do not have the attribute Sensitivity.

- Priority
  Documents can be sorted in a folder content list according to their priority. The following values are available:
    - Low
Attributes

- **Medium**
- **High**

Documents that are created in shared folders do not have the attribute *Priority*.

- **Document size**
  This value specifies the size of the document.

- **Language**
  The language in which the document is created must be specified so that the technical treatment of the document is controlled accordingly. The logon language is set as the default.

- **Expiry date**
  When the specified expiry date [Page 48] is reached, the document is automatically deleted.

**History**

The owner, the creator and the last person to make changes, along with the creation time and the change time, are displayed.

If a document is created by a substitute, the owner is not the same person as the creator. In this case, the substitute is the creator and the user for whom the substitute created the document is the owner.

**Storage Location**

- **Folder**
  The folder in which the document was created is specified. If the document is located in other folders, these are listed under the link list. By specifying a different folder here, the document can be moved to a different folder.

- **Link list**
  All the folders in your private folder area in which, in addition to the current folder, links to the document exist are listed. The links of other users to this document are not displayed.

**Activities**

You can change the priority, the expiry date and the storage location of a document. For a document that has been sent, these attributes are only valid for the user who made the change. Other attributes can only be changed if a document is modifiable and before a document is sent. If a document is not modifiable, the attributes can only be changed when the document is created or possibly when a document is copied. The document size, the history and the link list are purely display values, which are only changed by the system after corresponding actions, such as the insertion of text or the creation of a link.

You can change the default setting for some attributes in your private office settings [Page 106]. Administrators define standard settings for some values in the shared office settings [Page 214].
Expiry Date

Use

An expiry date can be specified for documents that have an information value that is limited in time. The documents are automatically deleted when this date is reached. By specifying an expiry date, you reduce the system load and your own clear-up work.

Shared folders and the outbox contain specifications regarding the retention period of the documents contained in them. If this retention period has expired, the document concerned is deleted from this folder even though the expiry date assigned to the document specifies a later point in time. The retention period in shared folders is maintained by a person responsible for folders. The retention period in the outbox is defined by an administrator in the shared office settings.

Activities

When you create a document, the expiry date specified by an administrator in the shared office settings [Page 214] is set as the default. Users can overwrite this value at any time in the attributes [Page 46] of a document.
Creating a Document

Use

A document that has been created in the Business Workplace can be sent, filed in one of the folders, or edited using other functions.

Integration

Documents can be created in your inbox, outbox, private folders, shared folders and resubmissions folder. In private office settings [Page 106] users can define which PC document classes are displayed to them directly under a user-defined name (for example, MS Word document for DOC) for creation in the Business Workplace. The administration can define a default for this setting in shared office settings [Page 214] so that the document classes used most often are displayed directly to all users. In the table for the maintenance of document classes [Page 235], the administration can prohibit the creation of documents of certain classes.

Prerequisites

To be able to create PC documents, the appropriate software must be installed on your PC.

Features

You can create documents by

- creating new documents with or without reference [Page 45].
- creating new PC documents in the Business Workplace or creating documents existing on your PC as documents in the Business Workplace.
- creating existing or new documents of any class (except those that have been prohibited by administrators). This includes, for example,
  - creating image documents [Page 41] as documents in the Business Workplace
  - creating business objects [Page 43] as object documents in the Business Workplace. Business objects can be created in a 'normal' folder or in an object folder [Page 40].
  - creating new SAPscript [Ext.] documents. Text formatting options are available in the SAPscript editor so that SAPscript is particularly suitable for creating forms.

Activities

Proceed as described in Creating a Document [Page 50].
Creating a Document

Prerequisites

You can create documents of the classes that were not forbidden by the administrators [Page 235].

When you create a document, the attributes [Page 46] that you have preset in your private office settings [Page 106] are used as a basis. With most documents you can change the attributes during the creation process. It is only when you are creating PC documents using the Import function that the document is directly created with the preset attributes and you do not have the opportunity to change the attributes. However, you can change the attributes afterwards, provided that the document has not already been sent.

Whether and which documents are proposed when you use the function Create more documents directly depends on your private office settings.

It is advisable to create PC documents that involve a lot of work on your PC first and to process them offline. The existing document can then be created in the Business Workplace using the Import function described below.

Procedure

The procedure differs depending on the class of the document that you want to create:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create short message   | 1. In the folder content list, choose New Message.  
2. Proceed as described in Sending a Short Message [Page 91] from step 2.  
   Irrespective of whether you send the message directly or only create it, when it is saved it is moved to the outbox and/or to the folder defined for documents sent, depending on your private office settings. |
| Create message         | 1. In the folder content list, choose .  
2. Enter a title.  
3. On the tab page Document content, enter the text. The standard text editing functions are available. You can change the document attributes on the tab page Attributes.  
   Further editing options [Page 58] are available. |
### Creating a Document

| Create more documents directly | 1. In the folder content list, choose `<Name>` in the list field of <11826397>.
|                              | `<Name>` corresponds to one of the names specified in your private office settings for the default PC document classes, for example, **MS Word document**.
|                              | 2. The rest of the procedure depends on the document class.
|                              | You edit the document contents of PC documents in the PC application. You can change the attributes in the Business Workplace on the tab page **Attributes**.

| Create (import) a document existing on your PC in the Business Workplace | 1. In the folder content list, choose **Import** in the list field of <11826397>.
|                                                                         | 2. In the subsequent dialog box, navigate to the required PC folder and select the document by double-clicking on it.
|                                                                         | The document is created in the current folder in the Business Workplace. In the process, the existing file name, without the file extension, is automatically copied as the title.

| Create documents of any class | 1. In the folder content list, choose **Create more** in the list field of <11826397>.
|                              | The document maintenance screen appears on the tab page **Attributes**.
|                              | 2. Specify the required document class [Page 39] and, if necessary, change the attributes.
|                              | 3. Switch to the tab page **Document content**.
|                              | 4. The rest of the procedure depends on the selected document class. The creation of a graphic of the class BMP is described below as an example.
|                              | The document is finally moved to the folder that is specified in the attributes.

| Create an existing or new object in the Business Workplace | 1. In the folder content list, choose **Create more** in the list field of <11826397>.
|                                                          | The document maintenance screen appears on the tab page **Attributes**.
|                                                          | 2. In the field **Document class**, enter **OBJ** and, if necessary, change the attributes [Page 44].
|                                                          | A dialog box with the available object types appears.
|                                                          | 3. Select an object type.
|                                                          | 4. Specify which object you want to create as the object document in the Business Workplace. You can either create an object existing in the R/3 System or, possibly, a new object. The procedure depends on the selected object type. In Creating an Object [Page 70], the creation of a telephone call is described as an example.
|                                                          | The procedure for creating a graphic is described below as an example.
Creating a Document

When you create a new PC document from the Business Workplace, you may receive the message from the PC application that the file cannot be opened because it does not correspond to the format of the application. In this case, proceed as follows:

Create the document in the PC application and then create the existing document using the Import function in the Business Workplace. Alternatively, contact your system administrator. The administrator can create a default document [Page 44] for the relevant application.

Example: The creation of a new graphic of the class BMP:

1. In the folder content list, choose Create more in the list field of 

   The document maintenance screen appears on the tab page Attributes.

2. In the field Document class, enter BMP and, if necessary, change the attributes [Page 44].

3. Switch to the tab page Document content.

   A graphic-editing program installed on your PC (for example, MS Paint) is opened in a separate window.

4. Edit the graphic and save the document firstly in the PC application and then in the R/3 System. For further information, see Calling a PC document [Page 61].
Find Document

Use

You can search for documents in the Business Workplace using this procedure. You can search for all document classes, but not for folders or distribution lists. There are separate search functions for folders and distribution lists. Various attributes can be used as search criteria besides the document class. You can, for example, search for messages (document class RAW) in your private folder area that you have received from a particular sender.

Procedure

1. In your Business Workplace, choose Documents. A dialog box is displayed in which you can enter the search criteria.
2. Restrict the search area. Choose between private and shared folders and also specify the folders that are to be searched.
3. Enter the search criteria. The following entry options are available:
   - Document Class
   - Document title
   - Creator
   - Last person to make changes
   - Recipient
     A generic entry with * as the joker for a character string is permitted (for example, document *ing), except for when document class is used.
4. Specify whether all documents are to be searched or only those that have been changed in the last week, the last month or in a time period to be specified.
5. Choose.

Result

The folder Search result is added to your folder tree. All the documents that correspond to your search criteria are listed in the folder content list of this folder. You can edit this document as you normally would. You can see in the document's attributes which folders the document is stored in (storage location and link list).
Moving a Document

Use

When organizing your folders, documents can be moved between folders, several documents can be combined to create a single document, or one document can be appended to another. Under certain circumstances, documents need to be available in several folders at the same time. If a document is accessed only rarely, the document should be archived to save storage space.

If you want to move a document, keep the following points in mind:

- Documents from shared folders cannot be moved to the inbox, the outbox or a private folder.
- You can only move documents from the inbox if they have been viewed first. If the document is marked with the attribute **ToDo** or **Reply required**, it can only be moved after completion of processing or after a reply has been sent.
- If a document from a private folder is moved to a shared folder, the transmission information, including the original author and recipients, is lost.

Features

When you move a document, the document is transferred from one folder to another. The document no longer exists in the original folder.

You can also move a link to the document, so that the same document is available in more than one folder. Any changes that are made to the document can then be seen in all the folders.

You can move the copy of a document so that an identical document is created in the target folder. The original document and the copy can be edited separately. When the Copy function is used, the attributes are copied, and any existing transmission information is lost. You can also append the copy to another document as an attachment.

You can move the document to the resubmission folder. In this case, the document is placed in your inbox again on a date (or dates) specified by you.

You can move the document to your PC.

More storage space can be made available in the database if you move documents to an archive. Users can access archived documents in their folder as normal.

Activities

Proceed as described in Moving a Document [Page 55]. Further information on the use of the resubmit function can be found in the section on Resubmissions [Page 95]. Archiving [Page 239] can only be executed centrally by an administrator.
## Moving a Document

In the context menu of a document, choose the required function:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move</td>
<td>Select a [target folder](Page 36).</td>
</tr>
<tr>
<td></td>
<td>You can also move the document to another folder in the folder tree using drag and drop.</td>
</tr>
<tr>
<td>Create link</td>
<td>Select a [target folder](Page 36).</td>
</tr>
<tr>
<td>Export</td>
<td>1. In the dialog box, navigate to the PC file that you want to move the document to.</td>
</tr>
<tr>
<td></td>
<td>2. Enter a name for the document.</td>
</tr>
<tr>
<td></td>
<td>3. Choose Save.</td>
</tr>
<tr>
<td>Copy</td>
<td>1. If necessary, change the name and title of the copy.</td>
</tr>
<tr>
<td></td>
<td>2. If you also want to change the document attributes of the copy, choose 📝, make the changes in the subsequent dialog box and then choose 📝.</td>
</tr>
<tr>
<td></td>
<td>3. Choose Target folder.</td>
</tr>
<tr>
<td></td>
<td>4. In the subsequent dialog box, select a [target folder](Page 36).</td>
</tr>
<tr>
<td></td>
<td>5. Choose 📝.</td>
</tr>
<tr>
<td></td>
<td>You can also copy the document using drag and drop if the STRG key is depressed.</td>
</tr>
<tr>
<td>Create a copy as attachment to an existing document</td>
<td>Perform steps 1 and 2 as described under the Copy function and then proceed as follows:</td>
</tr>
<tr>
<td></td>
<td>3. Choose the Target document.</td>
</tr>
<tr>
<td></td>
<td>4. In the subsequent dialog box, select a [target folder](Page 36).</td>
</tr>
<tr>
<td></td>
<td>A list is displayed of all the documents that are stored in the folder selected.</td>
</tr>
<tr>
<td></td>
<td>5. Select the required document by double-clicking on it.</td>
</tr>
<tr>
<td></td>
<td>6. Choose 📝.</td>
</tr>
</tbody>
</table>
Changing a Document

Use
You can change the document content, the attributes and the attachments of an existing document.

Prerequisite
The document has to have the attribute *changeable* or, if you are the author, *changeable by author*. In the private folder area, this attribute only applies after the document has been sent. You can define a default setting for this attribute in your private office settings [Page 106]. You can only change a document that is not changeable by making a copy of the document and making the changes to the copy.

In order to change a document that is located in a shared folder, you require the corresponding folder access authorization [Page 24].

Activities
Proceed as described in Displaying and Changing a Document [Page 57].
Displaying and Changing a Document

Procedure

1. In order to display a document, select it in the folder content list by double-clicking on it.
   
   On the tab pages Document content, Attributes, Recipient list and Attachments, you can display the corresponding components of the document and possibly change them.

2. In order to change the document, choose \( \text{edit} \).
   
   Various processing options [Page 58] are available.

3. Choose \( \text{save} \).
   
   Always copy the proposed name and the proposed directory if you are saving a PC document using the Store function of the PC application. For further information on displaying and changing PC documents, see Calling a PC Document [Page 61].

Result

The document is displayed and changed, if necessary. If you have changed a document that has been sent, the changes made can be seen by all internal recipients. After saving the changes, a dialog box asks you whether the document received by all the recipients should be assigned the status 'unread'. Choose Yes if you explicitly want to make all the recipients aware of the changes.
Editing a Document

Prerequisites
You must have selected a document to change.

Procedure
The following editing options are available in the document maintenance screen:

<table>
<thead>
<tr>
<th>Function</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create attachment</td>
<td>Proceed as described in Creating an Attachment [Page 64].</td>
</tr>
<tr>
<td>Move, copy or create a link to the document</td>
<td>Proceed as described in Moving a Document [Page 55].</td>
</tr>
<tr>
<td>Insert URL, Mailto, document link, object link, telephone number.</td>
<td>Proceed as described in Inserting Links in a Text [Page 59].</td>
</tr>
<tr>
<td>Including spool requests in a document</td>
<td>Proceed as described in Creating an Attachment [Page 64].</td>
</tr>
<tr>
<td>Executing a Document</td>
<td>Choose Execute in the context menu of an executable document [Page 42] or double-click on in the column Executable.</td>
</tr>
<tr>
<td>Printing a document</td>
<td>Proceed as described in Printing a Document [Page 67].</td>
</tr>
<tr>
<td>Accept document for processing or set to 'Done'</td>
<td>You set this document status [Page 68] if you receive a document with the attribute ToDo. To do this, choose Goto → Accept or Set to Done.</td>
</tr>
</tbody>
</table>

In the inbox, you can also flag unread documents that you do not want to read as Read. To do this, select the document in the folder content list of the inbox and choose Set to Read in the context menu.
Inserting Links in a Text

Use
You can insert links in messages. A connection (a 'link') can be created to the following objects:

- A Web page
- A mail address so that a send process can be started via the link
- Another document
- A Business object [Page 43]
- A telephone number so that a telephone call can be started via the link

Prerequisites
You must have selected a document to change.

Procedure
1. On the tab page Document content, position the cursor on the place in the text where the link should be inserted.
2. The rest of the procedure depends on the link type required:

<table>
<thead>
<tr>
<th>Link Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Web page  | a) Choose Insert → Web site.  
b) In the subsequent dialog box, specify the name of the Web page and, if necessary, the name with which the link in the text is to be displayed.  
  You can also copy the URL in your Web browser and insert it using in the dialog box. | |
b) Select a folder in the Folder selection [Page 36] dialog box.  
  A list is displayed of all the documents that are stored in the folder selected.  
c) Select the required document by double-clicking on it.  
  You and the internal recipients of the document can display the selected document from the link. | |
| Business object | a) Choose Insert → Object link.  
b) In the subsequent dialog box, select an object type by double-clicking.  
c) Specify which object you want to create as an attachment. Which options you have and how you are to proceed further depends on the object type selected.  
  You and the internal recipients of the document can display the selected business object from the link. | |
## Inserting Links in a Text

### Mailto

a) Choose **Insert → Mailto**.

b) In the subsequent dialog box, specify the recipient in the format `mailto: `<Recipient>` and, if necessary, the name with which the link in the text is to be displayed.

   You can also copy the recipient in a different place and insert it using ![Copy](image) in the dialog box.

   You and the internal recipients of the document can execute the `mailto`, in order to branch to the send screen. A message can be created there and sent to the recipient specified in the field `mailto`.

### Telephone number

a) Choose **Insert → Object link**.

b) In the subsequent dialog box, specify the telephone number and the country of the caller and, if necessary, the name with which the link in the text is to be displayed.

   You and the internal recipients can branch to the dialog box for initiating a telephone call [Ext.] from the link. To be able to actually initiate a telephone call, the telephone must be connected to the R/3 System.

### Result

A link is created in the text and can be used in the display mode of the document.

External recipients cannot use links to documents and Business objects stored in the R/3 System.

You have created a link to the URL **http://www.stuttgart.de** and specified the name **Stuttgart's Homepage**. The link is displayed in change mode with `<A HREF="http://www.stuttgart.de">Stuttgart's Homepage</A>`. The link **Stuttgart's Homepage** is displayed in display mode.

You have created a mailto to the external address **Anna Romanow** and specified the name **Message for Mrs. Romanow**. The link is displayed in change mode, for example, with `<A HREF="mailto:C11CLNT000ADDRESS &AD 0000014687INT 001 *<OBJECT>*">Message for Mrs. Romanow</A>`. The executable link **Message for Mrs. Romanow** is displayed in display mode.
Calling a PC Document

Purpose

Any PC documents created in the Business Workplace can be sent or published in shared folders. Whenever you create or change PC documents, you should note special features. We will use the process of calling a PC document in the Business Workplace to illustrate these.

Prerequisite

You can create and display any PC document provided that the corresponding software is installed on your computer.

The PC document classes are managed in an administration table [Page 236]. This table defines, for example, which documents can be created via the Business Workplace interface.

In private office settings [Page 106] users can define which document classes are displayed to them directly under a user-defined name (for example, MS Word document for DOC) for creation in the Business Workplace. The administration can define a default for this setting in shared office settings [Page 214] so that the document classes used most often are displayed directly to all users.

Process Flow

1. If the user calls the function for creating a PC document or calls an existing PC document in the Business Workplace, a temporary file is automatically created in the current directory of the R/3 System.

   When existing PC documents are called, the file contains the contents of the PC document.

   The content of the file for a PC document that is to be created depends on the number of default documents that the administration has created for the PC document class:

<table>
<thead>
<tr>
<th>Number of existing default documents</th>
<th>Description of file</th>
</tr>
</thead>
<tbody>
<tr>
<td>zero</td>
<td>The file is empty.</td>
</tr>
<tr>
<td>one</td>
<td>The file contains the default document.</td>
</tr>
<tr>
<td>several</td>
<td>The file contains the default document selected by the user. In this case, the user has to firstly select the required default document from the list of existing default documents.</td>
</tr>
</tbody>
</table>

The system creates a name for the file in the format:

~~<Name of the PC document>_<current date><current time>.<EXT>~~

<EXT> is a three-character file extension of the PC application, for example, DOC for Word documents.

An MS Word document with the title Company Excursion is called in the Business Workplace on 6 May 2000 at 14:22 hrs (and 33 seconds). The system then creates a
Calling a PC Document

temporary file with the title `Company Excursion_20000605142233.DOC` in your current directory.

3. Depending on the private office settings [Page 106] of the user, the PC application is then opened either in the R/3 window or in a separate window.

4. The user edits the document and chooses the function Save in the PC application. The document is then temporarily saved in the current directory under the name `~<Name of the PC document>_<current date>_current time>.

Always save the file under the name that is automatically generated and in the proposed directory. Otherwise the PC document is stored on your PC and not in the R/3 System.

Note that you can make changes in the PC application to documents that are not changeable. However, you cannot save these changes in the document that is open. You have to specify a different name. As a result, a new document is created which is not stored in the R/3 System but on your PC.

5. If the Save function of the R/3 System is called or the PC document is closed, the PC document is saved in the R/3 database. If you still have not specified a title, the title that is automatically generated is used.

6. The files, temporarily stored in the current directory, of all the PC documents that you have called from the R/3 System during one session are automatically deleted the next time you log on to the R/3 System.
Deleting and Retrieving Documents

Use

All documents that you have deleted from your inbox, outbox, resubmission folder or a private folder are moved to your trash folder. You can retrieve a deleted document from the trash on the same day as the deletion.

Documents from shared folders are moved to the trash folder of the relevant user. Therefore, only the owner can retrieve these documents.

Procedure

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
</table>
| Deleting a Document                    | 1. Select the document to be deleted in the folder content list. If you want to delete several documents simultaneously, select them all.  
   2. Choose 🗑️. If the confirmation prompt is activated in your private office settings, the system will display a dialog box in which you must confirm the deletion process. You can also put the folder in the trash folder using drag and drop. |
| Retrieving a Document from the Trash Folder | 1. Select the folder Trash or Shared trash in the folder tree.  
   2. Select the document.  
   3. There are several ways of retrieving the document from the trash:  
      - The document can be returned to the folder from which it was deleted.  
        Select Retrieve.  
        Documents which have been deleted from the resubmissions folder can only be moved.  
        The document can be moved or copied into any folder in your private folders or your outbox. A link can be created to it or it can be exported to the PC.  
        Choose Move, Create link, Copy, Export.  
   4. Change the expiry date, if necessary, and confirm your entries. The document is now retrieved or moved. |
Attachments to a Document

Use
To store or send documents with similar contents, one document can be appended to the other as an attachment.

The PR department of a company sends a press release to the Executive Board to be checked. The relevant pictures are appended to the document as an attachment. As the press release is also to appear on the company homepage on the Internet, a link to the web server that hosts the web site is also to be included.

Features
Any documents or links can be attachments. You cannot define attachments for attachments.

Using the function Create attachment, you can append any existing documents or spool requests stored by you to a selected document as attachments. You can also create documents stored in the Business Workplace and business objects existing in the R/3 System or on web pages as attachments.

Alternatively, you can append the selected document to another document as an attachment using the functions Copy, Move or Create link in connection with the function Document Selection.

Activities
Proceed as described in Appending an Attachment to a Document [Page 65].
Appending an Attachment to a Document

Procedure

1. In the folder content list, select the document that you want to append the attachment to.

   You can also execute this function in the document maintenance. Under the menu path Document → Create attachment, choose the required function and then continue with step b).

2. The rest of the procedure depends on the attachment type:

<table>
<thead>
<tr>
<th>Attachment type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Link to a document existing on the PC                | a) Choose ![image](image1.png)

   b) In the subsequent dialog box, navigate to the required PC folder and select the document by double-clicking on it.

| Link to Web page                                     | a) In the list field for ![image](image2.png), choose Link to Web page.

   b) In the subsequent dialog box, specify the name of the web page and, if necessary, a name for the attachment.

   You can also copy the URL in your web browser and insert it using ![image](image3.png) in the dialog box.

| Link to business object                              | a) In the list field for ![image](image4.png), choose Link to business object.

   b) In the subsequent dialog box, select an object type by double-clicking.

   c) Specify which object you want to create as an attachment. Which options you have and how you are to proceed further depends on the object type selected.

| Link to a document stored in the Business Workplace   | a) In the list field for ![image](image5.png), choose Link to document.

   b) Select a folder in the Folder selection [Page 36] dialog box.

   A list is displayed of all the documents that are stored in the folder selected.

   c) Select the required document by double-clicking on it.

| Stored spool requests                                 | a) In the list field for ![image](image6.png), choose Import from spool.

   A list of all the spool requests stored by you is displayed.

   b) Select the required spool request by double-clicking on it.

   The spool request is copied with the existing print control characters.
Appending an Attachment to a Document

Result

The attachment is appended to the document and displayed in the attachment list. When you send this document the attachments are sent with it. Note that the attached links (with the exception of the link to a Web site on the Internet) can only be used by internal recipients.
Printing Documents and Folder Content Lists

Use
You can print the content of a document. You can also print the document header and, if necessary, a note and the recipient list. In the folder content list, you can print the list of all the objects contained in a folder.

Procedure
Printing a folder content list
In the folder content list, choose Print in the list field of 

Printing a document
1. Call a document in the folder content list by double-clicking on it.
2. Choose .

Result
The document or the folder content list is printed in accordance with your private office settings [Page 106].

If you have not specified in your private office settings that you want to be able to change the print parameters before printing, the document is directly printed on the printer specified in your user profile.

If your user profile does not specify a printer, a screen is displayed first in which you must specify a printer. Then choose .
Document Status

Definition
Status of a document in your inbox or in shared folders.

The following statuses can be used in shared folders:
- Viewed
- Unviewed

The following, additional statuses can also be used in your inbox:
  - ToDo
  - In process
  - Done

Use
The statuses Read and Unread simplify the overview of documents in the inbox and shared folders for users. They can therefore recognize immediately which documents they have not yet read. In addition, these statuses can be implemented as sort criteria, so that the unread documents appear before the read documents in the list display.

When you receive a document with the status ToDo, you can reserve the document. The status In process is then assigned to the document. When you have processed the document, the status should be set to Done.

Columns that display the status of a document are available in the folder content list. The column Read/Unread is set by default. You can add other columns to the list yourself.
Working with Object Folders

Use

The use of the functions for processing object folders is fundamentally the same as that of the functions for processing folders or documents. As with other folders, the content of the object folders can only be accessed in the folder content list. Attributes and, if necessary, recipient lists can also be called.

Activities

You create new object folders in the folder structure. To do this, proceed as described in Creating a Folder.

You create objects in the Business Workplace as well as process the object folders and objects contained in a folder in the folder content list. Note that you can only send in the content list of the object folder that is above the highest object folder (that is not, therefore, an object folder). When you send an object folder, all subordinated objects and object folders are sent with it. Object folders in the folder structure are also displayed in a hierarchy in the recipient's inbox. To send an object folder, proceed as described in Sending a Document.
Creating an Object

Use

You can create an object existing in the R/3 System, or possibly a new object, in the Business Workplace by using this procedure. Only the part of the procedure that is the same for all objects is described here. How the object is then selected or created depends on the object type and is described in the relevant application. You can execute this function in 'normal' folders [Page 29] and in object folders [Page 40].

Procedure

1. In a folder content list, choose Create more in the list field of .
   The document maintenance screen appears on the tab page Attributes.
2. In the field Document class, enter OBJ and, if necessary, change the attributes [Page 44].
   A dialog box with the available object types appears.
3. Select an object type by double-clicking.
4. Specify which object you want to create in the Business Workplace. Which options you have and how you are to proceed further depends on the object type selected.

   Example: The creation of the object Telephone call
   a. In the folder content list, choose Create more in the list field of .
      The document maintenance screen appears on the tab page Attributes.
   b. You can specify a title.
   c. In the field Document class, enter OBJ
      A dialog box with the available object types appears.
   d. Select the object SAPphone: Telephone call by double-clicking on it.
   e. Enter the telephone number, without the country code, and the country of the caller.
   f. Choose .
   g. If you have specified your own title, in the subsequent dialog box select whether you want to use this title or the telephone number entered beforehand as the title and choose . If you have not specified your own title, the telephone number is used as the title without query.
   h. The telephone call is created in the Business Workplace. You can, for example, send or execute it yourself by selecting the object in the folder content list by double-clicking on it.

Result

The object is created in the folder that is specified in the attributes. The current folder is set as the default.
Working with Distribution Lists

Use

If information is to be sent to a defined group of users on a regular basis, a distribution list should be configured. All users who are to receive the information are included in the distribution list. When sending documents or creating a shared folder, only the name of the distribution list must be entered to carry out the following actions:

- Send a document to all users entered in the distribution list
- Make a shared folder accessible to all internal users entered in the distribution list
- You can also use a distribution list with internal users in other applications of the R/3 System where you have to specify several users, for example, when creating group appointments in the calendar.

Internal and external addresses can be grouped together in distribution lists. As a result, you can, for example, create a distribution list if a circular is to regularly be sent to a certain group of people. The distribution list also allows you to create a distribution list in which interested people can enter their names, for example, for a newsletter.

Distribution lists are suitable, for example, for grouping together smaller units of a company, such as project groups or all the group managers of a department. As distribution lists can contain other distribution lists, a flexible representation of the corporate structure is possible.

You can also specify organizational units [Ext.] for sending documents or assigning authorizations. Organizational units are, however, closely linked to corporate structure and, therefore, no organizational unit exists for projects that involve more than one department, for example.

Features

Distribution lists can be entered as recipients when sending documents and can be assigned access authorizations for shared folders.

The following functions are available for distribution lists:

- Functions which can also be executed on other documents:
  - Create, display, change, copy, print, export to PC, delete
- Functions which can only be used for distribution lists:
  - Expand entries (completely or partially)
  - Combine entries to create a new distribution list
  - Combine entries to create a new distribution list and replace the old distribution list with the new list
  - Create a subscription list
In contrast to documents, distribution lists cannot be sent and links cannot be created to a distribution list.

**Activities**

Private distribution lists are created by users in their private folders or outbox. Shared distribution lists are created in shared folders by users with the relevant authorization.

Each user can create their own distribution lists in their private folders. However, this distribution list can only be used by the user himself and it cannot be sent. Therefore, it is advisable to create distribution lists that are of interest to several users in shared folders. This could, for example, be all the members of a project or group.
Distribution List

Definition
List that groups together several addresses. A distribution list can be used, for example, to send documents to the addresses or to make documents accessible to the internal addresses via a shared folder.

Structure
A distribution list consists of:

- Contents
  The content consists of address entries with the corresponding address types.

- Attributes
  The attributes are name, title and storage location. Private distribution lists also have a sensitivity. Shared distribution lists have the indicator for subscription lists.
Shared Distribution List

Definition

Document of the class DLI that consists of a list of addresses. A shared distribution list is stored in shared folders and can be accessed by all users who have at least display authorization for the folder in which the distribution list is situated.

Subscription lists [Page 76] are a special type of shared distribution list.
Subscription Lists

Definition

A shared distribution list [Page 75] in which users who are interested in the topic can enter or delete their names. To be able to do this, they must have at least display authorization for the folder in which the subscription list is located.
Private Distribution List

Definition

Document of the class DLI that contains a list of addresses. A private distribution list is stored in a private folder and cannot therefore be accessed by other users.
Creating a Distribution List

Use
If you wish to send the same information to more than one recipient and are likely to repeat this process in the future, you should create a distribution list. If you create a distribution list, you do not have to enter recipients individually each time.

Prerequisite
To create shared distribution lists, you must have change authorization for the shared folder in which the distribution list is to be created.

Activities
The Business Workplace offers various options when creating distribution lists:

- New distribution lists can be created using the function Create distribution list.
- The entries of an existing recipient list (for example, on the send screen or in the display of an existing distribution list) can be grouped together in a new distribution list.
- Copy an existing distribution list and change the copy.

You can assign each entry the send attributes [Page 99] Express, Copy or Blind copy. With external addresses, you can also select a different communication method to the standard communication method as the recipient address.

You create a distribution list for a newsletter that published regularly. Since the newsletter contains a link to Web sites, change the communication method for those external recipients to whom Fax, for example, rather than Internet is assigned as the standard communication method.
Creating Distribution Lists

Procedure

Creating a Distribution List in the Distribution List Search

1. In the Business Workplace, choose Distribution lists.
2. The distribution list search screen is displayed.
   In the frame Find distribution lists, select whether you want to create a private or a shared distribution list.
3. Choose .
   The distribution list maintenance screen appears on the tab page Attributes.
4. Specify the attributes of the distribution list.
5. Switch to the tab page Distribution list content.
6. Specify the recipient addresses and for each one the corresponding recipient type [Page 97].
7. In addition, you can assign the send attributes Express, Copy and Blind copy to each recipient. When sending to an external address, you can also specify that documents are to be sent to another address from the address management rather than to the standard address.
8. Choose .

Result

The distribution list is created and can be used on the send screen, for example, or in other places in the R/3 System where a specific user group has to be specified.
Searching for Distribution Lists

Use

It is often difficult to obtain an overview of a large folder and therefore to know straight away where a distribution list is situated. The Business Workplace provides a search interface for distribution lists:

You can use the following values as search criteria:

- Name (the name of a distribution list is unique)
- Title
- Folder area (private or shared)
- Individual recipients.

You also create new distribution lists [Page 79] on the distribution list search screen.

Procedure

1. In the Business Workplace, choose Distribution lists.
   You branch to the screen Distribution lists. In the lower part of the screen, you can display your private distribution lists by expanding the node Private distribution lists.

2. In the frame Find distribution list, select whether you want to search for a private or a shared distribution list and enter the search criteria.

3. Choose Start search.

Result

The distribution lists that correspond to your search criteria are displayed in the lower part of the screen. The distribution lists found are highlighted in color. You can see from the symbol displayed for each distribution list whether it is a subscription list:

- Private or shared distribution list
- Subscription list.

The recipients are also flagged with symbols that indicate the recipient type:

- User
- External addresses
- Organizational units

The following functions are available in the list of results:
### Searching for Distribution Lists

<table>
<thead>
<tr>
<th>Function</th>
</tr>
</thead>
</table>
| **Display the number of recipients contained in a distribution list** | In the context menu of the distribution list, choose *Number of recipients*.  
All recipients of the distribution list and all recipients of distribution lists contained within it are counted. Recipients that appear several times are only counted once. |
| **Display the recipients contained in a recipient list** | Expand the node of the distribution list.  
All the recipients contained within it are listed. Distribution lists contained within the list can be expanded further. |
| **Enter your name in or remove your name from a subscription list** | In the context menu of the subscription list, choose *Enter name or Remove name*. |
| **Display address data for a recipient** | Select the recipient by double-clicking. |
| **Display distribution list** | Select the distribution list by double-clicking on it. |
| **Change distribution list** | Select the distribution list and choose ✏. |
| **Copy distribution list** | 1. In the context menu of the distribution list, choose *Copy*.  
2. Enter a new name and, if necessary, a new title.  
3. If necessary, select a different target folder [Page 36].  
The copy of the distribution list is moved to the specified folder and inserted in the hit list. |
| **Move distribution list to a different folder** | 1. In the context menu of the distribution list, choose *Move*.  
2. Select a target folder [Page 36].  
3. Choose ✔️. |
| **Print distribution list** | In the context menu of the distribution list, choose *Print*.  
The distribution list is printed on the printer that is preset in your user profile. |
| **Delete distribution list** | In the context menu of the distribution list, choose *Delete*.  
The distribution list is moved to your trash folder temporarily. You have the option of undoing the deletion. |
| **Delete entry from all distribution lists** | You can only execute this function for shared folders if you have authorization for all the folders in which the distribution list is located.  
1. In the field *Entry in DL*, specify the address that is to be deleted.  
2. Choose *Edit ➔ Delete DL entry*.  
3. Choose ✔️. |
Searching for Distribution Lists

The hit list is canceled if you exit the distribution list maintenance or if you start a new search.
## Editing a Distribution List

1. In the folder contents list, select the distribution list by double-clicking on it.

2. Choose 📝.

3. Add new entries.

   You can add information yourself for external addresses that are not stored in the address management.

   i. To do this, choose Extras → Fax entry, Internet entry, X.400 entry or Remote SAP entry.

   ii. In the subsequent dialog box, enter the address and, if necessary, further information, which is entered on the fax cover sheet when a fax is sent, for example.

   iii. Choose ✅.

   The following functions are also available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu Path</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand distribution list</td>
<td>Extras → Expand DL → Expand entry completely or Expand entry or Expand DL completely</td>
<td>Distribution lists that have been included in other distribution lists can be expanded to display all the entries.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Expand entry completely: The selected distribution list is expanded to display all entries.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Expand entries: The selected distribution list is expanded to display the first level of entries.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Expand DL completely: A flat list of users is displayed.</td>
</tr>
<tr>
<td>Combine distribution list</td>
<td>Extras → Combine</td>
<td>The selected entries are combined to create a new distribution list.</td>
</tr>
<tr>
<td>Combine and replace distribution list</td>
<td>Select Extras → Combine and replace</td>
<td>The selected entries are combined to create a new distribution list and displayed in the old distribution list as a single entry.</td>
</tr>
<tr>
<td>Enter your name in (or delete your name from) a subscription list</td>
<td>Extras → Subscribe or Cancel subscription</td>
<td>This function is not available for administrators. If you are an administrator, select Change and enter your name.</td>
</tr>
<tr>
<td>Move distribution list</td>
<td>Distribution list → Move</td>
<td>For further information, see [Moving a Document](Page 54).</td>
</tr>
<tr>
<td>Copy distribution list</td>
<td>Distribution list → Copy</td>
<td>For further information on copying, see [Moving a Document](Page 54).</td>
</tr>
</tbody>
</table>
Editing a Distribution List

<table>
<thead>
<tr>
<th>Print distribution list</th>
<th>Distribution list → Print</th>
<th>For further information on printing, see Printing a Document [Page 67].</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete distribution list</td>
<td>Distribution list → Delete</td>
<td>For further information, see Deleting and Retrieving Documents [Page 63].</td>
</tr>
</tbody>
</table>

4. Choose 🖨️.
Sending

Use

The Send function is used to distribute documents internally and externally. When you send documents internally, the documents are sent to SAP users in the same system. When you send documents externally, they are sent to non-SAP users or SAP users in another system. The Business Workplace enables you to:

- Send documents and object folders from your inbox, outbox and private folders
- Send copies of documents from shared folders
- Forward documents from your inbox
- Send documents stored on your PC
- Create and send documents directly.

In addition, you can send short messages [Page 91] from every SAP application. You can send any Business objects [Page 43] in SAP applications that support object services [Ext.].

You can send a document to one or more recipients. You can either enter the recipients individually or in groups using distribution lists [Page 74] or organizational units [Ext.]. The format in which you enter a recipient address (the recipient type [Page 97]) corresponds to the way you want to send the document (the communication method). The following communication methods are supported:

- Sending within an SAP System
- Sending via the Internet
- Fax
- Paging (SMS mail).
- Sending via X.400
- Sending between several SAP Systems of an SAP System network (Remote Mail)

You can copy recipient addresses from the SAP address management. In this case, recipients are each entered as an External address, irrespective of the communication method by which the document is to be sent. The document is then automatically sent by the communication method that is selected as the standard communication method for the respective address. Information, such as name and address, is entered automatically on the fax form when documents are sent by fax, for example.

This is not the case, however, when you send documents to addresses that are not stored in the SAP address management. In this case, you have to enter all the recipient-related information yourself.

Integration

When you send a document from your private folder area internally, the storage location of the document in the database does not change. Therefore, the recipient does not receive a copy of
Sending

the document that is stored in your inbox or in one of your private folders, but rather a link to the same document.

Changeable documents therefore remain changeable after they have been sent. If the document is changed by a user, all the users who still have the document in their private folder area see the changed document after it has been saved. In addition, the person who made the changes can decide whether the document is to be set to Unread in the inbox of all the recipients. In this case, the document is also placed in the inbox again for those users who have moved the document from the inbox to a private folder.

In contrast, only copies can be sent from shared folders. In this case, the recipient receives a new execution of the same document.

When you send a document, a company address and an address for the corresponding communication method must be assigned to you. You can maintain your address in the private office settings [Page 106].

Activities

To send documents, objects and object folders, proceed as described in Sending Documents [Page 87]. You can reply [Page 93] to documents received, forward [Page 94] the documents to other users or resubmit [Page 95] them to yourself. Transmission information for documents sent is displayed in the recipient list [Page 100]. If an error occurs while a document is being sent, a message is displayed, from which you can access the send log.

Folders and distribution lists cannot be sent. External recipients cannot display or process Business objects or links to documents and objects stored in the SAP System. This does not apply to Internet recipients within a mail system group. These recipients can call objects that were sent as URL in the Web GUI.
Sending a Document

Procedure

1. Create a new document or select an existing document.
2. Choose.
   You go to the send screen.
3. Enter the recipients and specify the corresponding recipient type [Page 97] for each one.

   If you send to recipients that are not stored in the address management, you have to choose the direct recipient types (for example, fax or Internet address) corresponding to the relevant communication method. In this case, you have to add the recipient-related additional information yourself. Entry help is available for this. To do this, proceed as follows:
   i. In the context menu, choose Fax entry, Internet entry, Pager entry or X.400 entry.
   ii. Enter the communication address (for example, DE 0893333 or abc@company.de) and, if necessary, additional information, such as recipient name and address for fax addresses, which is then entered automatically in the fax form. You have to specify a pager service for fax numbers.

   If an LDAP service is connected, you can search for addresses in it. You access the search screen for LDAP addresses [Page 110] by choosing the pushbutton LDAP service.

   iii. Choose.
4. You can assign the send attributes Express, Copy and Blind copy to each recipient.
5. Other recipient-related functions are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create resubmission for recipient</td>
<td>1. Select the recipients and choose under the recipient entry fields.</td>
</tr>
<tr>
<td></td>
<td>2. Proceed as described in Creating a Resubmission [Page 96].</td>
</tr>
</tbody>
</table>
| Creating distribution lists        | 1. Select the recipients that are to be grouped together in a distribution list and choose.
|                                    | 2. In the subsequent dialog box, enter a name, a title and specify a private folder as the storage location.
|                                    | 3. Choose. The distribution list is created in the specified folder. Send attributes specified for individual recipients are copied into the distribution list. |
| Expand distribution list           | Select the distribution list and choose.                                    |
|                                    | The distribution list is expanded into individual recipients. Recipients who are on the distribution list and were previously specified as individual recipients are only displayed once. |
Sending a Document

6. If necessary, switch to the tab page Send options in order to
   - specify additional send attributes (Send in the background, No forwarding)
     When you are sending documents to a large number of recipients, it is advisable to send in the background.
   - change the setting that indicates whether the message is to be moved to your outbox after it has been sent
   - specify, for internal sending, that the message is to be sent at a later date
   - change, for external sending, the setting indicating the type of send status for which you want a status confirmation.

7. Other functions are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create note</td>
<td>Choose Note. When you send a document from shared folders, the note is displayed directly. Enter a text. The standard text editing functions are available.</td>
</tr>
<tr>
<td>Create resubmission for yourself</td>
<td>Choose under the recipient entry fields. Proceed as described in Creating a Resubmission [Page 96].</td>
</tr>
<tr>
<td>Display document contents</td>
<td>Choose . To return to the Send dialog box, choose .</td>
</tr>
<tr>
<td>Display previous recipient list</td>
<td>Choose Recipient list: To return to the Send dialog box, choose .</td>
</tr>
<tr>
<td>Display attachment list</td>
<td>If attachments are appended to the document, choose next to the document title. To return to the Send dialog box, choose .</td>
</tr>
<tr>
<td>Append an existing PC document as an attachment</td>
<td>You can only execute this function here if the document to be sent is changeable or has not yet been sent. Choose . In the subsequent dialog box, navigate to the required PC folder and select the required document by double-clicking on it.</td>
</tr>
</tbody>
</table>

8. Choose .

Result

The document is sent to all the specified recipients and a link to the document is stored in your outbox or in a different private folder, depending on your send options. You can specify a default setting for your send options in your private office settings [Page 106]. Internal recipients receive a link to the document so that they can see any possible changes to the document. External recipients who receive the document as a fax or an Internet message, for example, receive a copy of the document so that subsequent changes cannot be seen by them.
Sending a Mail with a Callback Function

Use
You can send calls with a note or as an attachment to a document. The recipient can then call you back by calling the document or the attachment. The callback function can only be used by SAP users whose telephony settings are maintained.

An employee cannot be reached by telephone at the moment. You can send a mail to the employee asking them to call you back and append an executable call to your telephone number to the mail and send it. When the recipient calls up the attachment, the *Initiate call* dialog box containing the specified number is displayed.

Procedure

1. Choose System → *Send short message*. Wait until the system has opened a new session.
2. Specify the title of the document and enter a text.
4. Select *Document* → *Create attachment* → *Link to business object*
   A list of the available objects is displayed.
5. Select the entry *SAPphone: Telephone call* by double-clicking on it.
6. A dialog box is displayed in which you can enter your telephone number and the country code.
   The tab page *Attachments* is added to the tab pages *Document content* and *Attributes*.

5. Specify the recipient with the corresponding recipient type [Page 97].
6. Choose 📥.

Result
The message is placed in the Business Workplace inbox of the recipients. They can call the message there. If they call up the attachment and confirm the dialog box, the callback is initiated.
**Sending a Short Message**

**Use**

This procedure is used to create and send a short message quickly. It can be called anywhere in the R/3 System from the system menu. You do not have to end your current work in the system beforehand because a new window that is independent of the current window is displayed when the function is called. The window is closed again after the message is sent and you can continue to work in the original window.

It is advisable to specify an expiry date for short messages that have an information value that is limited in time. By doing so, you save yourself and the recipient clear-up work and reduce the system load.

**Procedure**

1. Choose *System → Short message or New Message*.
   
   Wait until the system has opened a new session.

2. Specify the title of the document and enter a text. The standard functions are available. In addition, you can insert links [Page 59] in the text.

3. If necessary, switch to the tab page *Attributes* in order to
   - assign the short message an expiry date
   - change the attributes Changeability, Priority, or Language assigned to the short message.
   - specify a folder other than the default folder as the storage location for the short message. The outbox is set as the default folder.

4. If you want to append a PC file as an attachment to the message, choose 📖 and select a file from the folder structure of your PC.

   The tab page *Attachments* is added to Document content and Attributes. All attachments to the message are listed on this tab page and can be processed.

5. Specify the recipients and the corresponding recipient type [Page 97].

   If you send to recipients that are not stored in the address management, you have to choose the direct recipient types (for example, fax or Internet address) corresponding to the relevant communication method. In this case, you have to add the recipient-related additional information yourself. Entry help is available for this. To do this, proceed as follows:

   iv. Choose Goto → *Fax entry, Internet entry, Pager entry, Remote SAP entry or X.400 entry*.

   v. Enter the communication address (for example, DE 0893333 or abc@company.de) and, if necessary, additional information, such as recipient name and address for fax addresses, which is then entered automatically in the fax form. You have to specify a pager service for fax numbers.

   If an LDAP service is connected, you can search for addresses in it. You access the search screen for LDAP addresses [Page 110] by choosing the pushbutton LDAP service.
Sending a Short Message

vi. Choose ✉.

8. You can assign the send attributes Express, Copy and Blind copy to each recipient.

9. If necessary, switch to the tab page Send options in order to
   
   – specify additional send attributes (Send in the background, No forwarding)
   
   – change the setting that indicates whether the message is to be moved to your outbox after it has been sent
   
   – specify that the message is to be sent at a later date
     
     This function can only be used for external sending if it is supported by the external communication system.
   
   – change, for external sending, the setting indicating the type of send status for which you want a status confirmation.

8. Choose ✉.

Result

The short message is sent. Afterwards, the session is closed again automatically. If you want to know whether the recipient has received or read the short message, switch to your Business Workplace and in the outbox folder Documents, call the recipient list [Page 100] for the message.

To be able to see whether the recipient has received or read the message, the send option Place in outbox after sending has to have been selected. If the message was sent externally, you can only see whether the recipient has read the message if this function is supported by the external communication system.
Reply

Use
There are two advantages of replying to documents using the Reply function:

- The recipient address is automatically entered in the send screen and all other recipients of the original document can also be entered by the system.
- You can trace the correspondence history [Page 101].

Features
You can reply to a document with or without reference to the original. In both cases, you can send the reply to all the recipients of the document or display the correspondence history.

If you select Create with reference, the document to which you are replying is used as a reference for the new document (the document header and, if available, the contents are copied). This function should be used if, for example, you have been sent a form which you should process, or if you wish to include the previous correspondence in your document.

Activities
The following functions are available when viewing documents to which you wish to reply:

<table>
<thead>
<tr>
<th>Function</th>
<th>Pushbutton</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reply</td>
<td>Reply</td>
<td>The attributes of the selected document are copied. The sender is automatically entered as the recipient. You can change the entries in the header and one the send screen, or confirm the entries directly.</td>
</tr>
<tr>
<td>Reply with reference</td>
<td>Reply with reference</td>
<td>The attributes and content of the selected document are copied. The content of the correspondence can therefore be displayed. The sender is automatically entered as the recipient.</td>
</tr>
<tr>
<td>Send a reply to all recipients of the document</td>
<td>Reply to all</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>All recipients of the document are entered.</td>
</tr>
</tbody>
</table>

An automatic title with the format RE: <Title> is created for the reply. You can change the title, if necessary.

After you have written your reply, choose ✅. The sender, and, if necessary, the other recipients of the document, is entered as the recipient. You can add other recipients, define send options, create attachments and enter a note. To send the reply, choose ✅.
Forwarding a Document

Use

You can forward a document which has been sent to you to another user and include your own note. The only exception is a document to which the send attribute *No Forwarding* has been assigned. With the help of the transmission information, you can determine if a document has been forwarded, and, if so, by whom and on what date (time). You can find out who created the document and when.

Activities

If you want to forward a document, choose *Forward* in the context menu of the document. On the send screen, you have the opportunity to create a note for the document. If the document already has a note, the note is displayed. You can either use this note or modify the note. To subsequently send the document, proceed as described in *Send [Page 85]*.
Resubmitting a Document

Use

You can define resubmissions for documents, i.e. the document is automatically placed in your inbox on a certain date in accordance with criteria you define. You can therefore remind yourself of certain events or have documents which need to be completed by a certain date automatically placed in your inbox on this date. You can also define a resubmission for the recipient of a document. If the recipient has removed the document from his or her inbox, it is placed in the inbox again on the date specified.

If you define a resubmission for a document in your inbox, the document is moved from the inbox to the resubmissions folder. This helps you keep an overview of current documents in your inbox. If you create a resubmission for documents in the outbox or in a private folder, an additional link to the document is placed in the resubmissions folder. The document also remains in the outbox or in the private folder.

Folders and distribution lists cannot be resubmitted.

Activities

Proceed as described in Creating a Resubmission [Page 96].
Creating a Resubmission

Use

You can create a resubmission for yourself in the folder contents list, in the document display or the document maintenance or in the Send dialog box. You can only define a resubmission for the recipient of a document in the Send dialog box.

Procedure

1. In the Resubmission dialog box, specify:
   - when the document is to be placed in the inbox for the first time
   - whether and in which time interval (number of days, weeks, months or years) the resubmission is to be periodically repeated
   - when the document is to be placed in the inbox for the last time
   - the conditions under which the resubmission is not to take place (if the document has already been read, replied to, processed or if it is currently being processed)
   - whether and the number of days the document is to be placed in the inbox before the specified last date.

2. Choose ✓.

Result

The document to be resubmitted is placed in the inbox of the user himself or of the recipient on the days specified, provided that none of the conditions specified above are apparent. If a resubmission date falls on a public holiday, the resubmission takes place on the last working day before this date for those users who have the selected Resubmission only on working days in their private office settings [Page 106]. The document is deleted from the resubmissions folder on the date of the last resubmission.
Address Type

Definition

Type of recipient address or sender address. An address type can be one unit (for example, address name) or several units (for example, shared distribution list). Some address types determine the communication method by which the document is sent (for example, an Internet address or a fax number).

Use

When an address is specified, for example on the send screen, the corresponding address type must be assigned. The address type can be entered automatically [Page 98]. The following recipient types are available in the Business Workplace:

<table>
<thead>
<tr>
<th>Recipient Type</th>
<th>Example</th>
<th>Indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address name</td>
<td>Anna Wilson</td>
<td></td>
</tr>
<tr>
<td>SAP user name</td>
<td>Wilsona</td>
<td>B</td>
</tr>
<tr>
<td>External address</td>
<td>Edward Miller</td>
<td>A</td>
</tr>
<tr>
<td>Private distribution list</td>
<td>Favorite colleagues</td>
<td>P</td>
</tr>
<tr>
<td>Shared distribution list</td>
<td>Archiving project</td>
<td>C</td>
</tr>
<tr>
<td>Fax number</td>
<td>USA 123 456 7890 (&lt;country code - fax number&gt;)</td>
<td>F</td>
</tr>
<tr>
<td>Internet address</td>
<td><a href="mailto:anna.wilson@our.company.com">anna.wilson@our.company.com</a></td>
<td>U</td>
</tr>
<tr>
<td>Organizational object</td>
<td>Purchasing (Organizational unit)</td>
<td>H</td>
</tr>
<tr>
<td>Business object</td>
<td>Office folder</td>
<td>J</td>
</tr>
<tr>
<td>Remote SAP name:</td>
<td>C11:000:wilson (&lt;System name:Client:Name&gt;)</td>
<td>R</td>
</tr>
<tr>
<td>X.400 address</td>
<td>g=anna;s=wilson;o=c11;ou1=m000;p=company;a=dbp;c=us</td>
<td>X</td>
</tr>
<tr>
<td>LDAP address</td>
<td>C=usa/o=c11/ou=m000/cn=…</td>
<td>D</td>
</tr>
</tbody>
</table>

In addition, the following address type is available in Workflow:

<table>
<thead>
<tr>
<th>Recipient Type</th>
<th>Example</th>
<th>Indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organizational object ID</td>
<td>S 50000698</td>
<td>G</td>
</tr>
</tbody>
</table>
Automatic Entry of Address Type

Use

If you specify a recipient in the R/3 System, you normally have to assign the recipient type as well. This assignment can be entered automatically.

Procedure

1. In the field *Recipient*, enter the recipient name. A generic entry with * as the joker for a character string is permitted.

2. Choose ✅.

   The system searches for the recipient name.

3. If several recipients were found that correspond to the specified recipient name, these are listed. In this case, select the required recipient from the list by double-clicking on it.

Result

The recipient type is entered by the system in the field *Recipient type*.

However, note that the search for the recipient type is terminated as soon as one or more recipients are found within a recipient type. The search is performed in the following order:

- Address name
- User name
- External address
- Private distribution list
- Shared distribution list
- Other recipient types, the recipient addresses of which are recognized by their unique form (for example, Internet addresses with the symbol @).

If you have created a recipient list with the name Becker, for example, and this name also appears under the user names or the address names, the distribution list will not be found and, consequently, the recipient type *Distribution list* not listed. In this case, you have to specify the recipient type yourself.
**Send Attributes**

**Definition**

Attributes that users can assign to documents from the send screen. The send attributes apply to individual recipients, i.e. different attributes can be defined for separate recipients of the same document. The send attributes for each recipient are displayed in the recipient list (exception: blind copy).

**Structure**

When **sending [Page 85]** a document in the Business Workplace, users can assign the following send attributes to the document:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Express</td>
<td>If the recipients are working online in the relevant R/3 System, a message is displayed, informing them that an express message has been received.</td>
<td>![express_icon]</td>
</tr>
<tr>
<td>Copy</td>
<td>A document with this attribute is sent to the recipient for their information. This is only possible if <strong>Blind copy</strong> has not been selected.</td>
<td>![copy_icon]</td>
</tr>
<tr>
<td>Blind copy</td>
<td>The recipients of a blind copy are only displayed to the recipients themselves and to the sender. Recipients cannot forward or print a blind copy.</td>
<td>![blind_copy_icon]</td>
</tr>
<tr>
<td>No Forwarding</td>
<td>The recipient(s) cannot forward the document.</td>
<td>NF</td>
</tr>
</tbody>
</table>

In addition to the attributes specified above, users in the Business Workplace can receive documents from other applications with the following attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>ToDo</td>
<td>A recipient must process the document. The recipient can only move/delete the document from the inbox when the document has been processed (exception: moving the document to the resubmissions folder temporarily).</td>
<td>TD</td>
</tr>
</tbody>
</table>
Recipient Lists and Transmission Information

Use

You can call up information in the recipient list about documents which have been sent to you or which you have sent. This information includes status attributes, recipient information, correspondence history, and the recipient list.

Activities

In the folder content list of the outbox, for example, choose Recipient list in the context menu of a document.

You branch to the display of the document on the tab page Recipient list. All the recipients of the document are listed there. The list contains the following information:

- Recipient with send status (👍 for successfully sent, 🔄 for waiting, 🗑️ for send error)
- Recipient
- Symbol for note (which can be called by double-clicking on 📄)
- Send time
- Time at which the recipient read the document
- Time at which the recipient replied to the document
- Icon for correspondence history [Page 101] (which can be called by double-clicking on 📄)
- Forwarder.

Further information about the recipients selected in the list is displayed in the bottom window:

- Recipient and recipient type (address data can be called by clicking on the icon)
- Sender (address data can be called by clicking on 📄)
- Forwarder (address data can be called by clicking on 📄)
- Send attributes
- Status confirmation
- Correspondence history.
Correspondence History

Definition

List of correspondence for one document. A correspondence history exists if the reply function [Page 93] was used.

In each case, therefore, the correspondence history is only recorded between two correspondents.
Measures for Periods of Absence

Use

The Business Workplace provides the following office functions for periods of absence:

- **Substitution by other users [Page 103]**

  Users can define substitutes for their period of absence. The substitutes can then access the folder areas for which the absent user has given them authorization in their own Workplace. One or more substitutes can be defined for different time periods.

- **Automatic forwarding to another address [Page 104]**

  Users can specify addresses to which documents sent are forwarded. These addresses can be other internal users or external addresses (for example, Internet addresses). You can specify several addresses for forwarding but only one can be active for each time period.

  If necessary, automatic forwarding can also be set centrally by an administrator. See **Setting Automatic Forwarding Centrally [Page 222]**.

- **Automatic reply [Page 105]**

  Users can create a reply that is automatically sent to the senders of messages received by them. You can specify the reason and duration of your absence, for example, in this reply. It is only sent once to each sender. You can also specify that it is only sent to internal senders.
Creating a Substitute

Use

Using this procedure, you can create a substitute who can access your folder areas when you are on vacation, for example, and who can display and process folders and documents there. If a substitute creates new documents in your name, he or she is entered as the creator and you as the owner of the document. Confidential documents are not displayed to the substitute.

Only users who have authorization to work with the Business Workplace can be created as substitutes. All internal users normally have such authorization.

Procedure

1. In the Business Workplace, choose Settings → Private office settings.
2. Call the tab page Substitutes.
3. Choose .
4. Enter the name of the substitute and the time period in which the substitution is to be active.
5. Specify the folders areas that the substitute can access:
   - Your inbox and outbox
   - Your private folders
   - The folders and documents in shared folders for which you have authorization.
6. Choose .

Result

The substitute is created and becomes active at the specified time. The folder areas for which you have given the substitute authorization are displayed in the substitute's folder tree in addition to his or her own folder area.

You can specify more than one substitute. The substitutes that are currently active are flagged with the icon in the private office settings. You can change or delete substitutes that you have created at any time. Click on to call further information on a substitute.
Creating Automatic Forwarding

Use

You can create automatic forwarding to another address for a time period when you are away on business, for example, and have access to the Internet. In this case, you can send documents to a mailbox that you can access at any time from your notebook or from any computer.

Procedure

1. In the Business Workplace, choose Settings → Private office settings.
2. Call the tab page Automatic forwarding.
3. Choose .
4. Enter a recipient address and the time period in which automatic forwarding is to be active.
   The possible entries Internet address, X.400 address and Remote SAP Name are available when you are specifying an external address that is not stored in the address management.
5. Select whether you want all documents or only functional documents to be forwarded.
6. Select whether the documents that are forwarded are also to remain in your Workplace inbox.
7. Choose .

Result

Documents sent to your Workplace inbox are forwarded to the specified recipient in the specified time period. It is possible that an administrator has specified in shared office settings that confidential documents are not to be sent externally. In this case, if you forward documents externally (for example, to an Internet address), confidential documents remain in your R/3 inbox, regardless of whether you have selected the option Also place in inbox.

You can create automatic forwarding several times (for different time periods!). The forwarding that is currently active is flagged with in the private office settings. You may change or delete the forwarding at any time. Click on to call further information on a forwarding entry.

In contrast to manual forwarding, the forwarder is not displayed in the inbox list when documents are forwarded automatically.
Creating an Automatic Reply

Use
If you are going to be absent for any period of time or you want to reduce your workload, you can create an automatic reply which is automatically sent in response to all incoming messages. In this way, the sender is informed that no reply to the matter in question will be forthcoming during a certain time period. When the automatic reply is sent, the message in your inbox is not viewed or completed. You must still process the message as required by the attributes.

Procedure
9. Call the tab page Automatic reply.
10. Enter the time period in which the automatic reply is to be active.
11. Enter a title and a text.
12. Choose ✓.

Result
The automatic reply is saved and is sent to the senders of the documents received in your Workplace inbox in the specified time period. If a sender sends several documents to you, they only receive the reply once.

Only one automatic reply can be created. You can specify on the tab page Send/Print whether the reply is to be sent to external addresses.
Private Office Settings

Use
The private office settings contain the default settings for the send, folder and office functions in the Business Workplace. In addition, they contain information on authorizations and the address of the user.

Prerequisites
Users with the role SAP_BPT_USER can display and change their own settings and address. They can display the settings and address of other R/3 users. Administrators with the role SAP_BPT_ADMIN can change all settings.

Features

Default settings for processing documents

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change options after sending</td>
<td>Specify whether documents that you have sent can be changed by you alone, by all users or not at all. You can overwrite this default setting in the document attributes.</td>
<td>Changeable by author</td>
</tr>
<tr>
<td>Default document classes</td>
<td>Specify which document classes are to be directly displayed for selection when the function Create is called and specify the name under which this is to occur.</td>
<td>DOC - Word document</td>
</tr>
<tr>
<td>Confirmation prompt when deleting</td>
<td>This flag prevents you from deleting things accidentally. If you select this field, a dialog box is displayed after you have called the Delete function asking you to confirm the deletion before it is carried out.</td>
<td>X</td>
</tr>
<tr>
<td>Start PC application in the R/3 window</td>
<td>Specify whether you want to display and edit PC documents directly in the R/3 window. This setting only applies to PC applications that support OLE, such as Microsoft Word or Excel.</td>
<td>X</td>
</tr>
<tr>
<td>Resubmission only on working days</td>
<td>Specify whether you do not want to receive resubmissions on weekends or public holidays but rather on the last working day before.</td>
<td>X</td>
</tr>
<tr>
<td>Factory calendar</td>
<td>In the field Factory calendar, select the factory calendar that corresponds to your region so that the system proceeds according to the appropriate calendar when the setting Resubmission only on working days is selected.</td>
<td>Germany (Baden-Württemberg)</td>
</tr>
</tbody>
</table>

Default settings for sending and printing documents

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send automatic reply externally.</td>
<td>Specify whether your automatic reply is to be sent to external addresses (for example, to fax addresses).</td>
<td></td>
</tr>
</tbody>
</table>
Copy to outbox | Specify whether you want an overview in your outbox of all the documents that you have sent. You can then follow transmission information, for example. If an administrator has defined an expiry date for the outbox, the document is automatically deleted when this date is reached. You can overwrite the default settings on the send screen. | X

Name | If you want to store the documents that you have sent in a private folder, if necessary in addition to the outbox, enter the name of the folder here. After your confirmation, the corresponding title is automatically entered. Note that the folder can become very big if you do not ‘clean it up’ regularly. You can overwrite the default settings on the send screen. | X

Change print parameters | Specify whether you want to branch to the screen with the print parameters before you print so that you can change them (for example, the printer) if necessary. | X

Include document header | Specify whether the document header (title, creator and so on) is also to be printed. | X

Include note | Specify whether notes assigned to a document are to be printed. | 

Include recipient list | Specify whether the recipient list for a document is to be printed. Remember that the recipient list may be very long. | 

Office functions for periods of absence
You have the following options:
- Create a substitute [Page 103]
- Create automatic forwarding [Page 104]
- Create an automatic reply [Page 105]

Administration information on the current user
The following information is displayed:
- User name, address name and address number
- Creator, changed by, creation time and change time
- Last access to the Business Workplace by the user
- Send authorizations, authorizations for creating shared folders and archiving authorization of the user.

Activities
Users can maintain their private office settings themselves. To do this, choose Settings → Office settings in the Business Workplace. You can maintain the settings on six tab pages. The following functions are also available:
Private Office Settings

- You can display the address of the current user by choosing 📧.
- You can call the address management and search for addresses on the tab page Administration information using the pushbutton 📧 Address management.
- You can call the office settings of a different R/3 user by choosing Other user.
- Administrators can assign a Business Workplace [Page 219] to a user manually by choosing 📧.

To save the changes, choose ✅.

Administrators can use a function [Page 218] to maintain the settings centrally for all users or for a certain group of users.
Displaying Addresses and Other Personal Data

Use
You can display the addresses and data, such as department and cost center, of R/3 users. You can also display external addresses that are stored in the address management of the R/3 System or in an LDAP service.

For information on changing addresses, see Maintaining Internal Private Addresses [Page 226] and Maintaining Addresses of Companies and Contact Persons [Page 227].

Procedure

Display addresses of R/3 users
1. In the Business Workplace, choose Environment → Display personal data
2. Enter search criteria. A generic entry with * as the joker for a character string is permitted (for example, B*cker for a last name or 101101* for a cost center).
3. Choose .
   A list of the data of all the users who meet your search criteria is displayed. You can use the list editing functions of the R/3 System. You can use the data for mail merging in Microsoft Word, for example.

Display external addresses from the R/3 address management
1. In the Business Workplace, choose Environment --> External contact persons or External companies.
2. Enter the search criteria.
3. Select Display.

Find and display addresses in an external directory service (LDAP)
1. In the Business Workplace, choose Environment → External directory service.
2. Enter the search criteria. For more information, see Search Screen for LDAP Addresses [Page 110].
3. Select Display.
Specify the LDAP server in which addresses are to be searched for. You can call the servers connected to the SAP System and select one using the input help.

Search criteria

Which part of the addresses is to be searched (for example, name or department)?

Is the character string to be searched for (equal)? Or are all addresses that do not contain this character string to be searched for (unequal)?

Which character string is to be searched for (for example, Smi* or Purchasing)? * can be used as a joker

Specify whether all search criteria or whether only a minimum of one of the search criteria must be fulfilled. An OR link and unequal operators should not be combined.

You can increase or decrease the number of search criteria using these symbols.
Processing the Quota Notification

Use

Administrators can execute a program that calculates the size of your private folder areas. The results can be sent to you. You then receive a document in your inbox with the title *Your quota from* `<Date> <Time>` . When you execute this document, the results of the quota are displayed in a list. They can also be displayed as a graphic.

The notification of your quota is often a sign that your folder areas have become too big. If this is the case, delete unnecessary documents and move the documents that you do want to keep from your inbox to your private folders as soon as possible. You can monitor the success of your clean-up work by calculating your quota again and displaying the history of the data collected.

Prerequisites

To recalculate the quota, you require the authorization for executing background jobs.

Procedure

After receiving the quota document

1. In the folder contents list, choose *Execute* in the context menu of the quota document.
   
   The list of results of the data collection is displayed.

2. To call the graphic showing the results, choose \[Image\].

After cleaning up

1. Call the quota document in the folder contents list by double-clicking on it.

2. Choose *Quota* → *Recalculation*.

3. To display the history of the data collections, choose *Quota* → *History*.

Result

The system runs the calculation in the background. You receive a message in your inbox as soon as it is finished.
Object Services

Use

Object services allow general functions, such as the communication and document administration functions, to be executed in a cross-application way. This means that you can create information about an object, display the information, or send the information to another user from anywhere in the R/3 System. You can call object services in all applications that support this function.

For further information on object services [Ext.], see the documentation: BC - Generic Business Tools.
Business Workplace With Other Interfaces

Use

The Business Workplace enables users to use other interfaces to edit their messages and - with limited functions - work items. These include the Web browser and Groupware, such as Microsoft Outlook.

Users can access the Business Workplace with the normal mail interface using the SAP MAPI Service Provider, as long as the mail interface is MAPI compatible. Documents, folders, work items and the calendar can be displayed and edited online or offline using Microsoft Outlook. In this case, the functions of the mail clients (e.g. Drag’n’Drop and full text search) are available in addition to the functions of the Business Workplace. Outlook provides a form that enables R/3 specific functions to be used for messages. If you use telephone integration with SAPphone, users can initiate a call directly from Microsoft Outlook using this form. Further information about working with the Business Workplace using MAPI compatible mail clients can be found in the SAP MAPI Service Provider [Ext.] documentation. For further information on the use of forms, see BC - Form Integration with SAPforms.

You can edit the Business Workplace and the calendar in a Web browser using the Internet Transaction Server. Further information about working with the Business Workplace using the Internet Transaction Server can be found in the documentation: Business Workplace in the Internet [Page 114].
Business Workplace via the Internet

Use

This Easy Web Transaction gives you access to your Business Workplace. The following folders are available:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inbox</td>
<td>Here you will find all documents sent to you, work items assigned to you and resubmissions.</td>
</tr>
<tr>
<td>Outbox</td>
<td>Here you will find an overview of and additional information on documents you have sent, workflows you have started and work items you have executed or forwarded.</td>
</tr>
<tr>
<td>Private folders</td>
<td>This is a folder structure for managing your own documents, messages, distribution lists and work processes.</td>
</tr>
<tr>
<td>Shared folders</td>
<td>This is a folder structure for publication and management of information on an enterprise-wide or group-specific basis.</td>
</tr>
<tr>
<td>Resubmission s</td>
<td>This provides temporary storage for the documents and work items to be resubmitted into your inbox at some point in the future.</td>
</tr>
<tr>
<td>Trash</td>
<td>This provides temporary storage for the folders and documents you have deleted. This folder gives you the opportunity to undo the deletion.</td>
</tr>
</tbody>
</table>

The Business Workplace provides access to the R/3 mail and folder system as well as SAP Business Workflow end user functions. This enables you to create, process and send documents [Page 116] as well as display and process work items [Ext.].

The mail and folder functions enable you to display documents and folders, and create, send and process documents or short messages.

Unlike in the R/3 System, although you can display and process documents of every class including their attachments, you can only create text documents. The full subfolder structure of a folder is not displayed, but individual levels through which you can then navigate.

The workflow functions enable you to display and execute work items. After logging on to the R/3 System via the Internet, you can display your worklist. This list of work items is identical to the list that the employee would see if they logged on to the R/3 System directly.

Prerequisites

Authorizations/security

An employee who is to have access to their Business Workplace via the Internet needs the authorizations of a Workplace end user. This authorization is in the role SAP_BC_SRV_GBT_USER.
Features

Service name

The service name of this Easy Web Transaction is BWSP. The relevant files are located under this service name in the SAP@Web Studio.
Creating, Processing and Sending Documents

1. Select a folder.

2. The following processing options are available:
   - To create a short message, a document or a folder, choose *Create short message, document* or *Create folder*.
   - To display a short message, a document or a folder, select it from the list by single-clicking.
     Which functions you can select depends on the folder in which you are located.

4. In the screen area in which the content of the document is displayed, you have the following processing options:
   - **Short message**: Specify a recipient and choose *Find* so that the recipient type is entered automatically. Select *Express* if applicable and enter a title and the text. Choose *Send*. The message is sent to the recipient and stored in your outbox.
   - **Document**: Enter a title and a text and choose *Save*. You can process the document with the following functions:
     - **Create attachment**: If you want to create a text document as an attachment, specify the title of the document. If you want to create a PC document as an attachment, specify its file path and name or choose *Browse* in order to select the PC document from the folder hierarchy of your PC.
     - **Send**: Specify a recipient and choose *Find* so that the recipient type is entered automatically. Select *Express* if applicable.
     - **Resubmit**: Specify a resubmission date and choose *Save*.
     - **Move** or **Create link**: Your private folders are displayed. Select the required folder. After moving the document, it is only available in the selected folder. When creating a link, you get the same document in the original folder and in the selected folder, so that changes to this document will be visible in both folders.
     - **Delete**: The document is moved to the trash. You can retrieve it or delete it permanently there.
   - **Recipient list and transmission information**: With short messages and documents that have been sent, you can display the recipient list by selecting *Recipients* in the document display. This also provides information as to which of the individual recipients have read the document and when.
**Business Workplace: Workflow Functions**

**Use**

You use this part of the Business Workplace [Page 10] if you want to use the functions of SAP Business Workflow.

The Business Workplace is the main interface between an end user and the workflow system. All dialog and missed deadline work items to which the user is assigned as a recipient are displayed in the user's workflow inbox.

As a head of department, you are responsible for approving leave requests. The relevant approval process is implemented using a workflow in your enterprise.

The requests (in the form of work items) appear in your worklist (workflow inbox) and must be rejected or approved there.

The rejected or approved requests (executed work items) are not only returned to the applicants after processing, but are also put into your workflow outbox (under Work items executed by me). You can therefore check the requests you have processed.

**Features**

**Workflow settings**

You can configure the workflow functions in the Business Workplace using the personal workflow settings [Page 144].

**Business Workplace screen areas**

The Business Workplace has three screen areas, which are used in the following manner by SAP Business Workflow:
Overview tree

The following workflow functions are available under the Inbox node, which is under the initial node Workplace:

- Workflow
  - Grouped according to task
  - Grouped according to content
  - Grouped according to content type
  - Grouped according to sort key
- Overdue entries
- Deadline messages
- Incorrect entries

For information on these functions, refer to Workflow Inbox [Page 158].

The following functions are available under the Outbox node, which is under the initial node Workplace:

- Started workflows
- Work items executed by me
- Forwarded work items

For information on these functions, refer to Workflow Outbox [Page 196].
The Resubmissions node is located under the initial node Workplace and contains the:

- Workflow resubmissions [Page 198]

**Worklist**

The worklist [Ext.] is displayed in the upper right corner of the Business Workplace screen. Depending on whether you are in the workflow inbox, the workflow outbox or the workflow resubmissions, you have various functions available to you, which are described at the respective locations.

**Work item preview**

In the lower right corner of the Business Workplace screen, a work item selected in the worklist is displayed in a preview [Page 200]. Not all the functions of the work item display or the workflow log are available.

A user exit [Page 201] can be used to configure the work item preview to suit your individual requirements.

**Support for context menus**

All workflow functions can be called using the relevant context menu.

**Workflow Toolbox**

*SAP Business Workflow's Workflow Toolbox [Page 202] enables the user to access workflow functions even during a workflow-driven application transaction.*

**E-mail notification for new work items**

The report RSWUWFML can be used to inform an employee by mail that there is a new work item in their Business Workplace inbox.

This function is therefore beneficial to all employees who do not work with their Business Workplace on a daily basis.

**Activities**

To access the Business Workplace from the SAP Easy Access screen, choose one of the following options:

- ![icon](image)
- **Menu → Business Workplace**
- **Tools → Business Workflow → Development → Runtime Tools → Business Workplace.**
Work Item

Definition
Object that represents a task or action in the workflow system at runtime.

Use
Work items are subdivided into a specific work item type according to their assignments. The internal processing procedures are controlled via this work item type. The work item type determines which statuses and transitions are valid.

Depending on the work item type, some of these work items are displayed in a user's work list. Other work items, on the other hand, are only used and processed internally.

Structure

Work item types displayed in the Business Workplace

<table>
<thead>
<tr>
<th>Work item type</th>
<th>Short text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>W</td>
<td>Work item with dialog [Page 122]</td>
<td>Runtime representation of single-step tasks that require interaction with the user.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Runtime representation of user decisions</td>
</tr>
<tr>
<td>D</td>
<td>Missed deadline [Page 127]</td>
<td>Work item for notification of missed deadline</td>
</tr>
<tr>
<td>A</td>
<td>Work Queue [Page 130]</td>
<td>A work queue is a list of objects to be processed once and together in a limited time frame.</td>
</tr>
</tbody>
</table>

Other work item types

<table>
<thead>
<tr>
<th>Work item type</th>
<th>Short text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>Workflow [Page 132]</td>
<td>Runtime representation of a multistep task</td>
</tr>
<tr>
<td>B</td>
<td>Batch item [Page 137]</td>
<td>Runtime presentation of a single-step task that runs in the background</td>
</tr>
<tr>
<td>E</td>
<td>Wait step work item [Page 142]</td>
<td>Runtime representation of a wait step in the workflow definition</td>
</tr>
<tr>
<td>C</td>
<td>Container anchor</td>
<td>This type of work item is required as a special development in the EDI environment [Ext.]. It does not normally appear in the workflow environment.</td>
</tr>
</tbody>
</table>

Work items of this type should be regularly deleted or archived.
Dialog Work Items (Type W)

**Definition**
Work item that represents a task at runtime that requires interaction with the user.

Since the **user decision** is also represented internally by a task, a dialog work item can also represent a user decision.

When a dialog work item is executed, the underlying object method of the task is called. The deadlines for executing dialog work items are monitored.

**Use**
A dialog work item is displayed with **ready** status in the workflow inbox of the Business Workplace. It is removed from the integrated inboxes of the other agents when the recipient reserves, executes, or processes this work item with other functions.

The database oriented approach used in SAP Business Workflow allows a work item to be **seen** by several recipients equally authorized in organizational terms in their inboxes and **executed** from there. However, only one recipient can actually **reserve** this work item for processing and **execute** it. The work item is then no longer available to any other recipients.

**Integration**
A task represented by a dialog work item can be

- a step in a workflow definition:
  
  In the workflow definition, reference is made to tasks in the **activity** and **user decision** steps.

- started as single steps via an event or in dialog:
  
  Tasks can be started as elementary activities directly in dialog or via a triggering event. These tasks are then also represented by a dialog work item in the workflow inbox.
### Status of a Dialog Work Item

The valid statuses for dialog work items (type W) are listed in the following table.

<table>
<thead>
<tr>
<th>Work item status</th>
<th>Description</th>
</tr>
</thead>
</table>
| 🔄 waiting        | The work item has been scheduled for its requested start. A work item has this status:  
  - if it already exists but the requested start specified in the workflow definition has not been reached yet.  
  - if it has been set to resubmission  
  Work items in the waiting status are not displayed in the workflow inbox. |
| 🔄 ready          | The work item has been released for execution and appears in the workflow inbox of all recipients. |
| 🔄 reserved       | The work item has been received by one of its recipients with the result that its status has changed from ready to reserved.  
  A work item in the reserved status is then displayed to this recipient only. It is no longer displayed in the workflow inboxes of the other recipients. |
| 🔄 In process     | The work item is currently being processed by a recipient or in a different mode. A work item also has this status:  
  - if the work item is waiting for its terminating event.  
  - if the user cancelled the method.  
  - if the method was ended with a temporary exception for which no subsequent steps have been modeled.  
  The point at which processing is completed cannot be detected by the workflow system in this status. As long as the status of the work item is set to in process, database changes have not been made. |
| 🔄 Executed       | The work item is awaiting explicit confirmation of its completion.  
  The work item only has this status if it is necessary to confirm that it has been completed. A work item with executed status can be executed or forwarded several times until it is set to the status done in the Business Workplace.  
  In this way, groupware components are realized in SAP Business Workflow. |
| 🔄 completed      | The execution of the work item is completed.  
  The result of the task represented by the work item is correct, i.e. the result modeled in the workflow definition.  
  Work items in the completed status are not displayed in the workflow inbox of the Business Workplace. |
### Status of a Dialog Work Item

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Logically deleted</strong></td>
<td>Execution of the work item is no longer meaningful or required by the workflow logic.</td>
</tr>
<tr>
<td></td>
<td>A work item changes to the <em>logically deleted</em> status in the following way:</td>
</tr>
<tr>
<td></td>
<td>* Termination in parallel processing branches*</td>
</tr>
<tr>
<td></td>
<td>When the required number of processing paths has been executed in a fork, the work items</td>
</tr>
<tr>
<td></td>
<td>in the other paths that have not yet reached the <em>completed</em> status are automatically</td>
</tr>
<tr>
<td></td>
<td>set to the <em>logically deleted</em> status.</td>
</tr>
<tr>
<td></td>
<td>* Intervention by an administrator*</td>
</tr>
<tr>
<td></td>
<td>An administrator can only set a work item to the <em>logically deleted</em> status if it has</td>
</tr>
<tr>
<td></td>
<td>not yet reached the <em>completed</em> status and is not part of a higher-level workflow.</td>
</tr>
<tr>
<td></td>
<td>Work items in the <em>logically deleted</em> status are not displayed in the workflow inbox of the</td>
</tr>
<tr>
<td></td>
<td>Business Workplace.</td>
</tr>
<tr>
<td></td>
<td><img src="image1.png" alt="Diagram" /></td>
</tr>
<tr>
<td></td>
<td>A work item with the <em>logically deleted</em> status may have caused database changes or other</td>
</tr>
<tr>
<td></td>
<td>actions (generate event, send notification). These changes are not canceled automatically</td>
</tr>
<tr>
<td></td>
<td>(compensated).</td>
</tr>
<tr>
<td><strong>error</strong></td>
<td>Execution of the work item was terminated with an error.</td>
</tr>
</tbody>
</table>

In addition to the statuses given above, a work item can be **locked against execution**. This is possible in any status and involves an administrative function which is selected for a work item via the *Change* option.
Status Transitions of a Dialog Work Item

The diagram below shows the possible status transitions that a dialog work item (type W) can undergo:

![Status and Status Transitions of Work Items (W)](image)

- **Waiting**:
  - Transition to **Ready** via **Reserve** or **Replace**
  - Transition to **Error** via **Execute**
  - Transition to **Completed** via **Execute**

- **Ready**:
  - Transition to **Reserved** via **Replace**
  - Transition to **In process** via **Execute**
  - Transition to **Completed** via **Execute**

- **Reserved**:
  - Transition to **Ready** via **Reserve**
  - Transition to **In process** via **Replace**
  - Transition to **Completed** via **In process**

- **In process**:
  - Transition to **Completed** via **Execute**
  - Transition to **Error** via **Execute**

- **Completed**:
  - Only visible in Business Workplace if:
    - End of processing is to be confirmed explicitly.
    - Method was terminated with a temporary exception.
    - Terminating event is expected.

- **Waiting**:
  - Only visible in Business Workplace if:
    - End of processing is to be confirmed explicitly.

- **Ready**:
  - Only for object methods for which the end of processing has to be confirmed explicitly.

The arrows are labeled with the functions used by a user to trigger the respective status transition.

**Comments**

For further information, refer to Status of a Dialog Work Item [Page 123].

**Transition from status waiting**

The transition from the status waiting to the status ready is performed automatically by the work item manager when the requested start is reached. A workflow system administrator can set a work item to the status ready manually.

**Transition from status ready**

From this status, the work item passes either to the status reserved or via the status in process to the status completed.

**Transition from status reserved**

A work item with the status reserved can be reset to the status ready.
Status Transitions of a Dialog Work Item

Transition to and from status *in process*
A work item with the status *in process* can be reset to the status *ready*. A workflow system administrator can reset a work item manually. This function is available when changing the work item.

Transition from status *executed*
After confirmation of end of processing, the work item assumes the status *completed*.

Transition from status *completed*
Work items with the status *completed* can no longer be set to another status even if a workflow system administrator intervenes.

Transition from status *error*
A workflow system administrator can intervene and set work items with errors to the status *in process* or the status *logically deleted* (possibly after eliminating the error).

Transition from status *logically deleted*
Work items with the status *logically deleted* can no longer be set to another status even if a workflow system administrator intervenes.
Missed Deadline Work Item (Type D)

Definition

Notification of a deadline recipient if the runtime system detects that the deadline for a certain work item has been exceeded.

Use

This work item informs its recipients that a deadline (start or end deadline) of a monitored work item has been exceeded. The recipients are informed by means of a missed deadline work item (type D) in the workflow inbox of the Business Workplace.

When it is executed, this work item displays information on the monitored (and now late) work item.

The text for notifying the recipient is set by default.

When a deadline is monitored for an activity [Ext.] or user decision [Ext.], it is also possible to enter an individual text in the respective task definition.
## Status of a Missed Deadline Work Item

The valid statuses for missed deadline work items (type D) are listed in the following table:

<table>
<thead>
<tr>
<th>Work item status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready</td>
<td>The work item appears in the Business Workplace of the recipients.</td>
</tr>
<tr>
<td>In process</td>
<td>One of the recipients has executed the work item</td>
</tr>
<tr>
<td>Completed</td>
<td>The execution of the work item is completed.</td>
</tr>
<tr>
<td></td>
<td>Work items in the <em>completed</em> status are not displayed in the workflow inbox of the Business Workplace.</td>
</tr>
</tbody>
</table>
Status Transitions of a Missed Deadline Work Item

The following status transitions are possible for missed deadline work items (type D):

**Transition to and from status in process**

The status of a missed deadline work item changes from *ready* to *in process* when it is executed by a user. Execution of a missed deadline work item displays the most important information on the monitored work item.

The missed deadline work item remains in the *in process* status until end of processing is confirmed explicitly. Until then, the work item can be executed or forwarded several times.

**Transition to completed status**

The status of the missed deadline work item changes to the *completed* status when completion of processing has been confirmed explicitly.
Work Queue Work Item (Type A)

Definition

Work item that represents a work queue.

A work queue comprises a list of objects that are to be processed once together within a specified period. The work queue serves as a framework for the individual entries to be processed and manages the list of objects to be processed including their statuses and the tasks to be performed on them.

Work queue work items are displayed in the Business Workplace. The work item status indicates the overall processing status of the work queue.

Use

Once you have created the work queue work item and you know its work item ID, you have the following options:

- Process the work queue within a workflow.
- Control the release, processing and status evaluation of the work queue with function modules.
- Control the release and processing of the work queue by processing the work queue work item directly.

Integration

To create the work queue work item from the list, you call the function module `SWZ_AI_CREATE`.
Status of a Work Queue Work Item

A work queue work item can have the following statuses:

<table>
<thead>
<tr>
<th>Work item status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>waiting</td>
<td>The work queue has been created but cannot be released yet.</td>
</tr>
<tr>
<td>ready</td>
<td>The work queue work item (type A) is displayed in the Business Workplace of the recipients passed in the table AGENTS of the function module SWZ_AI_CREATE. If the work queue is to be processed via a workflow and therefore not appear as a separate work item in any Business Workplace, a non-existent user must be specified in the table when the work queue is created. The work queue must be reserved for further processing.</td>
</tr>
<tr>
<td>reserved</td>
<td>A person with release authorization has reserved the work queue.</td>
</tr>
<tr>
<td>In process</td>
<td>Work queue processing has begun. – Dialog work items (type W) have been created for entries with dialog. – For entries without dialog marked accordingly, the methods have been executed directly.</td>
</tr>
<tr>
<td>completed</td>
<td>All lines in the work queue have the status COMPLETED or CANCELLED and have reported back accordingly to the work queue. A work queue work item (type A) that assumes this status automatically creates the event created.</td>
</tr>
<tr>
<td>Logically deleted</td>
<td>Further processing of the work queue is invalid (and therefore no longer possible).</td>
</tr>
<tr>
<td>error</td>
<td>At least one line of the work queue has the status error.</td>
</tr>
</tbody>
</table>
Workflow Work Item (Type F)

Definition

Work item that represents a multistep task at runtime.

Use

For every multistep task started there is one type F work item. The workflow log and the workflow container can be accessed:

- For error diagnosis and error correction if no work items are displayed
- For information on steps of a workflow (including their current agents, notes, and ad hoc objects) already processed
- For modifying an ongoing workflow by changing the workflow container
- For reporting on completed processes

Type F work items are not displayed in the Business Workplace but can be found using the work item selection [Ext.]

Structure

A workflow consists of a sequence of work items that are executed by agents or the system. The work items represent the steps in the workflow definition that refer to a particular task. These are steps of the types activity [Ext.] or user decision [Ext.].

Integration

Workflow Execution
The Work Item Manager manages the processing of work items and monitors deadlines. To automate workflow processes, activities in the workflow can also refer to object methods which run in the background. If this is the case, the work item manager initiates the calling of the background processes.

The work items whose execution requires dialog can be accessed by the selected agents (determined from the organizational model and role resolution) from their worklists in order to select them for processing.

This worklist is displayed and managed in the workflow inbox of the Business Workplace [Page 117].
Status of a Workflow Work Item

The valid statuses for workflow work items (type F) are listed in the following table:

<table>
<thead>
<tr>
<th>Work item status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waiting</td>
<td>The (sub) workflow is scheduled but its requested start has not yet been reached.</td>
</tr>
<tr>
<td>Ready</td>
<td>Temporary interim status</td>
</tr>
<tr>
<td>In process</td>
<td>Execution of the (sub) workflow has begun.</td>
</tr>
<tr>
<td>Completed</td>
<td>The end of the (sub) workflow has been reached.</td>
</tr>
<tr>
<td>Logically deleted</td>
<td>Execution of the (sub) workflow is no longer required or meaningful. A status of a workflow changes to <em>logically deleted</em> in the following way:</td>
</tr>
<tr>
<td></td>
<td>- Intervention by an administrator.</td>
</tr>
<tr>
<td></td>
<td>An administrator can only set a workflow item to the <em>logically deleted</em> status if it has not yet reached the <em>completed</em> status.</td>
</tr>
<tr>
<td></td>
<td>- Termination in parallel processing branches</td>
</tr>
<tr>
<td></td>
<td>When the required number of processing paths has been executed in a fork, the work items in the other paths that have not yet reached the <em>completed</em> status are set to the <em>logically deleted</em> status.</td>
</tr>
<tr>
<td></td>
<td>A workflow set to the <em>logically deleted</em> status is recursively scanned for dialog and workflow work items (type W or F) that do not yet have the status &quot;completed&quot;. These work items are then also set to the status <em>logically deleted</em>.</td>
</tr>
<tr>
<td></td>
<td>A work item changed from the <em>executed</em> status to the <em>logically deleted</em> status may already have caused database changes or other actions (generate event, send notification). These changes are <em>not</em> canceled automatically (compensated), but are recorded in the log.</td>
</tr>
<tr>
<td>Errors</td>
<td>An error occurred in workflow control.</td>
</tr>
</tbody>
</table>

Workflows and their statuses are **not** displayed in the Business Workplace. Information about the workflow can be accessed via the subordinate dialog work items.
Status Transitions of a Workflow Work Item

The diagram shows the possible status transitions.

The statuses of a workflow work item and the permissible status transitions always concern an entire workflow.

A step (activity) in the workflow definition can reference both a task and another workflow. A workflow can therefore also contain subordinate subworkflow items.

Comments

Transition from status waiting

The work item manager automatically carries out the transition from the waiting status to the ready status when the requested start date/time of the workflow has been reached.

A workflow system administrator can set a work item to the status ready manually.

Transition from status ready

The ready status is a temporary interim status because it only exists until the first work item of the workflow has been created.

Transition to and from status in process

The status of the workflow changes to in process as soon as the first work item of this workflow has been created. The workflow remains in this status until the entire workflow definition has been processed.
Status Transitions of a Workflow Work Item

**Transition to incorrect status**

An error occurs during workflow control or coordination.

Role resolution for determining an agent does not return a result which can be used.

A workflow system administrator can intervene and set workflows with errors to the status *in process* or the status *logically deleted* (possibly after eliminating the error). If a workflow is incorrect, the responsible workflow system administrator specified either globally in Customizing or in the basic data of each workflow definition is notified by mail.

This status does *not* mean that a dialog work item of this workflow has the *incorrect* status.

**Transition to completed status**

A workflow is set to the status *completed* when the last step of the relevant workflow has been completed.
Background Work Item (Type B)

Definition

Work item that represents a single-step task at runtime whose execution does not require a dialog and, therefore, can be controlled automatically by the system.

Integration

Type B work items are not displayed in the Business Workplace.
Status of a Background Work Item

The valid statuses for background work items (type B) are listed in the following table.

<table>
<thead>
<tr>
<th>Work item status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Waiting</strong></td>
<td>The work item has been scheduled for its requested start. A work item has this status after it has been created until the requested start specified in the workflow definition is reached.</td>
</tr>
<tr>
<td><strong>Ready</strong></td>
<td>Temporary intermediate status of a background work item. The system calls the associated object method as soon as a background work item can be processed. The status of the background work item then changes to in process immediately.</td>
</tr>
<tr>
<td><strong>In process</strong></td>
<td>The work item is currently being processed. A work item also has this status: • if the method was left with a temporary exception. In this case, special Error Handling for Background Work Items with Temporary Errors [Page 140] is carried out. • if the work item is waiting for its terminating event. The point at which processing is completed cannot be detected by the workflow system in this status.</td>
</tr>
<tr>
<td><strong>Completed</strong></td>
<td>The execution of the work item is completed. The result of the task represented by the work item is correct, i.e. the result modeled in the workflow definition.</td>
</tr>
<tr>
<td><strong>Logically deleted</strong></td>
<td>Execution of the work item with regard to the process logic is no longer meaningful or necessary for the process to continue. A work item changes to the logically deleted status in the following way: • Termination in parallel processing branches When the required number of processing paths has been executed in a fork, the work items in the other paths that have not yet reached the completed status are automatically set to the logically deleted status. • Intervention by an administrator The administrator can only set a work item to the logically deleted status if it has not yet reached the completed status and is not part of a higher-level workflow. A work item with the logically deleted status may have caused database changes or other actions (generate event, send notification). These changes are not canceled automatically (compensated).</td>
</tr>
</tbody>
</table>
# Status of a Background Work Item

| Error | Execution of the work item was terminated with an error. |

In addition to the statuses given above, a work item can be **locked against execution**. This is possible in any status and involves an administrative function which is selected for a work item via the *Change* option.
Error Handling for Background Work Items

Use

Error handling for background work items must be carried out by the workflow system

- because background work items (with errors) are not displayed in the Business Workplace and are therefore detected too late, if at all.
- because background work items that are temporarily incorrect, for which another execution attempt can (theoretically) be successful, cannot be restarted by a user.

(Temporarily incorrect work items are work items whose method was terminated with a temporary exception for which no subsequent step has been defined.)

Features

In Customizing for the workflow system, you can define how often the workflow system attempts to restart a temporarily incorrect work item. You can also define the interval between two repetition attempts and activate the monitoring function.

Monitoring is also activated as part of automatic Customizing [Ext.] (Tools → Business Workflow → Development → Utilities → Customizing).

You can also specify the maximum number of repetition attempts ("repetition counter") separately for each individual background step in the respective workflow definition. This setting overrides the value in Customizing if it is greater than zero.

If an error (method exception) occurs when background work items are executed by the workflow system, the system responds as follows depending on the type of exception and error modeling settings:

<table>
<thead>
<tr>
<th>In the workflow definition...</th>
<th>The exception is defined for the object method as a...</th>
</tr>
</thead>
<tbody>
<tr>
<td>a subsequent step is modeled for the exception.</td>
<td>temporary error</td>
</tr>
<tr>
<td>The step has status completed and the modeled subsequent step is executed.</td>
<td>Background work items for which a repetition counter is explicitly modeled in the workflow definition are restarted first by the system. If all of the attempts are unsuccessful, the status of the work item changes to completed and the modeled subsequent step is executed.</td>
</tr>
</tbody>
</table>
Error Handling for Background Work Items

| no sub subsequent step is modeled for the exception | The step is not yet completed. The respective work item retains the status in process. Background work items are restarted by the system. The number of repetition attempts is determined either by the repetition counter in the step definition or - if this is equal to zero - by the repetition counter set in Customizing. If all of the attempts are unsuccessful, the work item status changes to incorrect. | Workflow and work item assume the error status. |

Processing Incorrect Work Items

The workflow system sends a mail to the relevant system administrator for every background work item with the status incorrect.

Processing Work Items That Have Been Started

The workflow system determines all of the background work items that have been in process for longer than 30 minutes. An error message is then sent to the workflow system administrator for all of these background work items, since the system assumes that processing has been cancelled. However, this does not necessarily mean that an error has occurred.
Wait Step Work Item (Type E)

Definition
Work item that represents a wait step or a workflow at runtime, which is waiting for an event to occur.

Use
Type E work items are not displayed in the Business Workplace.
Work Item with Express Notification

Use

When the system creates a work item with priority 1, each of its recipients [Ext.] receives an express notification (dialog box with appropriate text) on the screen. The recipient can call the Business Workplace directly from the express message.

Excluded agents do not receive a message.

Constraints

The system does not create an express message

- if the user processes the work item immediately due to advance with immediate dialog [Ext.].
- if the work item represents a general task [Ext.] that is not restricted to certain agents.
- if the work item was forwarded.

The system only creates express notifications when a work item is created. An express notification is not created for the new recipients of priority 1 work items that are forwarded.

If one of the selected agents processes the work item, the other agents still receive an express message.

Features

Express messages are only sent for dialog steps as soon as the system has created them with the ready status. If the work item is created first with the waiting status because its requested start has not been reached yet, the express message is not sent until the status changes from waiting to ready.

Activities

How is the priority set?

The priority of a work item can be determined for steps that require a dialog with the user. It is defined in the tab page Miscellaneous of the step definition.
Workflow Settings

Use
You use the workflow settings to maintain the special workflow functions in the Business Workplace.

Features
The following functions are available:

- Personal settings [Page 145]
- Display organizational assignment [Page 147]
- Refresh organizational environment [Page 147]
- Adopt substitution [Page 150]
- End substitution [Page 150]
- Maintain substitute [Page 150]
- Activate substitute [Page 150]
- Adopt view [Page 154]
- Exit view [Page 154]

Activities
You can access the workflow settings within the Business Workplace [Page 117] via Settings → Workflow settings.
Personal Settings

Use
The personal settings for workflow enable you to adapt the runtime system to suit your requirements.

Features

Work item display

| User view with ActiveX (32-bit) | Both of these settings define the work item display [Page 161] as the default. Note that the ActiveX variant is only available on 32-bit platforms. |
| User view without ActiveX       |                                                                                                                        |
| Technical view                  | This setting defines the technical work item display [Page 170] as the default.                                        |

Workflow log

| User view with ActiveX (32-bit) | User view of the workflow log [Page 173] without any technical aspects. This view uses ActiveX controls and is therefore only available on 32-bit platforms. |
| User view without ActiveX       | User view of the workflow log without any technical aspects. This view uses the hierarchical list display of the ABAP List Viewer [Ext.]. |
| Technical view                  | In addition to the main semantic information, the technical view of the workflow log also displays technical numbers and texts that may not be available in the logon language of the user. The technical view is intended primarily for system administrators. |

Further settings

| Display work item texts in logon language | All work item texts in the Business Workplace are always displayed in the user’s logon language. If the user’s logon language is different to the language in which the work item was created, additional database accesses are required that can delay display of the Business Workplace. |
## Personal Settings

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable forwarding of work items to several users</td>
<td>The work item can be forwarded to several agents. The term “agent” is used in a broad sense in this context. You specify the agent as an organizational object (organizational unit, job, position, user) when forwarding the work item. This organizational object can consist of several persons. For further information, refer to [Forwarding](Page 190).</td>
</tr>
<tr>
<td>(Double)-clicking on an object displays the object in the same window.</td>
<td>You can choose an object in the work item display, which is then displayed in the current session window and replaces the work item display. When you exit the object display, you return to the work item display. If you do not set the indicator, a new session is created to display the object. This setting does not apply if you work with the SAP GUI for HTML.</td>
</tr>
<tr>
<td>No tips &amp; tricks in workplace</td>
<td>The [Business Workplace](Page 117) includes tips and tricks for working with work items and workflows in the work item preview. If you set this indicator, the tips and tricks are not displayed.</td>
</tr>
<tr>
<td>No HTML in execution of decision tasks.</td>
<td>You use this indicator to decide whether the execution of decision tasks is displayed in HTML or not. Deactivating the HTML display may make sense, for example, if you have problems displaying HTML documents generally because of the settings in your local HTML browser.</td>
</tr>
</tbody>
</table>

## Activities

To change the personal settings for workflow, you choose **Settings → Workflow settings → Personal settings** in the Business Workplace.

The settings are saved as user parameters and take effect the **next time** the work item display or workflow log is **called**.

You can change the standard values for these personal workflow settings in Customizing for SAP Business Workflow. These standard values are always used if users have not maintained settings of their own.
Organizational Assignment of a User

Use

The worklist displayed is formatted specifically for the user who is logged on. You can query this user's organizational assignment.

Prerequisites

The functionality described depends on a setting in the PD system table [Ext.].

Features

The organizational assignment of a user is buffered and read at each new logon or once a day (but not each time the Business Workplace is called).

If the organizational assignment of a user changes while the user is logged on and must be updated, you choose Settings → Workflow settings → Refresh organizational environment in the Business Workplace.

Activities

To view current information on the assignment of the user logged on in the organizational plan of the enterprise, choose Settings → Workflow settings → Display organizational assignment in the Business Workplace.

The following information is displayed for the user logged on:

- The name maintained in the user address
- The organizational unit
- The position the user occupies
- The job describing the position

By double-clicking on an entry, you can display the staff assignments or the job description.
Substitutes for Workflows

Use

*SAP Business Workflow* implements a substitution arrangement to deal with a user's duties in their absence.

Prerequisites

The automatic appearance of work items in the substitute's worklist is dependent on a setting in the PD system table [Ext.]. It is possible to define which objects can be entered as position-related substitutes in *Administration of Organizational Management* [Ext.].

Features

Who is involved?

Substitution always involves two users:
- One user specifies a substitute: User B
- The other user (the substitute) 'adopts' the substitution: User A

The substitute can process “foreign” work items for the duration of the substitution. It is irrelevant whether they are assigned to the underlying single-step tasks as a possible agent.

How does substitution work?

Substitution works in two ways:

1. User A adopts substitution for user B and for the duration of the substitution sees only the work items seen previously by B in their workflow inbox.

   User B must have entered user A as their substitute for a particular period without activating the substitution. During this period, A can adopt substitution for B at any time without having to confer with B.

   Instead of their own worklist, user A is displayed user B's worklist. B's name is in the column Substitution for in the worklist, as long as this column is included in the current configuration of B's Business Workplace.

2. User A automatically sees not only the work items previously seen by employee B, but also their own work items in their Business Workplace. This also applies to all work items generated for B in the future ("automatic forwarding").

   User B must enter user A as substitute and activate the substitution. No further action on the part of user A is required for this kind of substitution.

   A can continue working as usual. They see a Business Workplace to which B's work items are added dynamically. A can recognize these work items by the fact that B's name is in the column Substitution for, as long as this column is included in the current configuration.

In both cases, user A can perform operations on these "foreign" work items within the scope of the substitute profile assigned to them by B. It is irrelevant whether A is assigned to the underlying single-step tasks as a possible agent.
User B can continue working without any restrictions in both cases.

**Activities**

You can access substitute maintenance in the Business Workplace [Page 117] by choosing Settings → Workflow settings. For information on the individual functions, refer to Maintaining and Activating Substitutes [Page 150]
Maintaining and Activating Substitutes

Maintaining substitutes

1. In the Business Workplace [Page 117], choose Settings → Workflow settings → Maintain substitute.

   The Maintain substitute dialog box appears.

   To facilitate maintenance of the substitution, the Personal substitutes entry and the positions you occupy are displayed in the hierarchy on the Maintain substitutes screen.

   You specify your substitute either as a personal substitute or as a position-related substitute.

   - Personal substitute
     A personal substitute can see and execute all your work items, including those assigned to you via a personal agent assignment.
     You can only specify one other user as a personal substitute.

   - Position-related substitute
     A position-related substitute can only see and execute the work items you have received on the basis of agent assignment at the level of position, job or organizational unit.
     You can enter another position or a user as a position-related substitute.

2. Position the cursor either on the entry Personal substitutes or on the relevant position, and select Create substitute.

   You can maintain existing entries by double-clicking on the relevant entry.

   If you want to maintain a position-related substitution, decide whether you want another position or another user as a substitute. Select either position or user as the substitute type and specify the number or the user name of the substitute.

3. Specify the validity period for the substitution on the detail screen for substitution.

   Only within this period can the substitute adopt the substitution.

4. Specify a substitute profile in the dialog box Detail screen substitution.

   Irrespective of whether you have created your substitute as a personal or position-related substitute, you can limit the scope of the work items displayed to your substitute by specifying a substitute profile.

5. Select the field Substitution active if applicable.

   You must activate the substitution if you want work items to be visible for the substitute automatically from now on. If you do not activate the substitution, the substitute must adopt the substitution explicitly to see your work items.

6. Save your entries and exit substitute maintenance.
Activating substitutes

1. In the Business Workplace, choose Settings → Workflow settings → Activate substitute.
   
   The Activate substitute dialog box appears.

2. Select the substitutes that you want to activate, and choose the function Activate.

Deactivating substitutes

1. In the Business Workplace, choose Settings → Workflow settings → Activate substitute.

   The Activate substitute dialog box appears.

2. Select the substitutes that you want to deactivate, and choose the function Deactivate.

Adopting substitution

1. In the Business Workplace, choose Settings → Workflow settings → Adopt substitution.

   The Choose substitution dialog box appears.

2. Select the user(s) for which you want to adopt substitution.

3. Exit the dialog box.

Ending substitution

1. In the Business Workplace, choose Settings → Workflow settings → End substitution.

   The substitution is ended.
Views

Use
The Business Workplace [Page 117] provides various views on the work items displayed in the workflow inbox.

Using an appropriate view, a superior can "see" and process the work items of their employees.

Choosing a particular view also gives you the opportunity to see work items of other users in your workflow inbox and process them with full functionality, although the underlying tasks are not organizationally assigned to you.

Prerequisites
Views only require action by an employee: This employee chooses a view from a catalog of defined views. The employee must have the authorization required to choose a particular view.

Authorizations
To choose a particular view, you require a corresponding authorization based on authorization object S_WF_LVIEW.

To maintain a particular view, you must have the relevant authorization. This is an authorization based on the authorization object S_TABU_DIS to maintain tables for authorization group SWES.

Features
Views are always based on an evaluation path [Ext.] starting from the employee who wishes to adopt a view and leading to the employees whose inboxes could be viewed. The employee adopts a view by selecting another employee from the result list of the evaluation.

Activities
The activities associated with this function include:

- Adopting and Exiting Views [Page 154]
- Maintaining Views [Page 153]
Maintaining Views

Prerequisites

A view is always based on an evaluation path. This evaluation path describes which relationships are traced from the user who wants to adopt the view to the users whose Business Workplaces can be viewed.

You can use one of the evaluation paths available in the system. If there are no suitable evaluation paths, you can define an evaluation path of your own.

⚠️

Different views can only be maintained as a customer setting.

Procedure

1. To call table maintenance for views, choose Tools → Business Workflow → Development → Definition tools → Worklist client → Maintain views.

   This displays the screen Change View "View for Maintaining Views": Overview".

   Maintaining views is an activity that is described in the Implementation Guide and can be performed in Customizing.

2. Create a new view. To do this, choose the function New entries.

3. Assign a unique name to the view.

4. Specify an evaluation path.

5. Describe the view with a long text.

6. Specify a start evaluation path.

   This selection is optional. The start evaluation path is used to get an initial selection of objects, which is then evaluated further via the first evaluation path.

7. Select Save.
Adopting and Exiting Views

Procedure

Adopting views

1. To adopt a view as the standard view (= view on your own work items), choose Settings → Workflow settings → Adopt view in the Business Workplace.

   You are now on the dialog box View: Choose Agent. Only the views for which you have an authorization are available.

2. Choose a view.

   On the basis of the evaluation path defined for the view, the system selects the positions, organizational units or users connected to you.

3. From the result list of this selection, choose the object whose workflow inbox you want to view.

Exiting views

A view is only active while the Business Workplace is displayed. The next time you call the Business Workplace, you are asked if you wish to adopt the view previously set.

To return to the standard view when working in the workflow inbox of the Business Workplace, choose Settings → Workflow settings → Exit view.
Dynamic Columns for the Business Workplace

Use
Up to 6 columns in the workflow inbox of the Business Workplace [Page 117] can be filled on a task-specific basis with contents that are determined dynamically at runtime.

The standard functions for filtering, sorting, and grouping are available for these columns.

Please compare with Selectable Columns for the Business Workplace [Page 156].

Features
If you want to include one of the “dynamic columns” into the workflow inbox display, you must specify an element from the task container for each task, from which the content of the column is established at runtime.

Work items that belong to different tasks are then also displayed with different information. Work items that belong to tasks for which this functionality is not used are displayed with a blank entry.

Activities
The column contents are maintained via Tools → Business Workflow → Development → Definition tools → Worklist client → Dynamic columns for worklist.

You can also define the column headings. These headings are displayed if all of the work items displayed in the Business Workplace refer to the same task.
**Selectable Columns for the Business Workplace: Workflow**

The columns displayed essentially determine the appearance and information content of the workflow inbox of the Business Workplace. Detailed knowledge of the columns is also required to make full use of the filter and grouping criteria.

You can determine the selection of columns via display variants. The following columns are available:

<table>
<thead>
<tr>
<th>Column</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work item is executable</td>
<td>Indicator denoting that the work item [Page 120] is executable. ().</td>
</tr>
<tr>
<td>Work item title</td>
<td>Title of work item.</td>
</tr>
<tr>
<td>Status indicator</td>
<td>Status of work item. In symbol form.</td>
</tr>
<tr>
<td>Creation date</td>
<td>Date when the work item was created with the status ready or waiting for the first time. A work item is only created with status waiting if a requested start was declared for the work item and the work item is created before the requested start.</td>
</tr>
<tr>
<td>Creation time</td>
<td>Creation time of a work item.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority of the work item.</td>
</tr>
<tr>
<td>Attachments exist</td>
<td>Attachments are shown with the symbol.</td>
</tr>
<tr>
<td>End of processing must be confirmed</td>
<td>Indicator denoting that the end of processing must be confirmed explicitly. ()</td>
</tr>
<tr>
<td>Work item overdue</td>
<td>Indicator denoting that a deadline has been missed for the work item. ()</td>
</tr>
<tr>
<td>ID</td>
<td>Unique number of a work item, which is assigned internally by the system.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of work item. In abbreviation form.</td>
</tr>
<tr>
<td>Task</td>
<td>Identification for the task represented by the work item (for example TS00008323).</td>
</tr>
<tr>
<td>Technical status</td>
<td>Status of work item. Technical name.</td>
</tr>
</tbody>
</table>
### Selectable Columns for the Business Workplace: Workflow

<table>
<thead>
<tr>
<th><strong>Work item type</strong></th>
<th>Type of work item. Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Task name</strong></td>
<td>Name of task</td>
</tr>
<tr>
<td><strong>Work item status text</strong></td>
<td>Status of work item. Name</td>
</tr>
<tr>
<td><strong>Deadline status</strong></td>
<td>The deadline status specifies whether one of the deadlines has been missed. The possible values in this column are therefore:</td>
</tr>
<tr>
<td></td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td>• Latest start</td>
</tr>
<tr>
<td></td>
<td>• Requested end</td>
</tr>
<tr>
<td></td>
<td>• Latest end</td>
</tr>
<tr>
<td></td>
<td>• Other</td>
</tr>
<tr>
<td><strong>Current agent</strong></td>
<td>Name of the user who last reserved or processed the work item.</td>
</tr>
<tr>
<td><strong>Latest end date</strong></td>
<td>Latest end of work item. The end is reached when the work item assumes the status <strong>completed</strong>.</td>
</tr>
<tr>
<td><strong>Latest end time</strong></td>
<td>Latest end time of a work item</td>
</tr>
<tr>
<td><strong>Forwarder</strong></td>
<td>Name of the party who forwarded the work item.</td>
</tr>
<tr>
<td><strong>Substitution for</strong></td>
<td>Name of the substituted party whose work item is displayed</td>
</tr>
<tr>
<td><strong>Work item content</strong></td>
<td>Column in which the default attribute of the object referenced in the container element <strong>_WI_Object_ID</strong> is displayed.</td>
</tr>
<tr>
<td><strong>Group object</strong></td>
<td>Column in which the default attribute of the object referenced in the container element <strong>_WI_Group_ID</strong> is displayed.</td>
</tr>
<tr>
<td><strong>Execution can be rejected</strong></td>
<td>Indicator denoting whether execution of the work item can be rejected (🚫).</td>
</tr>
<tr>
<td><strong>Dynamic columns</strong></td>
<td>Refer to Dynamic Columns for the Business Workplace [Page 155].</td>
</tr>
</tbody>
</table>
Workflow Inbox

Use

The worklist of the user currently logged on to the Business Workplace is displayed in the workflow inbox.

Integration

As is the case for the workflow resubmissions [Page 198] and the workflow outbox [Page 196], the workflow inbox is an integral part of the Business Workplace.

Features

Views in the workflow inbox

A user's worklist can be displayed as an overview or according to the following grouping criteria:

<table>
<thead>
<tr>
<th>Grouped according to task</th>
<th>The work items are grouped according to the tasks to which they belong.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grouped according to content</td>
<td>The work items are grouped according to the object instances to which they belong.</td>
</tr>
<tr>
<td>Grouped according to content type</td>
<td>The work items are grouped according to the object types to which they belong.</td>
</tr>
<tr>
<td>Grouped according to sort key</td>
<td>The work items are grouped according to sort keys. Please refer to Grouping According to Sort Keys [Page 187].</td>
</tr>
</tbody>
</table>

You can also choose from the following views:

- Overdue entries
- Deadline messages
- Incorrect entries

Workflow Functions

The screen area in which the worklist is displayed has a toolbar containing the workflow functions and functions for configuring the list. For information about these functions, refer to the documentation on the ABAP List Viewer [Ext.].

The workflow functions can be accessed in the Business Workplace via the toolbar or the relevant context menu (right-hand mouse button). The following functions can be executed on work items:

- **Update**
  
  This function updates the worklist [Ext.] of the user currently logged on to the Business Workplace.

- **Execute**
  
  To be executed, a work item must have either the status ready or the status in process.
When a dialog work item [Ext.] is executed, the object method to which the single-step task for this work item refers is carried out.

When a missed deadline work item [Ext.] is executed, the most important information on the monitored work item is displayed.

- **Display work item**
  
  This function goes directly to the work item display [Page 161].

- **Reserve** (dialog work items only)
  
  This reserves a work item for execution by the end user in question. The work item must have the status *ready*. This work item is then no longer visible to the other recipients who could previously see it in status *ready*. The status of the work item changes from *ready* to *reserved*.

- **Replace** (dialog work items only)
  
  Replacing releases the work item from its reserved status and makes it available again to all of the original recipients. The status of the work item changes from *reserved* back to *ready*. The status of the work item must be *reserved* before it can be replaced.

- **Forward**
  
  Forwarding [Page 190] passes a work item on to another employee for execution.

- **Resubmit**
  
  If a user chooses this function, the selected work item is placed in workflow resubmissions [Page 198].

- **Display workflow log**
  
  This function displays the workflow log [Page 173].

- **Manage attachments** ... (Functions for attachment management [Page 183], dialog work items only)
  
  - Display attachments
  - Create attachments
  - Change attachments
  - Delete attachments

- **More functions**
  
  - Set to ‘Done’ [Page 195]
  - Reject execution [Page 185]
  - Execute together [Page 186]
  - Change priority [Page 188]
  - Send mail [Page 179]
  - Change work item [Page 193]

- **Environment**
Workflow Inbox

- Display objects in workflow (dialog work items only)
- Display workflow relationships [Page 191]
- Start Workflow [Ext.]
- Create link [Page 189]

Activities

You can access the workflow inbox in the tree on the left in the Business Workplace via Workplace → Inbox.
Work Item Display: Standard View

Use
The objective of the work item display is to display all the information and activities that are relevant to an end user in the environment of the displayed work item in a clear and concise manner.

The work item display supports the agent not only in the processing of the current work item but also in the compilation of an activity list, which then functions as the agent's personal worklist.

Integration
A technical work item display [Page 170] is available for work items of all other types. You can make this technical work item display standard for dialog work items as well.

The standard view of the work item display can be shown with or without ActiveX.

You make this setting for the work item display variant in your personal workflow settings [Page 145].

Features
The work item display is primarily designed for displaying dialog work items [Ext.]. It contains details about deadlines, statuses, agents, attachments and linked objects for a work item. The work item display also enables an end user - providing they have the relevant authorization - to compile an activity list as their personal worklist.

The work item display has three tab pages (Basic data, Activities, and Available objects).

- Tab page Basic data [Page 164]
- Tab page Activities [Page 166]
- Tab page Available objects [Page 168]
- Customer-defined tab page for work item display [Ext.]

You can define another tab page, which is then displayed as the first tab page when the work item display is called.

Application toolbar functions

- ![ Execute ]

To be executed, a work item must have either the status ready or the status in process.

When a dialog work item is executed, the object method to which the single-step task for this work item refers is carried out.

When missed deadline work items [Ext.] are executed, the most important information on the monitored work item is displayed.

- ![ Display last message ]

The return code that was returned to the workflow system after the object method was executed can be retrieved for processed work items using the Messages function.

- ![ Forward ]
Work Item Display: Standard View

- **Forwarding [Page 190]** passes a work item on to another employee for execution.

- **Resubmit**
  If a user chooses this function, the selected work item is placed in workflow resubmissions [Page 198].

- **Change priority**
  Refer to Changing Priorities [Page 188].

- **Change deadlines**
  Refer to Changing Deadlines [Page 182].

- **Display/create/change attachments**
  For attachments, refer to Attachment Management [Page 183].

- **Reserve** (dialog work items only)
  This reserves a work item for execution by the end user in question. The work item must have the status **ready**. This work item is then no longer visible to the other recipients who could previously see it in status **ready**. The status of the work item changes from **ready** to **reserved**.

- **Replace** (dialog work items only)
  Replacing releases the work item from its reserved status and makes it available again to all of the original recipients. The status of the work item changes from **reserved** back to **ready**. The status of the work item must be **reserved** before it can be replaced.

- **Mail**
  Refer to Send Mail [Page 179].

- **Display workflow log**
  This function displays the workflow log [Page 173].

- **Display graphical workflow log**
  This function displays the graphical workflow log [Page 177].

**Additional functions in the menus**

**Work Item**

- **End resubmission**
  The work item is put back into the workflow inbox. It has the status **reserved**.

  - **Create link [Page 189]**
  - **Reject execution [Page 185]**
  - **Set to 'Done' [Page 195]**

**Goto**

- **Methods**
You can use this function to execute the defined secondary methods [Ext.] of the work item displayed from the work item display.

A prerequisite for this is that the work item represents an activity that is part of a workflow. At least one secondary method must be defined for this activity.

- **Workflow description**
  The description text of the superordinate multistep task, the “process description”, is displayed.
  The work item must be part of a workflow and a description text must be maintained for the workflow.

- **Technical work item display [Page 170]**

**Extras**

- **Displaying tasks**
  This function can be used to display the definition of the task represented by the work item. Refer to Definition of a Single-Step Task [Ext.] and Definition of a Multistep Task [Ext.].

- **Technical data**
  Technical data about the work item, for example its ID, its texts or the ID of the superordinate work items are displayed.

- **Organizational Assignment [Page 147]**
- **Displaying Agents [Page 181]**

**Activities**

You can access the work item display by:

- Selecting a work item in the Business Workplace and choosing 🍀.
- Double-clicking one of the entries for a step in the workflow log.
- Selecting an entry that does not represent a workflow in the work item selection [Ext.] hit list displayed. (If you choose a workflow, the workflow log is displayed.)
Tab Page Basic Data

Use

The information on this tab page of the work item display [Page 161] is mostly self-explanatory. Except for the priority, you cannot make any changes here.

Features

Deadlines

These are the deadlines monitored by the runtime system. (Deadlines that are not set are displayed without a date.)

- Start by (latest start)
- End by (latest end)

Depending on whether the work item represents a step in the workflow or a task, the deadlines were either specified when this step was defined in the workflow definition or when the task was started online.

To display all of the deadlines of the work item, choose Work item → Deadlines.

Further Information

- Forwarded by
  
  If the work item was forwarded to you, the name of the forwarder is entered here.

- Priority
  
  The priority of a work item is derived from the definition of this step in the workflow definition. The priority is used as a sort criterion for positioning the work item in the Business Workplace.

  The priority can be changed here.

- Status
  
  The current processing status is expressed by the work item status [Page 123].

- Creation date (created on) and processing date (processed from)
  
  These are the actual dates and times (when the work item was created and when processing was started).

Using the Messages function, you can display the return codes for processed work items, which were returned to the workflow system after execution of the object method.

Work Item Description

A description of the work item to be executed is provided at the bottom left of this tab page.

The task description is entered in the task definition. It is used for information purposes and generally contains instructions and recommendations on processing the work item displayed.
Attachments

The titles of all the attachments added to this work item or, if the work item is part of a workflow, to the preceding work items are shown in the lower right of this tab page.
Tab Page Activities

Use

The Activities (not yet processed) list contains all the activities that are relevant for processing this work item.

The tab page Activities is part of the work item display [Page 161].

Features

The work item text of the task represented by the work item is generally at the start of the list ("main activity"). Once this activity has been processed (and completion of processing has been confirmed, if necessary), the status of the work item changes to completed. No other actions can then be carried out in the work item display.

Activities

You can extend the activity list and in this way create a worklist. The activities added represent your "personal worklist" as end user (agent).

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Done</td>
<td>An activity selected from the list is reported to be done. This functionality cannot be executed on the leading activity (first line) of this work item. The agent is responsible for reporting that an activity is done. The actual processing is not checked.</td>
</tr>
<tr>
<td>✔ Execute</td>
<td>An activity selected from the list is executed. The main activity (first line) of the work item can also be executed via the menu path Work item → Execute.</td>
</tr>
<tr>
<td>Create</td>
<td>Another activity is added to the list. This activity can entail: • Executing a method on an existing object (created invoice, created material, etc.) • Creating a new object (text, etc.) When you create an activity, you are given step-by-step support in dialog by a &quot;wizard&quot;.</td>
</tr>
<tr>
<td>Delete</td>
<td>An activity is deleted from the list.</td>
</tr>
</tbody>
</table>

Scrolling in the activity list: The activity list contains extensive information on each activity, which you can view by scrolling to the right. This information includes the following:

- Description
- Creator of the activity with date and time
- Actual agent of the activity with date and time
• Method and object type
Tab Page Available Objects

Use

All objects that are related to the work item are displayed in the list of available objects. These objects are stored in container elements of the task container as object references. You can display these objects or add new objects to the container element.

There are:

- **Ad hoc objects**
  - Objects added to a work item in this or one of the preceding steps of the workflow (container element _Adhoc_Objects of the task container)

- **Attachment objects**
  - Documents added to a work item in this or one of the preceding steps of the workflow (container element _Attach_Objects of the task container).

- **Process objects**
  - The object currently being processed (container element _WI_Object_ID of the task container)
  - The object added for grouping purposes (container element _WI_Group_ID of the task container)
  - Objects that are referenced in other elements of the task container

The tab page Available objects is part of the work item display [Page 161].

Features

Displaying objects with their default attributes

Each object referenced in the work item container is displayed with its default attribute [Ext.]. The default method [Ext.] of each object can be executed upon request. If no default attribute was defined for the object type, the key fields of the object are displayed.

Adding objects

You can extend and process the list of objects. The main purpose of this is to make the relevant information available to the agents of the subsequent steps in the workflow as well.

Only object types [Ext.] that support the IFFIND interface can be selected. You identify an actual object [Ext.] of this type by specifying its key fields [Ext.].

Activities

To execute the functions displayed, proceed as follows:
Tab Page Available Objects

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>An object is added to the list. When you add an object, you are given step-by-step support in dialog by a &quot;wizard&quot;.</td>
</tr>
<tr>
<td>Display</td>
<td>The default method of an object selected from the list is executed.</td>
</tr>
<tr>
<td>Remove</td>
<td>An object is deleted from the list.</td>
</tr>
</tbody>
</table>
Work Item Display: Technical View

Use
The technical work item display shows all information from the environment of the work item displayed.

The technical work item display is intended in particular for workflow system administrators.

The data is always formatted and displayed in a similar way irrespective of the work item type. You should note the work item type shown on the screen.

Features
General

Work item information
- Information derived from the definition of the relevant task: Work item type, work item text, way in which processing is completed.
- Status of the work item as current processing information
- Actual agent (available after dialog work items have been executed).

In the case of processed work items, the Messages function can be used to display the return codes returned to the workflow system after execution of the object method.

Deadline data
Here you can find the current dates/times [Ext.] (creation date/time of work item and date/time processing started and ended) as well as the deadlines that are monitored by the runtime system (requested and latest start and end deadlines).

A monitored deadline shown with red is in the past. If the symbol is displayed as well, a defined action was triggered.

Description
This description displayed here is taken from the task definition. It is used to inform the selected agents and contains instructions and recommendations on processing the work item displayed.

If you have selected a work item using the work item selection [Ext.] or the workflow outbox rather than your workflow inbox, you can execute it provided you are one of the possible agents.

You do not need to be one of the recipients in this case.

Additional functions
As well as the functions available in the standard view of the work item display [Page 161], the following additional functions are also available:
• **Display/create/delete object**

Each object referenced in the work item container is displayed with its default attribute [Ext.]. The default method [Ext.] of each object can be executed upon request. If no default attribute is defined for the object type, the key fields of the object are displayed instead.

You can extend and process the list of objects. The main purpose of this is to make the relevant information available to the agents of the subsequent steps in the workflow as well.

Only object types [Ext.] that support the IFFIND interface can be selected. You identify an actual object [Ext.] of this type by specifying its key fields [Ext.].

• **Type-specific data**

Type-specific data only applies to work queue and wait step work items.

For work queue work items (type A), the objects and tasks contained in the work queue are listed.

For wait step work items (type E), the number of events expected (information taken from the workflow definition) and the number of events that have already occurred are specified.

• **Execute for testing**

In order to make it possible to check the runtime system's program execution (work item manager and workflow manager) in debugging mode after execution of an object method, internal communication within the workflow system cannot take place asynchronously. To achieve this, execute the work item for test purposes. Enter /h in the command field first to go to the debugging mode.

• **Monitored work item**

The work item (type F or W) whose deadlines or completion are monitored by the workflow system is displayed.

This function is only possible and active from missed deadline work items [Ext.]. This function displays the work item. Full display functionality, including all navigation and change options, is also available here for this work item.

• **Instance linkage**

You go to the relevant line of the instance linkage table, in which the expected event (identified by object type and event ID) and the object (identified by object reference) are specified.

This function is only possible and active for those work items that wait for an event that completes them. This may apply to dialog work items (type W) and background work items (type B). This does apply to wait step work items (type E).

• **Container**

This function displays the content of the task container.

• **Change work item [Page 193]**
Activities

You can go to the technical view of the work item display by choosing Goto → Technical work item display in the work item display or by having this display variant as a presetting in your personal workflow settings [Page 145].
Workflow Log: Standard View

Use

The workflow log [Ext.] enables you to format all the information that is generated or collected during the execution of one active business process in one central location.

The standard view described here is intended, in particular, for agents and process controllers who want to get an overview of the steps processed so far.

Prerequisites

To use the view described here, you must have set a view with ActiveX in your personal workflow settings [Page 145].

Integration

Other options for displaying the workflow log are:

- Workflow Log: Technical View [Page 175]
- Graphical Workflow Log [Page 177]

Features

Application toolbar functions

The following functions are available on the application toolbar:

- Update
- List with technical details
  
  This function takes you to the technical view of the workflow log.

- Graphical workflow log

- Personal workflow settings
  
  You can use this function to maintain your personal workflow settings.

Tab pages

The system shows the various views on the workflow log on different tab pages.

Tab page Workflow Chronicle (what was processed when?)

The tab page Workflow Chronicle shows a hierarchical display of all steps in the workflow, which have been processed so far or are due to be processed. If the workflow has a subworkflow structure, the subworkflows are also displayed.

The Details function (symbol) lists the following information about each step in the lower part of the screen:

- Who carried out what detailed actions for these work items and with what results.
- When these actions were carried out.
Workflow Log: Standard View

- Which objects were involved.

The *Agents* function (symbol) displays the selected and possible agents of a step.

The *Graphic* function (symbol) displays the graphical workflow log.

**Tab page Workflow Agents (Roles, who processed what?)**

The tab page *Workflow Agents* shows the employees involved in this workflow up to now. The following is displayed for each employee:

- What action was carried out in what step.
- When this action was carried out.
- Which objects were involved.

This view shows how an employee was involved in the execution of a workflow.

**Tab page Workflow Objects (Objects, what was processed?)**

The tab page *Workflow Objects* lists the objects related to the workflow or addressed up to now in the execution of the workflow. These objects include:

- The “leading” object of the workflow.
- Any attachments and objects added in the individual steps of the workflow.

The following is displayed for each object:

- Who carried out what detailed action for what task.
- When this action was carried out.

This view shows what information was generated and processed, and how.

**Information at the click of a mouse**

You can view all the information provided in the workflow log using the mouse.

You can also go to the work item display [Page 161] for each dialog step. You can display address data for agents as well as the contents of work item attachments or the result of actions that have been executed.

**Activities**

You can access the workflow log from the work item display or the Business Workplace [Page 117] via the icon.
Workflow Log: Technical View

Use

The workflow log [Ext.] enables you to format all the information that is generated or collected during the execution of one active business process in one central location.

The view described here, in particular the technical view described below, is intended for workflow system administrators.

Integration

Other options for displaying the workflow log are:

- Workflow Log: Standard View [Page 173]
- Graphical Workflow Log [Page 177]

Prerequisites

To use the view described here, you must have set the view without ActiveX in your personal workflow settings [Page 145].

If you have chosen technical view in your settings, the standard view with technical details is displayed (see below). Otherwise, the two workflow log views are identical.

Features

The system uses a two-level, hierarchical list from the ABAP List Viewer [Ext.] to display the various workflow log views. You can adapt the appearance of the list to suit your requirements using display variants.

By single-clicking on an entry or a symbol, you can then branch to the workflow container or the work item display [Page 161], for example.

The following views are available:

- **Workflow chronicle**
  The first level of the Workflow chronicle view shows all the workflow steps that have already been processed or are currently pending. If the workflow has a subworkflow structure, the subworkflows are also displayed.

  The second level (detail view) shows the following for each step:
  
  - Who carried out what detailed actions for these work items and with what results.
  - When these actions were carried out.
  - Which objects were involved.

  This view is used to determine what activities were carried out in a workflow and in what order.

- **Workflow agents**
  The first level of the Workflow agents view shows the employees involved in this workflow up to now.
Workflow Log: Technical View

The second level (detail view) shows the following for each employee:

- What action was carried out in what step.
- When this action was carried out.
- Which objects were involved.

This view shows how an employee was involved in the execution of a workflow.

- **Workflow objects**
  
  The first level of the *Workflow objects* view lists the objects that are related to the workflow or that have been addressed up to now during execution of the workflow. These objects include:

  - The “leading” object of the workflow.
  - Attachments and objects added in the individual workflow steps.

  The second level shows the following for each object:

  - Who carried out what detailed action for what task.
  - When this action was carried out.

  This view shows what information was generated and processed, and how.

- **... With technical details (technical view)**
  
  The *technical view* shows technical control information for execution of a workflow, as required by workflow administrators, for instance.

  Based on the workflow chronicle, the *technical view* shows technical nodes and control structures, and makes additional data available, such as container elements ( ), employee data ( ), and workflow data ( ).

  The status of the work item is also displayed.

- **... With subworkflow structure**
  
  Here you can choose whether or not to display any subworkflows and their structure.

- **... With error indicators**
  
  If you activate the function *View with error indicators*, errors are marked in the log with the symbol. The standard indicator is .

**Activities**

You can access the workflow log from the workflow inbox of the *Business Workplace* via the symbol, or using the *context menu* (click the right-hand mouse button).

You can maintain the individual views (such as the technical view) within the workflow log via *Views* or *Views → Other views*.
Graphical Workflow Log

Use
The workflow log [Ext.] enables you to format all the information that is generated or collected during the execution of one active business process in one central location.

Integration
Other options for displaying the workflow log are:

- Workflow Log: Technical View [Page 175]
- Workflow Log: Standard View [Page 173]

Features
The graphical workflow log adds to the textual information. The workflow steps already processed are shown with in a graphical representation of the workflow definition. You can see at a glance which “route” a workflow instance has taken and which activities are processed in parallel to your own within a business process. Unlike the text version of the workflow log, the graphical workflow log also shows the subsequent flow of a workflow instance.

The screen of the graphical workflow log is split into the workflow area (left) and the overview area (right).

The following functions are available:

- Refresh
  Refreshes the display.

- Display node
  If you select an executed step and choose this function, the system goes to the technical work item display.
  If the step has not yet been executed, the relevant activity is displayed.

- Align...
  The workflow is centered within the workflow area.

- Zoom in
  The size of the workflow is increased within the workflow area.

- Zoom out
  The size of the workflow is decreased within the workflow area.

- Complete view
  The whole of the workflow is shown within the workflow area.

For other functions, refer to the documentation on the Workflow Builder [Ext.].
Activities

You can call the graphical workflow log from within the workflow log [Page 173] via ➔.
Send Mail

Purpose

You want to send a mail to another user in connection with a work item that requires processing. The work item being processed is therefore also to be made accessible to this user for information purposes.

The Send mail function enables you to send mails to any recipients with a text which can be entered freely. These mails are automatically linked to your work item in such a way that when the mail is executed by the recipient the work item is displayed.

Process Flow

Procedure as sender of mail

1. In the Business Workplace’s workflow inbox, position the cursor on a work item and choose Other functions → Send mail.
   
   If you are already in the work item display, choose Work item → Send mail.

2. Enter the text of the mail.

3. Send the mail to any recipients who are available as mail addressees
   
   The mail text is added to the work item as an attachment. The work item remains in your Business Workplace with the same status.

You can still complete the work item despite the fact that you have sent a mail. Since this makes the mail which has been sent superfluous, the recipient of the mail receives a second mail informing him/her that the (first) mail no longer needs to be dealt with.

Reply ends resubmission

Optional: If you do not want to process the work item until the mail has been replied to, define a resubmission for the work item. To do this, position the cursor on the entry, choose Resubmit and enter a date in the future.

The work item is resubmitted irrespective of this date and appears in your workflow inbox when the reply to the mail is received.

Procedure as recipient of a mail

You receive a mail that can be executed.

1. Read the mail.

2. Execute the mail, if applicable. The work item referred to by the sender in their mail is displayed. For further information on the object to be processed, choose Goto → Object to display the default attribute or execute the default method (generally Display) for the processed object.

   You can execute this work item if you are one of the possible agents of this task.

3. Reply to the mail. To do this, choose Document → Reply or Document → Reply w/reference when the mail is displayed. Then enter your reply and save your entries.
Send Mail

4. Choose Document → Send. On the send screen, the work item to which the mail referred is entered as the "recipient". Do not change this entry. Send the reply to the proposed recipient.

Result

The reply sent ends a resubmission which may have been defined for the recipient work item. This work item is appended as an (additional) attachment and can be read as such by the original user and taken into account.
Display Agents

Use

This function displays information about the agents of the work item.

Features

The system displays the following agents for the work item:

- **Recipient [Ext.]**
- **Possible agents [Ext.]**
- **Excluded agents [Ext.]**

You can choose a compressed display - containing only the user names (*users only* function) - or a complete display with additional information on the relationships used by the system to determine the agents (*overall view* function). You can also display the organizational assignment of each user.

Note that this information is only available for work items of types for which an agent is logical and necessary.

Activities

You can display the agents from the [work item display][Page 161] by choosing *Goto → Agents →* ...

---

[Page 161]
Changing Deadlines

Use
You use this function if you want to change the deadlines for a work item at workflow runtime. This dialog box displays all the deadlines of work item processing.

Please also refer to Current Dates/Times of a Work Item [Ext.].

Features
Depending on whether the work item represents a step in the workflow or a single-step task, the deadlines were either specified when this step was defined in the workflow definition or when the single-step task was started in dialog.

The dialog box is split into the following sections:

Deadlines
- Start by (latest start)
- End by (latest end)

Planned deadlines
- Start by (requested start)
- End by (requested end)

A monitored deadline shown in blue is in the past. If 🔴 is also displayed, the appropriate action has been initiated. This generally involves informing the deadline recipient.

Actual dates/times
- Created on: Creation date/time of the work item
  (Technically: The work item is created with the status ready or - if the requested start date has not yet been reached - with the status waiting).
- Processed from: Start of processing
  (Technically: Transition of the work item to the status in process).
- Completed on: End of processing or date when set to ‘done’.
  (Technically: Transition of the work item to the status completed.)

Activities
To execute this function, choose 🏅 in the work item display [Page 161].
Attachment Management

Use

One or more attachments can be assigned to each work item that appears in the Business Workplace's workflow inbox.

Attachments are documents written either with a SAPscript editor (document classes RAW, SCR) or with a PC application (document classes DOC, URL, PPT, XLS, PDF, ...) and then imported. You can enter new documents as attachments or create attachments from existing files.

Features

General

The attachment is automatically

- Added to the work item container
- Added to the container of the superordinate workflow
- Added to the containers of the subsequent work items in the workflow

You can define default documents for the individual document classes. For further information, refer to Default Documents [Page 44].

Attachments can be displayed by the recipients of the subsequent steps. But they cannot be changed and, therefore, have a document character.

A superior who is to make a decision on releasing a budget can enter an attachment justifying their decision. The selected agents of the subsequent steps can display this attachment.

If a work item has attachments, this is indicated by a symbol in the Attachments column in the Business Workplace. You can also execute the function for processing an attachment by double-clicking in this column (column header AT). If an attachment already exists, it is displayed.

If a work item has attachments, this is indicated by the symbol in the work item display.

Functions on attachments

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Displays the attachment selected in the dialog box Existing attachments.</td>
</tr>
<tr>
<td>Create</td>
<td>Creates a new attachment.</td>
</tr>
<tr>
<td></td>
<td>If you want to import an existing document from your PC to the attachment, choose Import.</td>
</tr>
<tr>
<td>Change</td>
<td>Displays the selection of Changeable attachments.</td>
</tr>
<tr>
<td>Delete</td>
<td>Displays the selection of Deletable attachments.</td>
</tr>
</tbody>
</table>
Attachment Management

Activities

You can access attachment maintenance in the Business Workplace by choosing or the relevant context menu (right-hand mouse button).
Reject Execution

Use
You can use this function if you need to reject execution of a work item for business or technical reasons. This function is only available for work items of type W.

The table entry to be processed already exists or the material whose master data is to be changed is no longer used.

Prerequisites
This function is only available if the property processing rejectable has been selected for the related activity in the workflow definition.

Features
Processing of the work item is terminated with the reject execution function. The subsequent steps defined in the workflow definition are executed.

Do not use this function if you do not want to or cannot process the work item for personal reasons (not responsible, not competent). In this case, replace the reserved work item or forward it.

Activities
You can access this function in the Business Workplace [Page 117] by choosing Other functions or the work item display (Work item → Other functions → Reject processing).
Execute Together

Use
You can select various work items and then execute them together. This function is only available for work items of type W.

The work items do not necessarily have to belong to the same workflow.

Prerequisites
The work items must refer to the same single-step task.
For information about other prerequisites for this function, in particular with regard to the underlying method, refer to Creating an "Execute Together" Method [Ext.].

Features
Only the first of the selected work items is proposed for execution. The entries you make here also apply to the other work items to be executed together.

Activities
Select the work items that you want to execute together. Then choose Execute together via Other functions... in the Business Workplace [Page 117].
Grouping According to Sort Key

Use

Each work item carries the two container elements _WI_Object_ID and _WI_Group_ID in its container. Both elements have been defined to hold an object reference.

- The container element _WI_Object_ID automatically contains the reference to the object to be processed in the work item.
- The container element _WI_Group_ID can contain an object reference, which must be assigned to this container element in a binding or via initial value assignment.

The object reference assigned via _WI_Group_ID is generally not identical to _WI_Object_ID, but is derived from the work item execution environment. It is used to group work items that refer to different objects or object types but are nevertheless connected.

Features

Display default attributes in workflow inbox

The default attributes [Ext.] of the objects referenced in _WI_Object_ID and _WI_Group_ID are available in the Business Workplace's workflow inbox [Page 158] under the column headers Object or Group for grouping, sorting and filtering purposes.

Material master data is processed in several instances of a workflow. The container element _WI_Object_ID in the containers of the individual work items therefore always contains the reference to the object of type BUS1001 (material) to be processed.

The container element _WI_Group_ID is assigned the expression &Material.Labor& (laboratory/drawing office for material as object reference) in the relevant steps of the workflow definition. The default attribute of the laboratory is therefore available as a group.

Default methods

The default method [Ext.] of the objects referenced in _WI_Object_ID and _WI_Group_ID is executed by double-clicking in the Object or Group column.
Change Priority

Use

The priority of a work item is a measure of its urgency.

It can be used as a sort criterion for organizing the workflow inbox. This function is only available for dialog work items.

Features

End users can display and change the priority of a work item. The priority is between 1 (highest) and 9 (lowest).

The change in priority can also be passed on automatically to the superordinate workflow and then to all work items created subsequently. The Pass on priority to subsequent steps indicator must be selected for this to take effect.

If a higher priority (lower number) is defined in the workflow definition for one of the subsequent steps, it is not changed.

Activities

You can access the Change priority function in the Business Workplace by choosing Other functions...
Create Link

Use
By storing links to work items in folders [Ext.], you can organize your work effectively using a personal folder hierarchy.

Features
The work item is added to a personal or shared folder as a link.
This work item can be displayed from this folder and executed by its recipients.
Work items can have an unlimited number of links.

Activities
You can access this function in the Business Workplace [Page 117] by choosing Environment...
**Forward Work Item**

**Use**
Forwarding passes a work item on to another user for execution.

**Integration**
The range of users to whom a work item can be forwarded is determined from the task definition as follows:

<table>
<thead>
<tr>
<th>Task definition:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Task is a general task [Ext.]</td>
<td>Work item may be forwarded to all users.</td>
</tr>
<tr>
<td>The indicator General forwarding allowed is set for the task</td>
<td>Work item may be forwarded to all users.</td>
</tr>
<tr>
<td>The indicator General forwarding not allowed is set for the task</td>
<td>Work item may only be forwarded to the recipients [Ext.] of the task.</td>
</tr>
</tbody>
</table>

**Features**
The user has the following search options to select the new recipient:

- The F4 input help can be used to determine the new recipient by performing a generic search for name components.
- The structure search can be used to determine the new recipient using the graphical display of the organizational plan.

The new recipient does not have to be an actual user. (The work item can also be forwarded to an organizational unit or a job.)

**Activities**
You can access this function in the Business Workplace [Page 117] by choosing 📜.
Workflow Relationships

Use
You can use this function to establish the work items in which a particular object [Ext.] is being processed. The following work item types are taken into account:

- Dialog work items [Ext.] (type W)
- Background work items [Ext.] (type B)
- Workflow work items [Ext.] (type F)

The list displayed is purely runtime information.

Prerequisites

Authorization
You require appropriate authorization for the functions shown. This is an authorization based on the authorization object S_PROGRAM for executing a program for authorization group 'SWI_OA'.

Features
You can call the function for displaying linked workflows from several starting points.

Calling via SAP Easy Access
Two functions are available via SAP Easy Access:

- Workflows for object
  This function displays all workflows linked to a particular object (for example a specific notification of absence). You must specify this object beforehand.

- Workflows for object type
  This function displays all workflows linked to a particular object type (for example FORMABSENCE). You must specify this object type beforehand.

  You can only specify objects whose object type definition supports the interface IFFIND.

Calling from the Business Workplace
In this case, you do not specify the object. The workflow relationships are displayed for the object processed in the selected work item.

Calling as a generic object service
In this case, you do not specify the object. The workflow relationships are displayed for the object being processed.
Workflow Relationships

What is displayed?

The display of the workflow relationships has two parts. The upper part displays the workflows identified for the object or object type. The lower part displays data on the currently selected work item in the form of a simplified workflow log:

- **Steps so far**
  The workflow steps processed so far are listed under *Step name*. The steps are linked to the work item preview of the relevant work item. The current agents of the work item are listed under *Agents*. Click once to go into detailed display of the user data.

- **Information objects addressed so far**
  All the objects and attachments belonging to the workflow are displayed here. Click once to display the information objects.

Activities

<table>
<thead>
<tr>
<th>Calling…</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>… Via SAP Easy Access</td>
<td>Tools → Business Workflow → Development → Runtime Tools → Workflows For Object</td>
</tr>
<tr>
<td>… From the Business Workplace [Page 117]</td>
<td>[Display workflow relationships]</td>
</tr>
<tr>
<td>… As a generic object service</td>
<td>System → Workflow → Workflow overview</td>
</tr>
</tbody>
</table>
Change Work Item

Use
The function enables you to change information and data associated with the selected work item.

Features

Changes in the initial screen
In general, the changes that are allowed depend on the type and status of the work item. The following changes are possible:

- **Work item text**
- **Priority**
- **Deadline data**

  You can set and change deadline data for the start and end deadlines of the work item. You can only make specifications for deadlines that are still being monitored and are in the future. For example, dialog work items with the *ready* status can no longer be assigned a requested start.

Manual intervention into the processing of work items
If you are an administrator with the appropriate authorization, you can intervene manually into the processing and therefore into the process flow of a workflow. This is particularly helpful for dealing with errors. The following changes are possible:

- **Set to ‘ready’ manually**
  The work item status is changed from *waiting* to *ready*.
  The work item therefore appears in the workflow inboxes of the selected agents.

- **Complete manually**
  The work item status is changed to *completed*.
  In the case of dialog work items, this status change (together with the current work item container) is passed on to the workflow system for evaluation. If the object method to be executed is a synchronous method with a result, the possible result values are displayed for selection.

- **Replace manually**
  The status of the work item is reset to *ready*.
  The work item is therefore displayed again in the workflow inboxes of all selected agents.

- **Restart after error**
  Work items and, in particular, workflows with errors can be restarted after the errors have been corrected.
  The information written by the workflow system in a log when the error occurred is now taken into account.

- **Delete logically**
Change Work Item

The status of the work item is changed to *logically deleted*.
In the case of dialog work items, this status change is passed on to the workflow system.

**Locking/unlocking execution**
An administrator can lock or unlock the current work item for execution. To do this, you select the appropriate function from the *Edit* menu.

**Deleting deadlines**
To delete a deadline you have changed or entered and reset it to its initial values, choose *Edit → Delete deadline*.

**Changing work item containers**
Choose *Edit → Change container* to go to the editor for changing the work item container.
The contents of the container for the relevant work item are displayed. You can change the current, runtime-specific data for the particular work item.
The container may still have elements that do not currently have a value. These elements are hidden as standard. The presence of elements that are not displayed is shown by a indicator. To display these elements, choose *Edit → Show elements*.
To add more lines to container elements defined as multiline, choose *Edit → Additional line*.

**Activities**
You can access this function in the Business Workplace [Page 117] by choosing Other functions, the relevant context menu or the technical work item display [Page 170].
Set Work Item to Done

Use
This function is used by the recipient of a work item to confirm explicitly that processing of this work item has been completed. As long as explicit confirmation has not been provided, the work item has *executed* status and can be executed again or forwarded.

The status of the work item changes from *executed* → *completed*.

Prerequisites
This function is only possible on a work item if a setting was made in the definition of the associated single-step task stating that the end of processing must be confirmed explicitly.

Activities
You use this Business Workplace function if the status of the work item has been changed to *executed* by a terminating event.

In general, however, the work item is not set to *done* via the Business Workplace. This function is usually provided as a dialog box directly after a work item has been processed.

Missed deadline work items [Ext.] must always be confirmed explicitly. After execution, they remain in the status *in process* until they are set to *done*.

You can access this function in the Business Workplace [Page 117] by choosing *Other functions*. 
Workflow Outbox

Use
The workflow outbox lists the workflows started and the work items forwarded and executed by the current user.

Integration
As is the case for the workflow resubmissions [Page 198] and the workflow inbox [Page 158], the workflow outbox is an integral part of the Business Workplace.

Features
Views in the workflow outbox

Started workflows
This view shows work items for the tasks started by you as a user in dialog or by a triggering event whose event container contains your user name as \_Evt_Creator.

Work items executed by me
The work items executed by you are displayed in this view.

Forwarded work items
The work items forwarded by you are displayed in this view.

Workflow Functions
The screen area in which the worklist is displayed has a toolbar containing the workflow functions and functions for configuring the list. For information about these functions, refer to the documentation on the ABAP List Viewer [Ext.].

The following functions are available for the different workflow outbox views:

- **Update**
  You use this function to update the workflow outbox.

- **Display work item** (not in Started workflows view)
  This function goes directly to the work item display [Page 161]

- **Change agent**
  You use this function to perform an ad-hoc agent assignment [Ext.], [Page 161]

- **Display workflow log**
  This function displays the workflow log [Page 173].

- **Display attachments** (refer to attachment management [Page 183])

- **Environment**
  - Display objects in workflow (dialog work items only)
• Display workflow relationships [Page 191]
• Start Workflow [Ext.]
• Create link [Page 189]

• Change selection period
  • Today only
  • Last 7 days
  • Last 30 days
  • User-defined ...

The functions described above can be called using the relevant context menu.

Activities
You can access the workflow outbox in the overview tree in the Business Workplace [Page 117] via Workplace → Outbox.
Workflow Resubmissions

Use

The workflow resubmissions [Ext.] function can be used to resubmit work items for processing at a later point in time or periodically and to display these work items in a list.

Technically, the following applies to work items which appear in your workflow resubmission folder: the work item status is set to waiting, your name is entered as the actual agent, and the requested start date is set to the resubmission date.

Integration

As is the case for the workflow inbox [Page 158] and the workflow outbox [Page 196], the workflow resubmissions is an integral part of the Business Workplace.

Features

Workflow Functions

The screen area in which the worklist is displayed has a toolbar containing the workflow functions and functions for configuring the list. For information about these functions, refer to the documentation on the ABAP List Viewer [Ext.].

The following functions are available in the workflow resubmissions:

- **Update**
  You use this function to update the workflow resubmissions.

- **Display work item**
  This function goes directly to the work item display [Page 161]

- **Display workflow log**
  This function displays the workflow log [Page 173].

- **Display attachments**
  This function is only available if the work item has attachments. Refer to attachment management [Page 183].

- **End resubmission**
  The work item is put back into the workflow inbox. It has the status reserved.

- **Environment**
  - Display objects in workflow (dialog work items only)
  - Display workflow relationships [Page 191]
  - Start Workflow [Ext.]
  - Create link [Page 189]

The functions described above can be called using the relevant context menu.
Activities

You can access the workflow resubmissions in the overview tree in the Business Workplace [Page 117] via Workplace → Resubmissions.

You are asked for a date for resubmission of the work item. The work item then disappears automatically from the workflow inbox and is not displayed there again until the date specified.
Work Item Preview

Use
The work item preview is in the bottom right corner of the Business Workplace screen and provides a preview of the properties of a work item. All the information on a work item is displayed if you choose the function Display work item in the worklist of the workflow inbox [Page 158] or the workflow resubmissions [Page 198]. This function goes directly to the work item display [Page 161].

A concise view of the workflow log [Page 173] is offered in the workflow outbox [Page 196] when the started workflows are displayed.

Integration
The work item preview is part of the Business Workplace [Page 117].

Features
Workflow functions
The description of the work item is displayed in the work item preview. It is also possible to access objects and attachments of the work item directly from the preview.

The concise view of the workflow log enables you to access processed steps (individual work items), their agents and information objects addressed so far.

For more information about the concise view of the workflow log, please refer to Workflow Relationships [Page 191].

Tips & tricks
"Tips & tricks" are displayed when you position the mouse pointer on the title of a "tips & tricks" entry. Whenever the work item preview is updated, a new title is offered.

You can activate/deactivate "tips & tricks" in your personal workflow settings [Page 145] (Settings → Workflow settings → Personal settings).

User exit
The work item preview can be adapted to customer-specific requirements using a user exit [Page 201].

Activities
The work item preview is activated/updated whenever you select a work item in your worklist.
User Exit for Work Item Preview

Use

This user exit [Ext.] gives R/3 developers the opportunity to adapt the work item preview [Page 200] in the Business Workplace [Page 117] to suit customer-specific requirements.

It is therefore possible to:

- Retain the standard preview, but add graphics (for example the company logo) or texts to it.
- Replace the standard preview with your own HTML document.
- Execute simple transactions in the review area of the Business Workplace.

The function module SWL0_PREVIEW_EXIT_TEMPLATE is available for reference when using this interface.

Under Tools → Business Workflow → Development → Environment → Start demo workflows, you can start the workflow template Demo for user exit on WI preview (WS70000640).

This workflow shows you the options available by using this user exit.

The workflow Demo for WI execution in preview (WS70000645) demonstrates the options for work item execution within the work item preview.

Please also refer to Demo and Test Workflows [Ext.].

Further information is available on SAPNet in the SAP Business Workflow Media Center under System documentation.
Workflow Toolbox

Use

*SAP Business Workflow*’s Workflow Toolbox enables the user to access workflow functions even during a workflow-driven application transaction.

The following functions are now available even during method execution:

- Display work item text
- Display task text
- Availability of attachments and objects as links
- Create/display/change/delete attachments
- Display possible agents
- Display workflow log
- Forward
- Resubmit
- Send mail

The toolbox is easy to activate from the application side in its dialog transactions. The full functionality of the toolbox is encapsulated in class `CL_WAPI_WF_TOOLBOX`.

The workflow WS70000651 *Demo for WI execution with WF toolbox* can be started by any user with transaction SWUI_DEMO, and generates work items in the Business Workplace. The toolbox demonstrates the execution of these work items in its various forms. For further information, refer to *Demo and Test Workflows [Ext.]*.

Features

**Class CL_WAPI_WF_TOOLBOX**

The class `CL_WAPI_WF_TOOLBOX` encapsulates the full functionality of the toolbox. An instance of this class is created directly before the *CALL SCREEN* of the application screen. This instance provides all the *GUI objects* it requires and manages them as well.

**Reusing worklist client functionality**

**Work item preview**

The toolbox uses the *work item preview [Page 200]* in the Business Workplace to display work item text, task description and links to attachments and other objects.

**Workflow log**

The first tab page of the ActiveX version of the *workflow log [Page 173]* is used again to display the complete workflows already processed.
Various Workflow Toolbox modes

**Toolbar only (embedded)**

If the toolbox is used in its simplest mode `C_MODE_INPLACE_WITHOUT_INFO`, it requires a custom container of approximately 1 x 4 cm on the screen.

The work item preview and workflow log are displayed in a separate new screen (modeless). A pushbutton is available to the user for this.

**Toolbar and information (embedded)**

If the toolbox is used in mode `C_MODE_INPLACE_WITH_INFO`, it is displayed in two parts on the screen: The toolbar is displayed above the preview initially. The user can switch between preview and log in the lower part.

**Toolbar and information (modeless)**

If the toolbox is used in mode `C_MODE_MODELESS`, it is displayed in two parts in a modeless window: The toolbar is displayed above the preview initially. The user can switch between preview and log in the lower part.

**Menu button only (embedded)**

If the toolbox is used in mode `C_MODE_INPLACE_BUTTON_ONLY`, it requires a custom container of at least 1 x 1 cm on the screen, depending on whether just an icon or an icon with text is to be displayed.

The toolbox opens a modeless window to display work item preview and workflow log when the user chooses the relevant menu option.
Administration of the Business Workplace

Use

The administration of the Business Workplace is divided into

- Administration of workflow [Page 269]
- Administration of the send, folder and office functions [Page 205].
Administration of the Send, Folder and Office Functions

Use

The send, folder and office functions of the Business Workplace are ready for use as soon as the R/3 System has been installed. SAP users are automatically assigned a Business Workplace when they are created. To send externally, the external communication systems must be connected via SAPconnect [Ext.] to the R/3 System and some settings in the R/3 System [Page 211] must be made. You should also adapt the Business Workplace settings to suit the requirements of your company. You can change the settings when the system is in operation.

Prerequisites

The authorizations for the administration of the send, folder and office functions are contained in the role SAP_BC_SRV_GBT_ADMIN.

Features

You can adapt the following settings to suit the requirements of your company.

- the permitted document classes [Page 235]
- the document templates [Page 45]
- the fax forms [Page 249]
- the structure of shared folders [Page 21]
- the shared office settings [Page 214], in which you can make system-wide settings for the document, send, mail system and folder functions

In order to reduce the work for individual users, you can maintain the private office settings centrally [Page 218].

You can maintain addresses [Page 224] for the central address management in Business Workplace administration. You can create and change internal addresses as well as addresses for companies and contact persons. If an address is deleted, you can remove this from all distribution lists centrally.

A reorganization program [Page 244], which deletes all the documents deleted in the Business Workplace from the database, must run regularly during production operation. You should also empty the shared trash [Page 243] at regular intervals. If distribution lists are specified in the authorization list for the access authorizations to shared folders, the authorization lists must be updated if the distribution lists change. This is not carried out automatically, but has to be initiated by an administrator via a report on Updating Folder Authorizations [Page 223]. If users are unexpectedly absent, you can set automatic forwarding centrally [Page 222]. Furthermore, functions are available for collecting and evaluating data [Page 252] for the mail and folder environment.

If problems occur with users, you can check the consistency of the user tables and the address tables [Page 221] or assign a Business Workplace to an SAP user [Page 219] manually. In order to reduce the load on the database, you can encourage the users to clean up with a report. A report is also available that you can use to reorganize users' inboxes centrally.

If you use the mail system of a third party manufacturer (Microsoft or Lotus), you can set up a mail system group. The messages sent internally in the SAP System are then automatically sent...
Administration of the Send, Folder and Office Functions

to the external mail system. For information on the settings required for this, see A Mail System Group Between an SAP System and an External Mail System [Page 260].

If you use the SAP System as a mail system and users work with a MAPI-compatible mail client, you should read the information about the SAP MAPI Service Provider [Ext.]. If you want to use the Internet Application Component of the Business Workplace, see Business Workplace in the Internet [Page 114].

Activities

The functions for the administration of the send, folder and office functions of the Business Workplace can be found in the role menu under the menu option Business Communication Administration → Office.
Authorizations for the Business Workplace

Roles for the Business Workplace

Authorizations are checked when functions are used in the Business Workplace, as they are throughout the SAP System. SAP supplies roles that group together the authorizations for a specific user group. The roles for the area of the send, folder and office functions of the Business Workplace are the following:

<table>
<thead>
<tr>
<th>Role Description</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorizations for the end users of the Business Workplace</td>
<td>SAP_BC_SRV_GBT_USER</td>
</tr>
<tr>
<td>Authorizations for the administrators of the Business Workplace</td>
<td>SAP_BC_SRV_GBT_ADMIN</td>
</tr>
</tbody>
</table>

For more information, see the documentation on Users and Roles [Ext.].

Authorization objects

When the send, folder and office functions of the Business Workplace are used, the system checks authorizations using the following authorizations objects:

- **S_OC_ROLE**: Administrator authorization
- **S_OC_TCD**: Authorization to use the transactions
- **S_OC_FOLCR**: Authorization to create shared folders
- **S_OC_SEND**: Authorization to send documents
- **S_OC_DOC**: Authorization to archive documents

Administrators require additional authorizations for table maintenance. These are checked using the following Basis authorization objects:

- **S_TABU_CLI** (client-independent tables) and
- **S_TABU_DIS** (other tables).

Authorization objects for the administration of the Business Workplace

<table>
<thead>
<tr>
<th>Object</th>
<th>Activity</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_OC_ROLE</td>
<td>Administrator</td>
<td>Transaction codes for the administration functions of the send, folder and office area</td>
</tr>
</tbody>
</table>

You can also enter generic values - that is, with a star (*) - so that the entry applies to all the possible values in the field.

Administrators can display all the folders in shared folders. This means that they can also display group folders even if they are not included on the authorization list of these folders.
## Authorizations for working with the Business Workplace

### Object Value Description

<table>
<thead>
<tr>
<th>Object</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_OC_F</td>
<td>M</td>
<td>Creation of client folders</td>
</tr>
<tr>
<td></td>
<td>G</td>
<td>Creation of group folders</td>
</tr>
<tr>
<td>S_OC_D</td>
<td>e.g.1000</td>
<td>The number of recipients that can be addressed per send process</td>
</tr>
<tr>
<td></td>
<td>OFF</td>
<td>Internal sending</td>
</tr>
<tr>
<td></td>
<td>FAX</td>
<td>Sending documents by fax and telex</td>
</tr>
<tr>
<td></td>
<td>RML</td>
<td>Sending documents between different SAP Systems</td>
</tr>
<tr>
<td></td>
<td>X40</td>
<td>Sending via X.400</td>
</tr>
<tr>
<td></td>
<td>INT</td>
<td>Sending via the Internet</td>
</tr>
<tr>
<td></td>
<td>X50</td>
<td>Sending to LDAP addresses</td>
</tr>
<tr>
<td>S_OC_S</td>
<td>24</td>
<td>Archiving documents</td>
</tr>
<tr>
<td>S_OC_T</td>
<td></td>
<td>Transaction codes for the application functions of the send, folder and office area</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can also enter generic values - that is, with a star (*) - so that the entry applies to all the possible values in the field.</td>
</tr>
<tr>
<td>S_LDAP</td>
<td></td>
<td>Specify the access authorization (for example, Read) and the logical LDAP server to which the authorization is to apply.</td>
</tr>
</tbody>
</table>

The authorization for accessing the LDAP server is not contained in the roles for the Business Workplace. If you set the access to the LDAP server for the Business Workplace (in the shared office settings), you should also assign the corresponding authorizations to the users.
Sending

Use
The Send function is used to distribute documents internally and externally. When you send documents internally, the documents are sent to R/3 users in the same system. When you send documents externally, they are sent to non-R/3 users or to R/3 users in another system. Documents can be sent externally by the following methods of communication:

- Fax
- Internet mail
- Remote mail (R/3-R/3 connection)
- X.400
- Paging (SMS mail).

Integration
The Business Workplace transfers the document to be sent to the send interface of the R/3 System, the Business Communication Interface [Ext.] (BCI). This controls internal sending and places the document for an external recipient in a queue. The document is then transferred to the external communication system (for example, a fax server) by SAPconnect. For further information on sending documents externally, see the documentation: BC - SAPconnect [Ext.].

The address management is used for sending documents internally and for sending documents to external addresses. When documents are sent to external addresses, the communication method that is flagged as Standard for this address in the address management is used. When documents are sent to an external address, for example by the standard communication method fax, the address data is automatically copied to the recipient field of the fax form. A fax number can also be entered directly, but in this case the recipient data must be entered in the fax form by the sender himself. An input help is available for this in the Business Workplace.

If a document is sent to several recipients, the BCI expands the recipient list of the document so that a send process is started for each individual recipient and the send status can be returned for each one. The sender can actively monitor the send status and can also be informed of it passively, depending on the type of confirmation (for example, in the case of send errors). The document sent to several recipients is not duplicated when it is sent internally. Instead, each recipient receives a link to the same document. The document therefore still only exists once in the database of the R/3 System after it has been sent.

This does not mean that the original of the document is stored in any particular folder (for example, the folder of the owner or of the creator) and can be deleted from this. All users have one link only to the document. The document is not deleted from the database (in the next reorganization) until the link has been deleted by all users.

Therefore, when a document existing in the folders of a user is referred to in this documentation, this, for the most part, denotes the link to the document. The document itself is not physically stored in the folders but rather in the database. It is not normally important for the user to know this. Only in the case of modifiable documents is it important to have some knowledge of the technical background. This
Sending

is due to the fact that, if a modifiable document is stored in the private folder areas of several users after it has been sent, changes to the document will be visible to all the users.

Prerequisites

The settings that are required in order to send documents externally and to receive documents in the R/3 System are summarized in Sending Documents in the R/3 System [Page 211].

Features

In the Business Workplace, documents can be sent to individual recipients as well as to distribution lists or organizational units that contain several recipients, possibly with different communication methods. For further information, see Recipient Type [Page 97].

You can specify in the shared office settings [Page 214] that documents sent by users in the Business Workplace, as well as documents sent from the applications under the users own name, are collected in the outbox and/or in a private folder. You can also specify that documents can be sent to Business objects and organizational units. Furthermore, you can activate the access to LDAP services.

Internet messages can be sent, for example, using the SAP Internet Mail Gateway [Ext.] contained in the R/3 standard system.

Folders (with the exception of object folders) and distribution lists cannot be sent.
Sending Externally from the SAP System

Purpose
Certain settings are necessary in the relevant components to enable documents to be sent externally from the SAP System. The following information gives you an overview of the settings you need to make in SAPconnect, in the address management, and in the Business Workplace. Additional settings may be necessary for sending from an application. These are described in the relevant application documentation.

Process Flow
1. Customizing settings

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Menu path / Transaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifying the communication types</td>
<td>Check whether the communication type SAPconnect is set for all communication methods that offer the communications systems connected via SAPconnect.</td>
<td>SCOT, Settings → Communication methods</td>
</tr>
<tr>
<td>Specifying conversion rules</td>
<td>SAP supplies conversion rules for the situation where the external communications systems and the SAP System support different formats [Ext.]. If additional conversions are necessary for your communications systems, you can add new conversion rules.</td>
<td>SCOT, Settings → Conversion rules</td>
</tr>
<tr>
<td>Defining rules for recipient number adjustment</td>
<td>For more information, see Rules for Recipient Number Adjustment [Ext.].</td>
<td>SCOT, Settings → Country code, Country code exceptions or Recipient number change (incoming)</td>
</tr>
</tbody>
</table>

2. Settings for the RFC Connection

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Menu path / Transaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating an RFC User</td>
<td>For more information, see Creating RFC Users [Ext.].</td>
<td>SU01</td>
</tr>
<tr>
<td>Creating RFC destination</td>
<td>For more information on RFC destinations [Ext.], see the documentation BC - RFC Programming in ABAP.</td>
<td>SM59 or when creating the relevant node RFC destinations in SAPconnect administration.</td>
</tr>
</tbody>
</table>
Sending Externally from the SAP System

3. Settings in SAPconnect

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Menu path / Transaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating node</td>
<td>For more information, see [Nodes [Ext.]]</td>
<td>SCOT, View → Node</td>
</tr>
<tr>
<td>Maintaining inbound distribution</td>
<td>For more information, see [Inbound Distribution [Page 230]]</td>
<td>SCOT, Settings → Inbound distribution</td>
</tr>
<tr>
<td>Scheduling send processes</td>
<td>For more information, see [Send Processes [Ext.]]</td>
<td>SCOT, View → Jobs</td>
</tr>
</tbody>
</table>

4. User settings

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Menu path / Transaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintaining addresses</td>
<td>SAP users can only send and receive in the communication methods for which they are assigned an address. If you have specified a standard domain [Page 211] for sending via the Internet, a sender address is created automatically when documents are sent using the communication method Internet for users to whom no Internet address is assigned. For more information on Addresses [Page 224], see the documentation BC - Business Workplace.</td>
<td>SU01 or SO12</td>
</tr>
<tr>
<td>Assigning send authorizations</td>
<td>Users require send authorizations. The authorization object S_OC_SEND and (as values) the allowed communication methods and the maximum number of recipients to which a user may address a message are assigned to you. The authorizations required for sending are, by default, contained in the role SAP_BC_SRV_GBT_USER for the end user of the Business Workplace.</td>
<td>SU01</td>
</tr>
</tbody>
</table>
5. Settings in the Business Workplace

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Transaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checking send restrictions</td>
<td>In the Business Workplace shared office settings [Page 214], you can activate send restrictions for sending from the Business Workplace interface. For example, you can allow internal sending only, or external sending only using the address management.</td>
<td>SO16</td>
</tr>
</tbody>
</table>
Shared Office Settings

Use

Administrators define the settings for the send, folder and office functions of the Business Workplace in the shared office settings. The shared office settings contain settings for the user, document organization, sending, addressing and mail system group areas.

The settings in the user area are used as standard defaults for the private office settings [Page 106]. It is recommended, for performance reasons, that you specify an outbox expiry date and set daily reorganization. You can restrict sending in the Business Workplace. In a distributed system landscape, you have to maintain the settings for the mail system group. You can also maintain settings for address buffering and for limiting the recipient types permitted.

Features

User

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Example entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy to outbox</td>
<td>This flag indicates that the documents sent by a user are to be placed in their outbox. You can then monitor the transmission information. If you select this field, it is advisable to set an expiry date for the outbox.</td>
<td>X</td>
</tr>
<tr>
<td>Confirmation prompt when deleting</td>
<td>This flag indicates that a dialog box is to be displayed before you delete something in the Business Workplace, asking you to confirm the deletion.</td>
<td>X</td>
</tr>
<tr>
<td>Resubmission only on working days</td>
<td>This flag indicates that documents are not to be resubmitted on weekends or public holidays but rather on the last working day before.</td>
<td>X</td>
</tr>
<tr>
<td>Factory calendar</td>
<td>In the field Factory calendar, select the factory calendar that corresponds to your region so that the system proceeds according to the appropriate calendar when the setting Resubmission only on working days is selected.</td>
<td>Germany (Baden-Württemberg)</td>
</tr>
<tr>
<td>Preset document classes</td>
<td>You choose this pushbutton to branch to the maintenance screen for the document classes that are directly displayed to users in the Business Workplace for selection when they use the Create function. The name under which the documents are displayed can also be maintained.</td>
<td>DOC - Word document</td>
</tr>
<tr>
<td>No notification of unread mails when logging on</td>
<td>This flag indicates that the dialog box that informs users of new messages when they log on to the R/3 System is to be deactivated.</td>
<td></td>
</tr>
<tr>
<td>Execution of express messages in a new session</td>
<td>This flag indicates that a new session is to be opened when users call a function in the dialog box Express Information.</td>
<td>X</td>
</tr>
</tbody>
</table>
### Document organization

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Example entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preset expiry date for documents</td>
<td>When a document is created, the number specified here is added to the creation date and the expiry date resulting from the calculation is then preset. The creator or person to change a document can overwrite the expiry date. If you do not specify a number, no expiry date is preset.</td>
<td></td>
</tr>
<tr>
<td>Expiry date of documents in the outbox</td>
<td>The number entered here is added to the creation date or the date the document was moved and the document is automatically deleted from the outbox when this date is reached. If the outbox is used as a folder for documents sent, it is advisable to make this setting so that the folder does not become too big. If you do not specify a number, no expiry date is preset.</td>
<td>80 days</td>
</tr>
<tr>
<td>Warning for PC documents larger than</td>
<td>When calling PC documents, a dialog box is displayed when the size specified here is reached, giving you the option of canceling the function or downloading the document to the PC first. If you do not specify a number, the dialog box is not displayed.</td>
<td>256 kilobytes</td>
</tr>
<tr>
<td>Daily reorganization</td>
<td>If you select this field, the daily reorganization [Page 244] is logged.</td>
<td></td>
</tr>
</tbody>
</table>

### Sending

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Example entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connected components for external sending</td>
<td>The selections in this frame show which components are available for external sending. The administration of the components is carried out in SAPconnect [Ext.].</td>
<td></td>
</tr>
<tr>
<td>Settings</td>
<td>You choose this pushbutton to branch to the SAPconnect administration screen.</td>
<td></td>
</tr>
<tr>
<td>No sending between R/3 users</td>
<td>This flag indicates that internal sending is disallowed for all users of the Business Workplace.</td>
<td></td>
</tr>
<tr>
<td>External sending only via address management</td>
<td>This flag indicates that sending to external addresses is disallowed for all users of the Business Workplace.</td>
<td></td>
</tr>
</tbody>
</table>

If you select all three fields, the Send function is deactivated in the whole of the Business Workplace.
Shared Office Settings

No external sending via address management

This flag indicates that sending directly to Internet addresses, fax numbers, X.400 addresses, paging numbers, Remote Mail addresses and LDAP addresses is disallowed.

No external sending of confidential documents

This flag indicates that confidential documents cannot be sent externally in this system. In this case, confidential documents also remain in the Business Workplace of the recipients who have set automatic forwarding to an external address. This is the case even if these recipients have specified that forwarded documents are not to be placed in the inbox as well.

Addressing

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Example entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset buffers after</td>
<td>The number entered here specifies the time period after which the buffer is automatically deleted regularly. You have to specify this setting in order for changes to buffered addresses to become effective. If the buffer is never to be deleted automatically, specify 9999. If a buffer is not to be used, specify 0000.</td>
<td>12 hours</td>
</tr>
<tr>
<td>Reset buffer</td>
<td>You delete the address buffer manually by choosing this pushbutton.</td>
<td></td>
</tr>
<tr>
<td>Addresses from LDAP service</td>
<td>If you select this field, users in the Business Workplace can access addresses from the LDAP service connected to the R/3 System.</td>
<td></td>
</tr>
<tr>
<td>LDAP settings</td>
<td>You choose this pushbutton to branch to the maintenance screen for LDAP settings.</td>
<td></td>
</tr>
<tr>
<td>Organizational objects</td>
<td>If you select this field, users in the Business Workplace can access organizational objects and, for example, use organizational units as recipients.</td>
<td>X</td>
</tr>
<tr>
<td>SAP Business Objects</td>
<td>If you select this field, users in the Business Workplace can access business objects and use them as recipients, for example.</td>
<td>X</td>
</tr>
</tbody>
</table>

Mail system group

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Example entry</th>
</tr>
</thead>
</table>
### Shared Office Settings

<table>
<thead>
<tr>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>No mail system group</td>
<td>If you select this field, the settings for the home addresses of the users have no significance.</td>
</tr>
<tr>
<td>Forward mails to</td>
<td>If you select this field, all messages received in this R/3 System are forwarded to the R/3 System specified in the field SAP System ID. This function is suitable for system landscapes in which one system is used as a central mail system.</td>
</tr>
<tr>
<td>SAP System ID</td>
<td>Specify the system name of the R/3 System to which mails are to be forwarded.</td>
</tr>
<tr>
<td>Client</td>
<td>Specify the client of the R/3 System to which mails are to be forwarded.</td>
</tr>
<tr>
<td>Consider user home addresses</td>
<td>If you select this field, messages received in this R/3 System are placed in the inbox that is flagged as the user's home address. This can be in an R/3 System or in another system connected in the mail system group.</td>
</tr>
<tr>
<td></td>
<td>The home address of each user is specified in the address management for each communication method used.</td>
</tr>
</tbody>
</table>

For more information on setting up a mail system group, see *A Mail System Group Between SAP Systems and an External Mail System*.

**Activities**

To maintain the shared office settings, call transaction SO16. The areas are listed on the tab pages.
Maintaining Private Office Settings Centrally

Use

Administrators can execute this program to maintain the private office settings [Page 106] of more than one user at the same time.

Features

The standard values for the office settings are displayed and these can be changed, if necessary. You can specify the users for whom the private office settings are to be changed. Depending on the size of the user group for which the settings are to be changed, you can define the target group in different ways. You can either

- specify the user names for which the office settings are to be changed, or
- select all users and then specify any exceptions.

Activities

To change the private office settings centrally, call transaction SOY1.
Assigning a Business Workplace Manually

Use

When an SAP user is created, the system creates a Business Workplace for the user at the same time. If errors occurred in this process and a Business Workplace was not assigned to the SAP user, you can assign a Business Workplace manually. You can also create a new Business Workplace for an SAP user to whom a Business Workplace is already assigned. In this case, you have to reset the user's Workplace first. In this process, all existing documents and settings are deleted.

The shared office settings and the standard values of the private office settings are used as a basis when a Business Workplace is assigned to a user.

Administrators can use a program [Page 221] to check whether a Business Workplace is assigned to all SAP users. This program then assigns a Business Workplace to any users who have not already been assigned one.

Activities

Call transaction SO12.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
</table>
| Assign Business Workplace to user | 1. Choose ⭕.  
2. Enter the user name.  
3. Choose ✓.  
   A Business Workplace is assigned to the user. Administrators or the users themselves can change the values proposed in the private office settings. |
| Reset the Business Workplace of a user | 1. Choose Different user.  
2. Enter the name or the user name of the user whose Business Workplace is to be reset.  
3. Choose ✓.  
4. Choose Reset user  
5. Choose Yes.  
   The contents and settings of the Business Workplace are deleted for the specified user and a new Business Workplace with the standard settings is assigned to this user.  
   Work items are not deleted when the Business Workplace is reset, but are transferred to the new inbox. |
User Tables: Consistency Checks

Use
This program is available to administrators for checking the consistency of the following tables: Business Workplace tables, SAP user tables and central address management tables.

Integration
If the program finds any inconsistencies, the entries in the Business Workplace tables (SOUC and SOUD) are compared and missing entries can be inserted, existing entries can be modified and obsolete entries can be deleted. This program can only insert missing entries in the SAP user administration tables (USR02 and USR21) and in the central address management tables (ADCP and ADRVP), no entries can be changed or deleted.

Activities
Call transaction SO55. You can execute the program as a test run. In this case, the results are displayed but no changes are made in the database.
Setting Automatic Forwarding Centrally

Use

Administrators can use a program to set and activate automatic forwarding of all the documents for a user. This can be important in case an employee becomes ill, for example. The messages can be forwarded, for example, to an external address (for example, Internet or fax). In this way, you can ensure that all messages sent to this person are processed.

Procedure

1. Call transaction SO36.
2. Make the following entries:
   - User
     Enter the name of the user whose documents are to be forwarded.
   - Forward to
     Specify the address to which the documents are to be forwarded.
   - Address type of the recipient
   - Forward from... / to...
     Enter the start and end (date and time) of the time period in which automatic forwarding is to be active.
3. Choose.

   Automatic forwarding is now active.

   You can only define automatic forwarding for a time period for which the corresponding user has not activated automatic forwarding himself or herself.

Result

The documents sent to the user's R/3 inbox are forwarded to the specified recipient address in the specified time period. They also remain in the user's inbox. If it is specified in the shared office settings that confidential documents are not to be sent externally, confidential documents are not forwarded to external addresses when automatic forwarding is used, but instead remain in the user's R/3 inbox.
Updating Folder Authorizations

Use
Shared distribution lists may be included in the authorization lists for shared folders. If changes are made to a distribution list, the authorization lists are not automatically updated, for performance reasons. In order to compare distribution lists with authorization lists, you have to execute the following program.

Activities

Updating Folder Authorizations Manually
1. Call transaction SO38.
2. Specify whether you want to update the authorization lists of all folders or of one particular folder only, along with all its subfolders.
3. Choose.

Scheduling a report for updating folder authorizations
Create a job that starts the program RSSOFALU with the required variant. For further information on scheduling background jobs [Ext.], see the documentation on BC - Computing Center Management System.
Addresses and Communication Methods

Use

Every R/3 user who wants to send documents from the R/3 System or to receive documents in the R/3 System from an external source must be assigned an address for the corresponding communication method, for example, a fax number or an Internet address.

Central Address Management

The address data of every user, along with the postal address and the company address, are managed in the central address management of the R/3 System. External addresses are also stored in the central address management. External addresses include the addresses of companies with which your company has contact and the contact persons via whom the contact to these companies occurs. Every address (therefore the internal users, the companies and the contact persons) can be assigned a postal address as well as the addresses of all the communication methods that can be used for this address.

You can find more information about this topic in: BC Central Address Management [Ext.].

Sending Externally via Address Management

When a document is sent externally, the addresses of the internal users are automatically used as the sender data, for example, on the cover sheet of a fax form [Page 249]. If an external address from the address management is specified as the recipient, the recipient data is also automatically copied. The R/3 user only needs to enter the name of the contact person and the recipient type External address on the send screen.

When a document is sent, various recipient address types (recipient types [Page 97] for short) are specified. Some correspond to the communication method by which the document is to be sent, for example, an Internet address or a fax address. However, no set communication method is connected with the recipient type External Address. Some contact persons prefer to receive their documents by fax, others by e-mail. Therefore, every address can be assigned a standard communication method. This communication method is then used for every send process, provided that the sender does not explicitly change this.

Sending Externally (Without Address Management)

If an R/3 user sends a document to an address that is not stored in the address management, you have to enter the communication address directly, for example, DE 0987654321 with the recipient type Fax address. You also have to enter the recipient data that is to be listed on the fax cover sheet, for example.

In the shared office settings [Page 214], administrators can forbid users from sending documents externally to addresses that do not exist in the address management.

Home Addresses in an R/3 System Group

In a mail system consisting of several R/3 Systems, documents can be sent to all users via Remote Mail or by a different external communication method. In this case, each user must have an address for the corresponding communication method for every system that they send documents from. A user can therefore have more than one address for one communication method. However, a user normally wants to receive all documents sent to them in one system,
regardless of which system the documents are addressed to. Therefore, it is possible to mark one of the addresses existing for a communication method as the home address. In order for this setting to have an effect, an administrator has to have activated the home address in shared office settings [Page 214].

**Other Functions**

Several addresses can be grouped together in a distribution list [Page 74].

If LDAP services are connected to the SAP System, users in the Business Workplace can search for addresses in them and copy the addresses directly from the LDAP service when sending documents. You make the settings for this in the shared office settings [Page 214]. A link to the maintenance of the LDAP server connected to the SAP System is also offered there. See also SAPNet note 188371. You also have to assign the authorization [Page 207] for accessing the LDAP server.

Specific information on Internet addresses [Ext.] can be found in the documentation on BC - SAP Internet Mail Gateway.

**Activities**

The company address is automatically assigned to R/3 users when they are created. To maintain the addresses of R/3 users, proceed as described in Maintaining Internal Private Addresses [Page 226]. You can also create a list [Page 109] with the data of several internal people. For further information on the maintenance of external addresses, see Maintaining Addresses of Companies and Contact Persons [Page 227].

If it is not possible to send documents in the R/3 System or to work in the Business Workplace, this may be due to inconsistencies between the tables for users, addresses and the Business Workplace. See User Tables: Consistency Checks [Page 221].
Maintaining an Internal Private Address

Use

You can maintain your own private address or that of another user from the Business Workplace. However, you cannot maintain the assigned company address or change the assignment from here. This has to be carried out in the maintenance of the user master record [Ext.].

Prerequisites

Each user can maintain their own address themselves. You require administration authorization in order to maintain the private address of another user.

A private address can only be maintained in the Business Workplace if a Business Workplace is assigned to the user.

Central address management must be available.

Procedure

1. Choose Settings --> Office settings.
2. This step differs depending on whether you want to maintain your own address or that of another user:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintain own address</td>
<td>Choose 🔄.</td>
</tr>
<tr>
<td>Maintain address of another user</td>
<td>a) Choose a different user.</td>
</tr>
<tr>
<td></td>
<td>b) In the subsequent dialog box, enter the data for the required user.</td>
</tr>
<tr>
<td></td>
<td>c) Choose ✅.</td>
</tr>
<tr>
<td></td>
<td>The office settings of the user are displayed.</td>
</tr>
<tr>
<td></td>
<td>d) Choose 🔄.</td>
</tr>
</tbody>
</table>

3. A dialog box is displayed from which you can maintain the address data.
4. To save your changes, choose ✅.
5. To exit Private office settings, choose ✅ if you also want to save any changes to the office settings. Choose 🖹 if you only want to copy changes to the address data.
Maintaining Addresses of Companies and Contact Persons

Purpose
You can maintain the addresses and communication methods of external companies and contact persons from the Business Workplace. The communication method by which documents are to be sent is specified for each address if the recipient type External address was specified as the recipient.

Process Flow
1. If you want to create addresses for the contact persons of a company the address of which does not exist in the address management, first create the company address [Page 228] and define the standard communication method for it.
2. Create addresses for the contact persons [Page 229] for the company address and specify the standard communication method for each one.

Result
It is possible to send directly to an external contact person via the corresponding standard communication method from the send screen.
Creating Company Addresses

Prerequisites
You require authorization [Page 207] for the transaction SOAD.

Procedure
1. Choose Environment → External companies
   You branch to the search screen of the address management.
2. Choose .
3. Enter the address data for the company.
   Under Communication, you can maintain the other communication methods (for example, pager numbers, other telephone or fax numbers, other Internet addresses, X.400 addresses and Remote Mail addresses for R/3-R/3 connections).
   As the standard communication method, specify the communication method by which the company should normally be contacted.
4. Save your entries.
Creating Addresses for Contact Persons

Prerequisites
You require [authorization [Page 207]] for the transaction SOCP.
The corresponding company address must be maintained.

Procedure
1. Choose Environment → External contact person
   You branch to the search screen of the address management.
2. Specify the company for which the contact person is to be created.
3. Choose .
4. Enter the address data of the contact person.
   Under Communication, you can maintain the other communication methods (for example, pager numbers, other telephone or fax numbers, other Internet addresses, X.400 addresses and Remote Mail addresses for R/3-R/3 connections).
   As the standard communication method, specify the communication method by which the contact person should normally be contacted.
5. Save your entries.
Inbound Distribution

Use

Inbound distribution enables you to distribute incoming documents to certain recipients. You can define this distribution according to the following criteria:

<table>
<thead>
<tr>
<th>Criterion</th>
<th>Function</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recipient</td>
<td>All documents that are addressed to a certain recipient are forwarded to a different recipient.</td>
<td>A user receives all the Internet messages that are sent to the address <a href="mailto:Info@Company.de">Info@Company.de</a>.</td>
</tr>
<tr>
<td>Sender</td>
<td>All documents that are received from a certain sender are forwarded to a defined recipient, irrespective of the recipient specified.</td>
<td>A buyer receives all documents that are received from his suppliers.</td>
</tr>
<tr>
<td>Recipient and Sender</td>
<td>All documents that are received from a certain sender by a certain recipient are forwarded to a defined recipient.</td>
<td>An employee takes over the processing of orders from his colleague. He now receives all the documents that are addressed to the colleague from this customer.</td>
</tr>
<tr>
<td>Communication method</td>
<td>All documents that are received in the R/3 System via a certain communication method and the recipients of which are not found, are forwarded to a defined recipient.</td>
<td>An administrator receives all the faxes for which the recipients were not found.</td>
</tr>
</tbody>
</table>

For incoming documents, a search is executed for the specified recipient via inbound distribution and then in address management. If no corresponding entry is found, the document is forwarded to the recipient address which is specified as the Alternative entry. This also ensures that a document is forwarded, even if the original recipient cannot be determined via inbound distribution or address management. (For example, if the original recipient has left the company.)

Integration

The inbound distribution function can only be implemented for incoming documents which are sent from outside the R/3 System. Automatic forwarding [Page 102] of internal documents can be set for a recipient. Automatic forwarding does not depend on the sender or the communication method.

Features

Incoming messages can be forwarded via inbound distribution to the following recipient types [Page 97]:

- SAP users
- Distribution lists [Page 74]
Inbound Distribution

- Business objects [Ext.]
- Organizational units [Ext.]
- EDI inbound distribution.

You can decide whether the documents are also to be forwarded to the recipients to whom they were originally addressed in addition to the recipients specified in the inbound distribution.
Maintaining Inbound Distribution

1. Call transaction SO28.

2. Define the distribution of incoming documents:
   a. In the **Recipient** column, enter the recipient address with which the external document will arrive in the R/3 System. A recipient address can be an RML address, a fax number or an Internet address, for example. A generic entry with * as the joker for a character string is permitted. AND links are used between the columns Sender and Recipient.
      
      If you enter * in this column, there are no restrictions with regard to the recipient address. You are therefore confirming that all incoming documents of a certain type should be forwarded to a new recipient within the R/3 System.
   
   b. In the **address type** column, specify the type of the incoming recipient address using the entry help.
   
   c. In the **New recipient** column, enter the recipient within the R/3 System to which the incoming document should be forwarded. A generic entry is not permitted.
   
   d. In the **address type** column, specify the type of the new recipient address using the entry help.
   
   e. If an incoming document should be sent to the original recipient as well as the new recipient, select the column **Additional selection**.
   
   f. In the **Sender** column, inbound distribution can be specified using the incoming sender address. A generic entry with * as the joker for a character string is permitted. AND links are used between the columns Sender and Recipient.
   
   g. In the **address type** column, specify the type of the incoming sender address using the entry help.

   For **alternative entries**, only the communication method (address type of the recipient) as well as the address and address type of the new recipient should be specified. In this case, you do not have to enter a recipient, sender address or address type for the sender.

3. Choose 

All fax messages from the German customer ABC with the fax number 06772/12345 are to be forwarded to the distribution list CUSTOMER SERVICE. The following entries would be required:

<table>
<thead>
<tr>
<th>Field</th>
<th>Example entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alternative entry</td>
<td></td>
</tr>
<tr>
<td>Recipient</td>
<td>*</td>
</tr>
<tr>
<td>Address type</td>
<td>Fax number</td>
</tr>
<tr>
<td>New recipient</td>
<td>CUSTOMER SERVICE</td>
</tr>
</tbody>
</table>
### Maintaining Inbound Distribution

<table>
<thead>
<tr>
<th>Address type</th>
<th>Shared distribution list</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional selection</td>
<td></td>
</tr>
<tr>
<td>Sender</td>
<td>DE 06772/12345</td>
</tr>
<tr>
<td>Address type</td>
<td>Fax number</td>
</tr>
</tbody>
</table>
Information on Documents in the Business Workplace

Documents, apart from PC documents and binary documents, are firstly stored in the R/3 database in the Business Workplace. Documents that are only accessed rarely can be archived. A program is available to administrators for mass archiving [Page 239] of documents from the Business Workplace.

PC documents and binary documents are stored internally (therefore, without the user being aware of this) in the Business Workplace by the SAP Knowledge Provider. By default, the SAP Knowledge Provider also stores the documents in the R/3 database. It can, however, store documents on an external content server. This has the additional advantage that these documents do not have to be accessed via the application server. For further information, see Configuring an HTTP Content Server for Documents in the Business Workplace [Page 240].

When a document is distributed (sent) to several users, the document is not duplicated, regardless of whether it is stored directly from the Business Workplace or via the SAP Knowledge Provider. All internal recipients receive a link to the document. As a result, the load on the database is reduced and changeable documents, for example, are possible.
Maintaining Document Classes

Use

You can define which document classes can be stored in the Business Workplace in table TSOTD. You specify whether individual classes can be created from the Workplace interface. If this is the case, you can select these classes in the field Document class, using the entry help, when you create documents. It is possible to completely forbid certain document classes in the Business Workplace. Alternatively, you can forbid the creation only of documents of a certain class. This means that documents of this class cannot be created from the Business Workplace interface, but can still be stored in the Workplace.

The PC document classes are entered in this table with the file extension EXT. You maintain individual specifications in another table [Page 236].

Activities

1. Call transaction SOTD.
2. Choose .
3. Make the following entries:
   - Class
     Enter a three-character abbreviation for the new class. The function module SO_XXX, whereby XXX is the class, must exist so that objects of this class can be created from the Business Workplace interface.
   - Object description
     Enter a description for the class.
   - Gen. TOM (Generic class Object Manager)
     If this field is selected, the system does not check whether a function module or a TOM exists for this class. This enables objects that cannot be maintained from the Workplace interface to be stored in the Business Workplace.
   - Create not possible
     If this field is selected, documents of this class cannot be created from the Workplace interface but only from an appropriate application, for example, ALI (ABAP/4 lists).
4. Choose .
Maintaining PC Document Classes

Use

In the maintenance of PC documents classes, you can prohibit documents with certain file types (for example, BAT or COM) from being imported and created in the Business Workplace. You can also disallow the execution of certain file types (for example, EXE).

You can specify certain document classes which should be treated as ASCII files. This means that documents that are treated as ASCII files by the frontend (e.g. as for HTM or TXT files), are also imported and exported as ASCII files. This enables users to display files on platforms that do not support the original data format.

You want to send HTM files, which were created on a PC, from the Business Workplace to a UNIX workstation, for example. These files must be converted into ASCII files before they can be displayed on the UNIX workstation.

Activities

1. Call transaction SOPE.
2. Make the following entries:
   - **File type**
     Enter a three-character file extension, for example, BMP or BAT.
   - **Forbidden**
     Select this field to forbid the creation of these file types in the Workplace.
   - **Not executable**
     Select this field to forbid the execution of these file types in the Workplace.
   - **ASCII**
     Select this field if these file types are to be treated as ASCII files in the Workplace.
   - **File type locked**
     Select this field to lock the R/3 window with a dialog box, even if PC documents are displayed as Read only in the PC application.
3. Choose .
Creating and Maintaining Default Documents

Use

As an administrator, you can define one or more default documents for the various document classes. The default documents are then used as templates for the creation of documents of this class. If several default documents exist for one document class, these are displayed to the user for selection.

Default documents are used in the following situations:

- You wish to save files from the PC editor directly in the correct format. To do this, create an empty document. If your organization uses various versions of a PC application (for example, MS Word 7 and MS Word 8), you should have an empty default document for each version.
- You are working with a PC application which expects a formatted transmission file (for example, PPT for PowerPoint or RTF for Rich Text Format).
- You wish to use forms.

Prerequisites

To be able to create default documents for PC applications, the required version of this application must be available on your PC.

Procedure

1. Call transaction SO19.
   You branch to the shared folder for default documents.
2. Choose ⬤.
   For PC applications that expect a formatted document from the start, you should create the document on your PC and then create it as a default document in the R/3 System by using the function ⬤.
3. Enter the class of the PC document.
4. Assign a name and a title. These can contain, for example, the PC application and the version number.
5. Choose ✓.
6. Edit the document.
7. Choose ⬤.
   If it is a PC document, save the document under the proposed name and close the PC application.

Result

The default document has been created. To change a default document, perform step 1 of the procedure and choose 🆙.
Mass Archiving

Use
As an administrator, you can execute this report in order to store several documents in an optical archive at the same time. SAP editor documents and SAPscript documents can be stored.

Prerequisites
You can only archive documents if an optical archive is connected to the R/3 System and is also set for the documents in the Business Workplace. Documents from the Business Workplace can only be archived centrally by an administrator. Since PC documents and binary documents are not managed internally in the Business Workplace but in the SAP Knowledge Provider (to which an external storage system can be directly connected), they are not included in archiving initiated from the administration of the Business Workplace. The other documents are stored in the connected archive and can be displayed from there. If a user calls the Change function for an archived document, the document is automatically retrieved from the archive and stored in the R/3 database again.

The connection to the R/3 System is made using SAP ArchiveLink [Ext.]. For information on the settings that you have to make in SAP ArchiveLink in order to move documents from the Business Workplace [Ext.] to your optical archive, see the documentation SAP ArchiveLink - Scenarios BC.

Features
You can restrict the documents to be archived according to the following criteria:

- Document class
- Document size
- Last change date of documents.

Activities

Calling Mass Archiving Manually
Call transaction SOY8. A selection screen is displayed, in which you can restrict the documents to be archived. Then choose .

Scheduling Mass Archiving Regularly
Create a job that starts the program RSSOPUT as a background job with the required variant and at the required times. For further information on scheduling background jobs [Ext.], see the documentation on BC - Computing Center Management System.
Configuring an HTTP Content Server for Documents in the Business Workplace

**Purpose**

A class must be created for documents so that they can be stored by the SAP Knowledge Provider. The class SOFFPHIO is assigned to the documents in the Business Workplace in the SAP Knowledge Provider. Storage categories with content repositories are assigned to this class. The content repositories contain the connection data for the relevant storage system, therefore either for the R/3 database or for the HTTP Content Server.

As shown in the graphic, the storage category SOFFDB is assigned by default to the class SOFFPHIO, meaning that the documents are stored in the R/3 database. If you connect an external HTTP Content Server to the SAP Knowledge Provider, you have to make settings so that documents in the Business Workplace can be stored on the external server.

**Process Flow**

<table>
<thead>
<tr>
<th>Process Flow</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Create a content repository for the connection to the external content server.</td>
<td>a) In the R/3 Implementation Guide (transaction SPRO), choose <em>Basis</em> → <em>Basis/Services</em> → SAP Knowledge Provider → Content Management Service → Maintain Content Repository. b) Create a content repository, containing the connection data for your content server, for the storage type <strong>HTTP</strong>. To do this, proceed as described in <a href="link">Maintaining Content Repositories [Ext.]</a>.</td>
</tr>
</tbody>
</table>
## Configuring an HTTP Content Server for Documents in the Business Workplace

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 2.   | Assign the content repository created to the storage category SOFFHTTP.  
|      | a) In the Implementation Guide (transaction SPRO), choose  
|      |   *Basis → Basis/Services → SAP Knowledge Provider →*  
|      |   *Content Management Service → Maintain storage categories*  
|      |   ![Icon](image)
|      |   b) Select the entry SOFFHTTP by double-clicking on it.
|      |   c) In the field Content Rep., specify the name of the content repository that you created for your HTTP content server, for example ZHTTP.
|      |   d) Choose ![Icon](image). |
| 3.   | Assign the storage category SOFFHTTP to the class SOFFPHIO as the standard.  
|      | a) Choose transaction SKPR08.  
|      | b) The memory category SOFFDB is specified for the class SOFFPHIO. In the field *Memory category*, enter SOFFHTTP.  
|      | c) Choose ![Icon](image).  
|      | For further information, see [Concepts [Ext.]](link). |

### Result

After you have made the settings, PC documents and binary documents that have been created in the Business Workplace are stored on the configured content server. The documents that were stored in the Business Workplace before this time remain on the R/3 database. (Therefore the connection to this, the storage category SOFFDB, cannot be changed or deleted.)
Configuring the Storage Category for the HTTP Content Server

2. Select the entry SOFHTTP by double-clicking on it.
3. In the field *Content Rep.*, specify the name of the content repository that you created for your HTTP content server, for example ZHTTP.
4. Choose .
Deleting the Shared Trash Folder

Use
The shared trash folder contains all the documents that were deleted from shared folders. It must be deleted at regular intervals. A report is available for this. It is also possible to delete the shared trash folder manually.

As the administrator, you can retrieve documents, folders, and distribution lists from the shared trash folder and place them in the folder from which they were deleted or move them to another folder in shared folders.

Procedure

Scheduling a job for deleting the shared trash folder regularly
Create a job that starts the program RSSOTRCL as a background job with the required variant and at the required times. For further information on scheduling background jobs [Ext.], see the documentation on BC - Computing Center Management System.

Deleting the shared trash folder manually
1. Call transaction SO17.
2. Specify a minimum time period in days.
   
   All objects that were deleted before this time are deleted from shared trash.
3. Choose 

Retrieving Documents from the Shared Trash Folder
1. In the folder tree of your Business Workplace (SBWP), choose Shared folders.
   
   As an administrator, you can display all the objects that have been deleted from shared folders. Other users can only display the objects that they have created themselves.
2. Select the document you want to retrieve.
3. There are two ways of retrieving the document from the trash:
   
   - The document can be returned to the folder from which it was deleted. To do so, choose Retrieve in the context menu.
   - The document can be moved to any folder in shared folders. To do so, choose Move in the context menu and select the required folder.
4. If necessary, change the expiry date for the document.
5. Choose ✓.
Scheduling Reorganization

Use
In the Business Workplace, documents must be reorganized regularly, that is, deleted from the database. If documents are deleted from the folders and trash of the Business Workplace, only the pointer from the folder to the document is deleted. All documents which no longer have a pointer are deleted from the system in the reorganization. The document content, document attributes and recipient information are deleted.

Two reorganization programs are available: Reorganization (RSSORE00) and daily reorganization (RSSORE02), which does not reduce system performance as much. You can run a log for daily reorganization in order to obtain an overview of the number of documents deleted in the time period. If you schedule daily reorganization, you should also execute the complete reorganization from time to time (once a month, for example). For test purposes, you can start the reorganization programs manually - without the flag Run with database change.

Procedure

Scheduling daily reorganization

Create a job that starts the program RSSORE00. For further information on scheduling background jobs [Ext.], see the documentation on BC - Computing Center Management System.

Starting daily reorganization manually

1. Call transaction SO31.
2. Specify whether a test run only without database changes is to be started or whether the documents are to actually be deleted directly from the database.
3. Choose Program → Execute in the background.

Running a log for daily reorganization

Select Daily reorg on the tab page Document organization in shared office settings [Page 214].

Scheduling reorganization as a background job

Create a job that starts the program RSSORE00 as a background job with the required variant and at the required times. For further information on scheduling background jobs [Ext.], see the documentation on BC - Computing Center Management System.

Starting reorganization manually

1. Call transaction SO30.
2. To start the program with a variant, choose and select the required variant from the following list by double-clicking on it.
   - Reorganize type
     If you only want to reorganize objects of a certain type, enter the required type.
   - Reorganize from/to year
All objects which were created during the specified period will be reorganized.

- **Run with DB change**
  
  This selection means that the reorganization will actually be executed. If you do not mark this field, only a test run will take place.

3. **Choose Program → Execute in the background.**

   As a result, you will receive a list of the document classes for each year with information about how many documents still exist and how many were deleted.
Inbox Reorganization

Use
If inboxes that are too full are affecting system performance, you can move documents from the inbox to private folders using this administration report. You can determine the conditions under which, and the users for whom, this should be carried out.

Procedure
2. Specify:
   - The number of documents in a user's inbox as of which inbox reorganization is to be carried out
   - The age as of which documents are to be moved in cases where this minimum number has been exceeded
   - The user(s) for whom inbox reorganization is to be carried out (certain users or all users with *)
   - Whether inbox reorganization is to be carried out as a test run only or whether changes are to be made in the database.
3. Choose .

Result
Run with database changes only
A new folder is created in private folders for those users who fulfill the specified conditions. You are entered as the owner of this folder. The documents that have exceeded the specified age, and which do not have the status Unread, ToDo or Reply required, are then moved from the outbox and the resubmissions folder to the private folder.

Also as a test run
A list is displayed informing you of the actions of the report. The number of documents that were in the inbox and the number that have been moved to private folders are listed for every user for whom reorganization was started.
Quota

Use
This program is used to evaluate the private folder areas of the inbox, outbox, resubmissions folder and private folders for each user. You can restrict the evaluation according to various selection criteria (for example, evaluation of folder level or document level, user group or date of last evaluation for each user). Users whose folder area exceeds a certain size can be informed of their private evaluation result in a mail and asked to clean up, for example. In the mail, users can call detailed data on the areas. The sizes of the folder areas are shown in a graphic. The users can recalculate their own quota and thus monitor the success of their clean-up work using the evaluation list and the graphics.

Procedure
1. Choose System → Services → Reporting.
2. In the field Program, enter RSSOQUTA.
3. Choose 
   The Quota selection screen is displayed.
4. Enter the target group of the quota. You can use the following address types:
   - Distribution list
   - Organizational object
   - User
5. If a data collection is to be carried out, select Select.
6. Decide which data is to be collected:
   - all data
     Data is collected up to the document level.
   - main data only
     Data is collected up to the folder area level.
7. If necessary, restrict the group of users whose data is to be collected. To do this, specify a time period in days. The data collection is then only carried out for the users for whom no data collection was run in the specified time period.
8. Select whether the users are to be informed of the current quota (if Select was selected) or the last quota that was run (if Select was not selected).
9. If necessary, restrict the group of users to be informed by setting lower limits for the following properties:
   - Number of documents in the inbox or
   - Size of the mailbox,
     The mailbox includes the inbox, the outbox, the resubmissions folder and the private folders of a user.
Quota

- Time period since the data for this user was last collected.

10. Choose 📂.

Result

The quota is carried out in accordance with your specifications. A hit list is displayed showing the number of documents in the inbox and the size of the mailbox for each user. The users to whom a mail was sent are also displayed. These users receive the mail in their Business Workplace inbox and can execute it there.
Forms in the Business Workplace

Use
Forms are used for the following functions in the Business Workplace:

- To send a document to a fax recipient, a SAPscript form is required to ensure the document is formatted correctly.
- When SAPscript documents are created, a format template (a form) is assigned to the document.

SAP supplies standard forms. However, you have to adapt the fax forms to suit the requirements of your enterprise. For example, you have to include your company logo. You can change the SAPscript form in the SAPscript editor.

Features
The following standard forms are supplied for the Business Workplace:

<table>
<thead>
<tr>
<th>Form</th>
<th>Form Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCR standard document</td>
<td>S_OFFICE-MAIL</td>
<td>Form which is used when creating documents of type SCR.</td>
</tr>
<tr>
<td>Short fax</td>
<td>OFFICE_TELEFAX_K</td>
<td>Form for a fax.</td>
</tr>
<tr>
<td>Medium-length fax</td>
<td>OFFICE_TELEFAX_M</td>
<td>Form for a fax with the Sender window.</td>
</tr>
<tr>
<td>Long fax</td>
<td>OFFICE_TELEFAX</td>
<td>Form for a fax with the Sender and Recipient windows.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This form is used when sending documents from the Business Workplace to fax recipients.</td>
</tr>
</tbody>
</table>

Activities
Adapt the forms supplied to suit the requirements of your company. To do this, proceed as described in Maintaining Forms [Page 250].
Maintaining Forms

Use

The following options are available when maintaining forms that are used in the Business Workplace:

- Changing the standard forms
- Creating new forms and changing the default forms for the creation of SCR documents and when sending faxes and telexes

Activities

To maintain the forms, select Office → Forms and one of the displayed form types from the Business Communication Administration area menu. Then proceed as described in Editing: Overview [Page 251].

If you want to maintain a form which is not displayed in the menu or create a new form, you should still select one of the displayed forms and enter the required form name in the Form field on the subsequent screen and then choose Change or Create.

You can find additional information about forms in R/3 in the following documentation: BC - Style and Form Maintenance [Ext.].
Processing in Overview

Form maintenance offers three processing options:

<table>
<thead>
<tr>
<th>Process</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create/change</td>
<td>Change a form that already exists or create a new one.</td>
</tr>
<tr>
<td>Display</td>
<td>Display a specific form.</td>
</tr>
<tr>
<td>Catalog</td>
<td>Display all available forms.</td>
</tr>
</tbody>
</table>

To create a form,

1. Enter the form name and fill in the header information [Ext.].
2. Define any paragraph formats [Ext.] and character formats [Ext.] that you need for the form.
3. Define page formats [Ext.] for the form.
4. Define the windows [Ext.] you want to position on the pages.
5. Define text elements [Ext.] in windows. These are the default texts and the texts selected by the program that can be printed in windows.
6. Specify how the windows are to be placed on the pages by defining page windows [Ext.].

For additional information relating to page windows, see Using Text Elements in Page Windows [Ext.] and Defining Main Windows in Page Windows [Ext.].
Statistics

Use

Programs are available for statistical evaluations of the document folder in the Business Workplace.

The data collection [Page 253] program carries out a data collection for the current date and writes the results to the database. Only the administrator may execute this program.

Using the data evaluation [Page 254] program, you can evaluate this data in different ways and display presentation graphics. This program can be used by all users.

Programs are also available for the data collection of different areas:

Access overview [Page 255]
Inbox overview [Page 256]
Document overview [Page 257]
Folder overview [Page 258].
Data Collection

Use

The following data is listed in the hit list obtained by this program: number of users, folders, distribution lists and documents in the folders, number of substitute periods and resubmissions, number of documents per type, number of different send and receive operations.

To obtain statistical data over an extended period, the program should be run daily or weekly.

Procedure

1. From the Business Communication Administration initial screen, select Office → Statistics → Data collection

2. Define the following:
   - Count table entries directly
     For performance reasons, you should not select this option if table T000 is maintained completely, or if the Business Workplace is used temporarily in the client that you are running the report in.
     In all other cases, select this field.
   - Determine PC document types
     Marking this field means that PC documents will be listed according to existing types. If you do not mark this field, the total number of all PC documents will be calculated.
   - Only display values
     Marking this field means that the data is not written to the database.

3. Choose 🔄.
Data Evaluation

Use

When the data collection process is complete, you can evaluate the data.

Activities

1. From the Business Communication Administration initial screen, select Statistics → Evaluation
   
   You will see an overview of the data (folders, distribution lists, documents, substitutes, resubmissions), user data, transmission data, PC document sizes, document types and PC document types which have been written to the database since the last time the report was run. You can change the display by entering a new date via the Selection date function. All data which has been written to the database since this date is displayed.

2. You can carry out separate evaluations for individual groups (shared data, document types, PC document types, transmission data). Choose View and the relevant group.
   
   If you are calling this function for the first time, you will be required to enter the selection criteria in a dialog box. Define the time period and interval for the evaluation. These criteria apply until they are changed via the Selection criterion function.

3. Choose Graphics to display the evaluation in an SAP presentation graphic.
Access Overview

Use
As an administrator, you can execute this report to gain an overview of the last access to the Business Workplace for each user. You can also enter restrictions so that the hit list contains only users who have not accessed SAPoffice for a certain length of time, for example.

The access overview therefore allows you to detect users who have been inactive for a long period.

Features
The report displays user names and the date on which each individual user last accessed the Business Workplace. From the initial screen for the report, you can specify the criteria which are to be used to sort the hit list.

Activities
To display the initial screen for the report, select Office → User → Access overview from the Business Communication Administration area menu.
Inbox Overview

Use
As an administrator, you can execute this report to gain an overview of the number of documents that users have in their Business Workplace inbox. You can also enter restrictions so that the hit list contains only users who have a more than a certain number of viewed and/or unviewed documents in their inbox, for example.

Features
The report displays user names, the number of documents in the inbox of each user, the number of unviewed documents, as well as the date of the last access to that particular inbox by the user. From the initial screen for the report, you can specify the criteria which are used to sort the hit list.

Activities
To display the initial screen for the report, select Office → User → Inbox overview from the Business Communication Administration area menu.
Document Overview

Use
As an administrator, you can execute this report to gain an overview of the number of documents in all folders for each user. You can also enter restrictions so that the hit list contains only users who have a more than a certain number of documents in their folders.

Features
The report displays user names, the number of documents in the folders and the date on which each individual user last accessed the folders. The number of documents refers to all the existing documents in the Business Workplace (including folders). From the initial screen for the report, you can specify the criteria which are used to sort the hit list.

Activities
To display the initial screen for the report, select Office → User → Document overview from the Business Communication Administration area menu.
Folder Overview

Use

There is an administrator report which you can use to display shared folders sorted according to different criteria. The criteria are:

- Folder name
- Folder title
- Folder area
- Number of documents in the folder
- Number of authorization records
  
  Users and their authorizations are entered in every shared folder. Client folders contain users who either cannot access the folder or who can only do so with an authorization other than the folder access authorization. Group folders contain lists of users who have authorization to access the folder. The number of these user entries is displayed for each folder.

- Number of subscriptions
- Last change date for the folder

Procedure

1. From the Business Communication Administration initial screen, select Evaluations → Folders → Folder overview
2. Select the required sort criteria.
3. Choose .


Other Administration Reports

The reports described in this section cannot be started from the Business Communication Administration interface.

Replicating Shared Folders

You can copy shared folders via report RSSORPLI as follows:

- To other R/3 Systems
- To another client within the same R/3 System
- To the same client within the R/3 System

See the report documentation for more information.

Deleting all Workplace Data from One or All Clients

The two following reports can be used to eliminate any inconsistencies which may have arisen.

Report RSSODELT deletes all the Workplace data (Workplace users, folders, documents, transmission records etc.) in one client.

Report RSSODELA deletes all Workplace data in all clients in one R/3 System.

When an R/3 user calls the Workplace after running a report, a new, empty Workplace is created for the user.
A Mail System Group Between SAP Systems and an External Mail System

Purpose

The SAP System's mail system enables communication to take place between SAP users, business applications and business partners. If you use a different mail system (Microsoft Exchange or Lotus Domino, for example) in your company, you can use this for the communication functions of the SAP System. By integrating the external mail system and SAP Systems, you avoid having to set up and administer two complete communication landscapes.

This documentation uses an example scenario to describe how a mail system group between an SAP System and an external mail system can be set up. The mail system group described here has the following aims:

- Users receive all messages in their home mail system so that they do not have to process several mailboxes at the same time. Messages addressed to SAP users are also received in the home mail system.
- SAP applications address messages to internal users. The messages are automatically forwarded to the users' home mail systems.
- Users can access the address of every mail system group user when they send messages from the SAP System.
- When Internet messages are sent from the mail system group, every sender address has the same domain, irrespective of whether the messages were sent from the SAP System or the external mail system.
- The statuses of messages sent from the SAP System within the mail system group are returned to the SAP System and to the external mail system.
- Replies are always received in the home mail system, irrespective of whether the message replied to was sent from the SAP System or from the external mail system.

SAP applications for which replies are to be sent back to the SAP System specify a sender (for example, the Internet address of a business object) on the Business Communication Interface [Ext.]. Application developers can find more information in Sending Under Other Names [Ext.].

Introduction notes

The link between SAP Systems and an external mail system is made by a connector (for example the SAP Exchange Connector or the Lotus Domino MTA for R/3). For further information, see System Structure of the Mail System Group [Page 262].

Restrictions

- A general domain can only be used for sending from the mail system group if the address is converted by an alias file.
- The addresses of mail system group users who are not SAP users can currently only be accessed in the SAP System using an LDAP connection to the send screen.
A Mail System Group Between SAP Systems and an External Mail System

- The Reply-to field of the RFC 822 is currently not used, that is, replies first go to the SAP System and are routed from there to the external mail system when messages are sent within the mail system group.

- Executable documents are not yet supported outside the SAP System in which they were generated.
System Structure of the Mail System Group

In the mail system group described here, an SAP System is linked to an external mail system (for example, Microsoft Exchange or Lotus Domino). Other SAP Systems can also be integrated. All users in the mail system group have home mailboxes in the external mail system. There, they receive all messages that are sent to their addresses in the SAP System or in the external mail system (internally or externally).

The link between an SAP System and an external mail system is made by a connector (for example SAP Exchange Connector or Lotus Domino MTA for R/3). Messages are exchanged between the SAP System and the mail system using the communication method SMTP (Internet mail). The communication methods SMTP and FAX can be used for external communication (from the mail system group).

Internet messages sent from the SAP System to external recipients (outside the mail system group) are first routed to the external mail system and then transferred to the Internet by the Internet mail connector.

In the mail system group described here, two domains are available for internal routing of Internet messages. One is for the SAP System (@SAP.COMPANY.COM) and one is for the external mail system (@COMPANY.COM). Only one domain (@COMPANY.COM) exists for external routing (outside the mail system group). This can be reached if the address is converted by an alias file.

If, in your mail system group, the status of messages sent from the SAP System is not to be returned in the SAP System, you only require one domain. In this case, you do not require an alias file for address conversion. However, you cannot then send Internet messages to the SAP System.

Depending on the system from which they are sent, outgoing faxes are sent using the fax server connected to the SAP System or to the external mail system. Incoming faxes are normally sent directly to the mailboxes of the users in the mail system group using the fax server for the external mail system.

The following diagram illustrates the system structure in which it is possible to return status confirmations to the SAP System when documents are sent within the mail system group:
For example, SAP Exchange Connector or Lotus Domino MTA for R/3

For example, Microsoft Exchange or Lotus Domino

Alias file for address conversion

Domain: @COMPANY.COM

Fax connector

SAP connect

Internet Mail Connector

Firewall

External mail system

SAP System

Connector

@SAP.COMPANY.COM

@R3.COMPANY.COM => @COMPANY.COM

@R3.COMPANY.COM

@COMPANY.COM

Fax connector

@COMPANY.COM

@COMPANY.COM

Domain: @COMPANY.COM

Internet
Settings for the Mail System Group

Use

The following settings are required to achieve the aims of the mail system group. Some of these settings are not required if the statuses of messages sent from the SAP System within the mail system group are not to be returned in the SAP System. The changes are flagged with * and are described below. Note, however, that the status of these messages is then not available to the SAP applications (for example, in the case of documents linked to business objects).

If you use SAP applications the replies of which are to go to the SAP System, you have to make additional settings (in SAP Business Workflow, for example, replies to mails about a work item can be sent back to the work item). For more information, see Settings for Sending to the SAP System [Page 266].

Activities

• Make address settings for SAP users

  The following settings must be made for every SAP user:

  – Set Internet mail (SMTP) as the standard communication method (transaction SO12, field Comm. method)
  – Select Internet mail address for the mailbox in the external mail system as the home address (transaction SU01, Other communication)
  – Select Internet mail address for the SAP System as the standard address (transaction SU01, Other communication).*
  – Specify the fax number for the mailbox in the external mail system

• Connect LDAP services and set access

  Install the LDAP connector that creates the link to the address directory of the external mail system. For more information, see SAPNet note 188371.

  In the SAP System, create logical LDAP servers that represent the LDAP connection to the address directory of the external mail system in the SAP System (transaction LDAP, Server), for example, with the server name Exchange or Domino.

  You have to make the following settings in order for users to be able to access the LDAP service from the send screen:

  – Select Addresses from LDAP services on the tab page Addressing in the shared office settings [Page 214] (transaction SO16).
  – Assign the authorization for accessing LDAP services. To do this, you have to create a profile containing the authorization object S_LDAP, to which at least the activity Display (3) for the LDAP server (for example, Exchange or Domino) or all LDAP servers (*) is assigned.

• Create alias file**

  An alias file must be created in order to prevent the SAP domain from being contained in the sender address when mails are sent to addresses outside the mail system group.
The alias file converts the SAP domain in the sender address to the standard mail system group domain. This is normally the domain of the external mail system.

- **Set up SAPconnect**

  The connector between the SAP System and the external mail system has to be installed (for example, SAP Exchange Connector [Ext.] or Lotus Domino MTA for R/3).

  The Internet mail and fax connectors have to be set up.

  In the SAP System, you have to make settings in SAPconnect [Ext.] (transaction SCOT) for the connectors to the external mail system and for the fax server connected to the SAP System. For an overview of the settings required for each connector, see External Sending in the SAP System [Page 211].

  Note that you deactivate confirmation of receipt for Internet messages and specify the domains of the external mail system as exceptions (in SAPconnect under Settings → Confirmation of receipt).***

- **Activate mail system group**

  Select Consider user home addresses on the tab page Mail system group in the shared office settings (transaction SO16). You should reset the address buffer on the tab page Addressing so that changed addresses are considered directly.

**Changes when status confirmations are not to be returned in the SAP System**

* Select Internet mail address for the mailbox in the external mail system as the home address and as the standard address: The Internet mail address for the SAP System is not required.

  User addresses can be maintained centrally in one system and distributed to other systems. For more information, see Distributing Users with Corresponding Addresses.

** An alias file is not required for address conversion.

*** Deactivate confirmation of receipt for Internet messages and specify no exceptions.
Settings for Sending to the SAP System

Use

SAP applications can specify their own senders for messages so that replies go back to the SAP System. If you use SAP applications that do this, you have to make additional settings in the mail system group. For more information, see the documentation for the relevant application.

Activities

The activities depend on which sender the SAP application specifies:

User

In order for replies to be sent to the SAP System, you have to make one of the following settings:

- Set a standard domain [Ext.] for the SAP System (transaction SCOT, Settings → Default Domain) and do not assign an Internet address to the user. An Internet mail address in the form <user name>@<standard domain> is automatically generated for the user when he or she sends documents.
- Select the Internet mail address of the SAP System as the standard address and the home address for the user (transaction SU01, Other communication).

Business objects

In order for replies to be sent to business objects, you have to make the following settings:

Enter a standard domain for the SAP System (transaction SCOT, Settings → Default Domain). An Internet mail address in the form <object type>.<object key>%BOR TRADER%@<standard domain> is automatically generated for the business object.

The following applies for both senders:

If you convert the standard domain into the mail system group domain, you have to reconvert the domain for incoming Internet messages (replies). This cannot be done using the domain alone because then all messages would be routed to the SAP System. In the case of business objects, you can convert the address *%BOR_TRADER%@domain back to *%BOR_TRADER%@standard domain, for example.
Questions & Answers Regarding Sending in the Mail System Group

How are users addressed in the mail system group?

If a mail system group user has an SAP user, this user can be selected as the recipient. If a mail system group user does not have an SAP user, their Internet mail address can be entered directly on the send screen or they can be selected from an LDAP service. The external mail system appears as the LDAP server.

How are messages sent internally in the SAP System to an SAP user (case 1)?

The message is forwarded using the communication method Internet mail to the mailbox in the external mail system (the home address of the user). The standard address that has been specified for the communication method Internet mail for the user who sent the message is used as the sender address. In our example, it is in the form <user>@SAP.company.com.

How are messages sent externally from the SAP System to an address outside the mail system group (case 2)?

The sender address is also the standard address of the user who is sending the mail, therefore it is in the form <user>@SAP.company.com. This address is converted into the form <user>@company.com by an alias file. The conversion can take place, for example, in one of the MTAs between the external mail system and the firewall.

Where do replies to messages sent from the SAP System go?

Since the reply-to-address is not entered, the reply is sent to the sender address. Two cases can be differentiated:

Case 1 - Internal sending (Message: SAP → Home mail system - Reply: Home mail system → SAP → Home mail system)

The sender address has not been converted and is in the form <user>@SAP.company.com. The reply created in the home mail system is sent to this address in the SAP System. As a result of the SAP user's address settings, the reply is forwarded to the user's home address, that is, it is sent back to the home mail system.

Case 2 - External sending (Message: SAP → Home mail system → External - Reply: External → Home mail system)

The sender address has been converted and is in the form <user>@company.com. The reply from the external recipient (outside the mail system group) is therefore sent directly to the mailbox in the home mail system.

Where are statuses of messages sent from the SAP System returned?

The statuses up to the transfer of a message to the external mail system are always returned directly (synchronously) to the SAP System, irrespective of the sender address. The final statuses returned asynchronously (for example, the status Read) are sent to the sender address.

Case 1 - Internal sending (Message: SAP → Home mail system - Status: Home mail system → SAP)
Questions & Answers Regarding Sending in the Mail System Group

Statuses returned asynchronously always go to the SAP System and can be accessed in the status history of the message sent. Senders also receive status information as a message in their home mail systems.

Case 2 - External sending (Message: SAP → Home mail system → External - Status: External → Home mail system)

Statuses returned asynchronously are sent as a message to the mailbox in the sender's home mail system. The SAP System does not expect a status for recipients outside the mail system group domain. The transfer of the message to the connector for the external mail system is considered the final status (sent successfully).

Why is the home address not used as the user's standard address (and therefore as the sender address)?

If the home address is not used as the standard address, statuses of messages sent from the SAP System to mailboxes in the external mail system are returned to the SAP System. If you do not require status confirmation in the SAP System, you can use the address of the mailbox in the external mail system as both the standard address and the home address. In this case, the sender addresses do not have to be converted when messages are sent to recipients outside the mail system group. Furthermore, replies to messages from the SAP System are sent directly - that is, without first being sent to the SAP System (see above) - to mailboxes in the home mail system of the mail system group user.

What happens with executable documents?

External sending of executable documents is not currently supported. The executability is lost as soon as the document leaves the SAP System. A solution is planned.

Are all object types supported?

All object types are supported. SAPconnect provides conversion modules that convert SAP formats into standard formats, for example, SCR or OTF to PDF. The object types that are to be converted cannot be specified as supported formats for the node that represents the SAP Exchange Connector. For further information, see Formats.

Business objects sent from the SAP System can be converted into a URL, which recipients can use to access the objects. An Internet Transaction Server (ITS) with the data for the SAP GUI for HTML (webgui.car) is required for this. For information on installing the ITS, see SAP@Web Installation Guide [Ext.].
Administration Tools

Use
The administration of the runtime system consists of several reports that can be split up into the following categories:

- Workflow runtime
- Event manager
- Workflow definition time
- WebFlow
- SAPforms [Ext.]

Prerequisites

Customizing
The following assumes that you have already performed automatic Customizing [Ext.]. Remember task-specific Customizing [Ext.], if you want to use SAP workflows or SAP tasks. Refer to the documentation Workflow Scenarios in Applications [Ext.].

Features
If you, as workflow system administrator, need an alternative way of accessing SAP Business Workflow functions, you can use the relevant transaction code. For an overview of the most important transaction codes, refer to Important Transaction Codes [Ext.].

Workflow runtime

Work item deadline monitoring
Tasks with deadlines have also have deadline monitoring based on a background job. You can change the configuration of the background job, schedule it, delete it or display it.

For further information about the background job, select (Display background job).

Work item error monitoring
If work items have the status ERROR for a long time, they are restarted automatically. This task is performed by a report that is controlled by a background job. You can change the configuration of the background job, schedule it, delete it or display it. You can also start the report manually via Execute work item error monitoring.

For further information about the background job, select (Display background job).

Reorganization
These functions include reports for archiving and deleting work items. Refer to:

- Archive work item [Ext.]

  During archiving, data that is no longer required in the system is checked using application-specific criteria and put in an archive file. The data is not removed from the
database. Once the files which are to be archived have been copied to the archive file completely, they can be removed from the database in a separate program run.

All interactions in conjunction with archiving are performed via archive management (Tools → Administration → Administration → Archiving).

All actions or programs are processed in the background. The background jobs required can be scheduled in archive management.

For more details about archiving, refer to the documentation Archiving Application Data [Ext.].
Synchronize runtime buffer
You have the opportunity to initialize the main memory buffer used by the workflow development environment. This rereads the current values from the database so that the current data is used.

You should always refresh the runtime buffer when you have changed something in the task definition.

After execution of this report, certain workflow functions initially have lower performance. This applies until the main memory contains all the necessary data.

Continue workflow after system crash
You can use this report to select and continue workflows that have had the status started for longer than a day. This means that workflows that have come to a halt after system errors can be continued.

Configure workflow RFC destination
The workflow runtime system executes its RFC [Ext.] and tRFC (transactional RFC) calls on a logical destination. You can set up or change a logical destination.

No logical destination is configured for the workflow system tRFC calls as standard.

Upper limits workflow runtime
You can make the following settings here:

- Maximum number of nested subworkflows permitted at runtime
- Maximum number of nodes that can be processed at runtime within a workflow definition

You can also activate/deactivate the display of agent names in the workflow log.

Event manager

Type linkages and instance linkages
Tables containing the assignment of events to the event receivers interested in the event.

For further information, refer to Maintenance of Linkage Tables [Ext.].

Event trace
The event trace [Ext.] can be used to log events.

Event queue
The event queue [Ext.] can be used to store events temporarily.

Workflow definition time

Workflow Builder
Here you can maintain:

- The workflow system administrator [Ext.] with "global" responsibility, that is, responsible for all workflow definitions
- The task executed in a user decision.
Administration Tools

If you create a step of the type user decision in a workflow definition, the task entered here is transferred into the workflow definition.

Please refer also to the Customizing activity Maintaining Administration Data for the Workflow Builder [Ext.].

WebFlow

Customizing Web server
You use this function to specify the Web server that is configured for your SAP System. For further information, refer to Defining the Web Server [Ext.].

SAPforms

Mail-enabling
This report can be used to schedule the sending of R3F messages. This is necessary if you want to execute a work item as a form in an external mail system.

The report is started immediately and then scheduled as a background job in accordance with the period entered.

Diagnosis
You have the opportunity to call reports with which you can search for errors that have occurred.

Trace on/off
The SAPforms trace logs all SAPforms-related actions.

You have the opportunity to activate/deactivate this trace.

Please also refer to SAPforms Administration [Ext.].

Activities
You can access all the workflow system administration reports described by choosing Tools → Business Workflow → Development → Administration.